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Trade Information 

Windows is a registered trademark of Microsoft Corporation. All other brand and product names are 

trademarks or registered trademarks of their respective companies. 

Warranty 

The material contained in this document is provided “as is,” and is subject to being changed, without 

notice, in future editions. Further, to maximum extent permitted by applicable law, APP Engineering, Inc. 

disclaims all warranties, either expressed or implied with regard to this manual and any information 
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Technology License 
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NOTES: 
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Ending serial number is TBD 
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Throughout this manual the APP ClearView Software™ may be referred to as the “software”, “master 

station software”, “analysis software”, or “COMTRADE Viewer”. 

Throughout this manual an event channel or event input may be referred to as a digital channel or digital 

input. 

 

How to reach us: 

APP Engineering, Inc. 

5234 Elmwood Avenue 

Indianapolis, IN 46203 

USA 

Office: 317-536-5300 

Fax: 317-536-5301 

Email: sales@appengineering.com 

Web: www.appengineering.com 

 

Hours: 

Monday - Friday 7:30AM to 5:30PM EST 

mailto:sales@appengineering.com
http://www.appengineering.com/
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Notice 

After purchasing the APP ClearView Software, APP Engineering, Inc. licenses it to the purchasing party 

upon the condition that you accept all of the terms contained in the license agreement. 

License and Warranty 

The software which accompanies this license (the “Software”) is the property of APP Engineering, Inc. or 

its licensors and is protected by copyright law. While APP Engineering, Inc. continues to own the 

Software, you will have certain rights to use the Software after your acceptance of this license. Except as 

may be modified by a license addendum which accompanies this license, your rights and obligations with 

respect to the use of this Software are as follows: 

Limited Warranty 

APP Engineering, Inc. warrants that the media on which the Software is distributed will be free from 

defects for a period of sixty (60) days from the date of delivery of the Software to you. Your sole remedy in 

the event of a breach of this warranty will be that APP Engineering, Inc. will, at its option, replace any 

defective media returned to APP Engineering, Inc. within the warranty period. APP Engineering, Inc. does 

not warrant that the Software will meet your requirements or that operation of the Software will be 

uninterrupted or that the Software will be error-free. 

You May: 

use one copy of the Software on a single computer; if the media which you receive contains more than one 

language version of the Software and/or multiple Software titles, you are only licensed for one language 

version per Software title contained on the media and you may not transfer such other versions to another 

person or allow another person to use such other versions; make one copy of the Software for archival 

purposes, or copy the software onto the hard disk of your computer and retain the original for archival 

purposes; use the Software on a network, provided that you have a licensed copy of the Software for each 

computer that can access the software over that network, or you have purchased a network license; after 

written notice to APP Engineering, Inc. and written approval from APP Engineering, Inc. transfer the 

Software on a permanent basis to another person or entity, provided that you retain no copies of the 

Software and the transferee agrees to the terms of this agreement; and if a single person uses the computer 

on which the Software is installed at least 80% of the time, then that person may also use the Software on a 

single home computer. 

You May Not: 

copy the documentation which accompanies the Software; sublicense, rent or lease any portion of the 

Software; decompile, disassemble, modify, translate, make any attempt to discover the source code of the 

Software, or create derivative works from the software; or use a previous version or copy of the Software 

after you have received a disk replacement set or an upgraded version as a replacement of the prior version, 

upon upgrading the Software, all copies of the prior version must be destroyed. 
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The above warranty is exclusive and in lieu of all other warranties, whether expressed or implied, including 

the implied warranties of merchantability, fitness for a particular purpose and non-infringement. This 

warranty gives you specific legal rights. You may have other rights, which vary from state to state. 

Disclaimer of Damages 

Regardless of whether any remedy set forth herein fails of its essential purpose, in no event will APP 

Engineering, Inc. be liable to the purchaser for any special, consequential, indirect or similar damages, 

including any lost profits or lost data arising out of the use or inability to use the software even if APP 

Engineering, Inc. has been advised of the possibility of such damages. Some states do not allow the 

limitation of exclusion of liability for incidental or consequential damages so the above limitation or 

exclusion may not apply to you. In no case will APP Engineering, Inc. liability exceed the purchase price of 

the software. The disclaimer and limitations set forth above will apply regardless of whether you accept the 

software. 

U.S. Government Restricted Rights 

Restricted Rights Legend, use, duplication, or disclosure by the Government is subject to restrictions as set 

forth in subparagraph © (l) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 

252.227-7013 or subparagraphs © (1) and (2) of the Commercial Computer Software-Restricted Rights 

clause at 48 CFR 52.227-19, as applicable, APP Engineering, Inc. 5234 Elmwood Avenue, Indianapolis, 

Indiana 46203. 

General 

This Agreement will be governed by the laws of the State of Indiana. This Agreement may only be 

modified by a license addendum which accompanies this license or by a written document which has been 

signed by both the purchaser and an officer of APP Engineering, Inc. Should you have any questions 

concerning this Agreement, or if you desire to contact APP Engineering, Inc. for any reason, please write: 

APP Engineering, Inc. 5234 Elmwood Avenue, Indianapolis, Indiana 46203.  
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Safety Notices 

Do not install substitute parts or perform any unauthorized modification to the product. Return the product 

to APP Engineering, Inc. for service and repair to ensure that safety features are maintained.  

*WARNING* 
 

A WARNING notice denotes a hazard. It calls attention to an operating 
procedure, practice, or the like, that if not correctly performed or 
adhered to, could result in personal injury or death. Do not proceed 
beyond a WARNING notice until you fully understand and are 
prepared to address the indicated conditions. 

*CAUTION* A CAUTION notice denotes a hazard. It calls attention to an operating 
procedure, practice, or the like that, if not correctly performed or 
adhered to, could result in damage to the product or loss of important 
data. Do not proceed beyond a CAUTION notice until you fully 
understand and are prepared to address the indicated conditions. 

 

*WARNING* 
 
 

(Personnel) 
Only qualified, service-trained personnel who are aware of the 
hazards involved should install, open any doors, remove any covers, 
or disconnect the instrument (APP Recorder). Disconnect power 
before attempting any service or maintenance.  

*WARNING* 
 

(Fuse) 
For continued protection against fire, replace the line fuse only with a 
fuse of the specified type and rating. 

*WARNING* 
 

 

(Live Circuits) 
Replacement of chassis, components, fuses and internal adjustments 
must be performed by qualified personnel. The system main power 
must always be disconnected before servicing. If the system utilizes 
voltage and/or current test switches make sure they are open and 
understand that the back of these switches are still live! If the system 
utilizes sliding link terminal blocks for the digital channels and alarm 
outputs, ensure that the sliding links are open and understand that 
one side of the sliding link terminal block is still live!  

*WARNING*  (Operating Environment) 
This instrument should not be used in an explosive environment. It 
should not be used in the presence of flammable gases or liquids. 
This instrument should not be used in a damp or wet environment or 
an environment that is subject to condensation. 
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*WARNING*  (Grounding) 
All chassis, cabinets, panels, and rack mount equipment must be 
connected to an electrical earth ground. Grounding must be done to 
prevent shock hazard to people. Instruments provided with a power 
terminal block are provided with an appropriate means for connecting 
an electrical safety earth ground. Only qualified and trained personnel 
should connect power to this instrument. If the instrument includes a 
three prong AC power cord, ensure that your power receptacle is 
properly earth grounded. 

*WARNING*  (Two Person Rule) 
Do not service or adjust equipment alone. Ensure that another person 
is present that knows emergency procedures and is capable of giving 
first aid. 

 

Additional Document Notes 

Throughout this manual an event channel or event input may be referred to as a digital channel or digital 

input. 
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This manual describes the use of the APP ClearView software and its basic principles. The order of the 

chapters follows the typical process for retrieving fault records and viewing record oscillograms. 

One of APP Engineering’s premier strengths is our ability to provide time saving, valuable, user-friendly 

software. Years of experience in software development, logical algorithm formulation, engineering, 

mathematics, and customer service has given us the tools to provide world class software solutions. Our 

commitment to provide software that is truly valuable is enhanced by our ability to respond quickly to 

customer requested changes and upgrades.  

APP ClearView™ is the ideal data analysis software for engineers and managers that need system 

information and answers quickly. It has a wide variety of graphics, math functions, reports, and file 

manipulation features that allow the user to easily navigate through their data. It supports the importing of 

industry standard formats such as COMTRADE (Common Data Transient Data Exchange) version 1991, 

and 1999, and 2013. It also allows users to export general data formats such as PQDIF, comma delimited 

files (*.csv) and text files (*.txt). 

The software is capable of communicating and retrieving COMTRADE records from any APP Recorder or 

viewing COMTRADE records already retrieved from other recording devices. Communication with the 

APP Recorder can be via modem or network connection. The software can be used to manually or 

automatically retrieve transient records and disturbance information from the recorder. It can also be 

configured to automatically accept incoming calls from any APP Recorder. 

When data is retrieved or automatically called in, a summary of the record is seen on the main page of the 

analysis software. Summary information includes fault ID number, fault date, fault time, fault length, 

synchronization status, list of triggers that started the record, and if applicable distance to fault information. 

Record oscillograms are easily viewed by double clicking a record in the summary table. 

Oscillograms can be viewed in channel sequential order, user defined order, by line group or a multitude of 

other ways. The channel drag and drop feature aids in the quick setup and analysis process. A simple right 

click in the values column displays readings such as RMS, instantaneous magnitude, DC offset, frequency, 

phase+RMS, and a host of statistical choices. Mathematical manipulation of the data can be easily 

performed with features such as add, subtract, invert, log, sine, cosine, tangent, and more. Available 

calculations include positive sequence, negative sequence, zero sequence, apparent power, active power, 

relative power, power factor, and impedance.  

Prefault, fault, and post fault event data are also included in the record. This information is displayed at the 

bottom of the oscillogram screen and can be set up in a variety of ways for convenient viewing and 

analysis. 
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2.1 System Requirements 

Before you install APP ClearView, make sure your computer meets the minimum requirements. 

▪ Windows (95 or above including NT, XP, Vista, Windows 7, 8, and 10 and Server 2003 or later) 

▪ Pentium III 800MHz or better 

▪ 500MB RAM 

▪ Hard Drive Free Space 500MB (Program size is approximately 15MB) 

▪ Pointing Device 

▪ CD-ROM or USB 

2.2 Installing APP ClearView 

Initial installation is done using the CD provided. Subsequent installations or upgrades can be done via 

download from the APP Engineering website once you have obtained a Password. Request a password by 

email to sales@appengineering.com or call Greg Bradley at 317-536-5300 ext. 101 or 317-442-4075. 

➢ To Install APP ClearView From CD 

• Place the APP ClearView CD in the CD-ROM drive.  

• On the CD-ROM, browse to and double-click the setup.exe file.  

• An installation wizard will walk you through the installation process. During the installation 

process, you must agree to the license terms, which are specified in this manual and on the CD-

ROM. If you do not agree to the terms do not install the software.  

• APP recommends that you install the program to the default path of C:\APP ClearView.   

➢ To Re-install or Upgrade APP ClearView from Download 

Before upgrading see “Upgrading APP ClearView” section below 

• Open browser and go to www.appengineering.com 

• Click Downloads 

• Type the password provided from APP Engineering next to the option for Clearview Software Full 

Version 

2.3 Upgrading APP ClearView 

Before you can upgrade to a new version of APP ClearView, you must first uninstall the current version of 

APP ClearView. Do this with the Add/Remove Programs feature in the Windows Control Panel.  

*CAUTION* Do not delete any files from the APP ClearView folder. 

Install the new version by following the instructions in Installing APP ClearView. 

2.4 Running APP Clearview as a Service 

A reliable way to run APP Clearview continuously is to set it up to run as a Windows Service. This will 

ensure Clearview continues to run and restart after the application or computer is interrupted. You can run 

Clearview as a service on a Server or Windows computer. The following instructions describe our preferred 

method of setting up Clearview as a Windows Service using NSSM as the service manager. 

mailto:sales@appengineering.com
http://www.appengineering.com/
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Once Clearview is running as a service. The user will not run the visible Clearview application until you 

want to make changes to settings or use the analysis tools. At that time, you should Open Task Manager 

and stop the service while having Clearview open. Once you are done, close Clearview, go to Task 

Manager and start the Clearview Service again. 

2.4.1 NSSM Installation 

To install NSSM as the Service Manager, open your browser and go to https://nssm.cc 

 

1. Download NSSM.by clicking one of the links in the Home screen or click Download from the 

menu on the left. 

 

2. Extract the downloaded ZIP file. 

 

3. Rename the extracted folder (e.g. "nssm-2.24"), to NSSM. 

4. Copy the NSSM folder to the root folder of drive C:\ 

Figure 1 Downloading NSSM 

Figure 2 NSSM Downloaded ZIP file 

https://nssm.cc/
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5. Open Command Prompt as Administrator by clicking Windows Start and typing command 

prompt. Right click on Command Prompt and select Run as Administrator. 

 

6. Navigate to the NSSM folder, by typing the following commands in order (Press Enter after 

typing each command): 

cd\ 

cd nssm 

 

7. Now according to your Windows system type (32 or 64bit), navigate to the appropriate 

subfolder: 

If you own 64Bit Windows, type: cd win64 

If you own 32Bit Windows, type: cd win32 

8. Now type the following command: 

nssm install 

9. Press the three (3) dots navigation button next to PATH and select the application's 

executable you want to run as a service.  

Figure 3 Run Command Prompt as Administrator 

Figure 4 Install NSSM command 
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10. When done, type a Name for the new service and click Install service 

Note: If you use a name with spaces, you will need to use double quotes anytime the 

name is used in a command line.  

11. Click OK to the message "Service installed successfully”. 

After installing the Clearview service with the NSSM service installer, a new Windows Service will appear 

in the services list in Task Manager, with the name you specified in the Service name, then it can be 

managed as any other Windows service. 

2.4.2 Setting the Clearview Service Account Logon 

Clearview as a service should be run using an account-other than SYSTEM. 

To check or change the user account running the Clearview Service, follow these instructions. 

Open Windows Task Manager and select Details TAB 

Figure 5 Selecting APP Clearview program to run as a service 

Figure 6 Name the Clearview service 
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If you need to change the logon account, click on the Services TAB, select the service and right-click, then 

select Open Services 

 

Then select Logon TAB 

Select “This Account” option instead of Local System Account option. 

Fill in the login and password for the account and click OK. 

If the service was running, you will need to Stop and then Start for the logon to take effect. 

Figure 7 Check logon account of the Clearview service 

Figure 8 opening the service properties 

Figure 9 change the logon account of the Clearview service 
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2.4.3 Using Remote Access with Clearview as a Service 

Using your remote access tool, connect and login to the computer or server running Clearview service. 

Go to Task Manage, Services TAB, right click the service and select stop. 

 

Then you can start APP Clearview from the Start menu and interact with the configurations and use the 

analysis tools as usual.  

When the user is done, close Clearview. 

Go to Task Manager and under Services TAB, right-click on the service and select start. 

If you are using a Server, logout of the computer which will close the Remote access session. 

Otherwise, Close your remote access session. 

  

Figure 10 Stop or Start the Clearview service 
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2.4.4 Uninstalling the Service 

To uninstall the service, follow the steps 5, 6 and 7 from the installation process, and then type the 

following command:  

nssm remove “Service Name” 

Where Service Name = the name of the service you created, using the NSSM utility (e.g. nssm remove 

“Clearview Service”). 

Note: Service names having spaces need to be put in double quotes (i.e. “clearview service”) 

Finally, click Yes to Remove the service. 

 

 

Figure 11 Removing the Clearview service 

Figure 12 confirm remove Clearview service 
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3.1 Introduction 

This chapter guides you through the process for establishing communications between APP ClearView and 

an APP Recorder, retrieving records from the APP Recorder, and viewing fault data.  

This chapter is designed to help you get started as quickly as possible. Therefore, it provides only the basic 

information to complete the basic tasks. Subsequent chapters provide more details about the functionality 

used to complete the steps presented in this chapter. 

In summary, the steps are: 

1. Create the Data and Setup Folders. 

2. Start ClearView and Specify the Minimum Configuration Settings. 

3. Add a New Point Assignment Record. 

4. Set up the Phone and Network List. 

5. Choose the Modem. 

6. View the Communication Screen. 

7. Connect to the APP Recorder. 

8. Retrieve a Point Assignment Record. 

9. Retrieve the APP Recorder Configuration File. 

10. Retrieve the Line Group Record. 

11. Retrieve the Calibration File 

12. Retrieve the Fault Summary File 

13. Retrieve Specific Fault Records from the APP Recorder. 

14. View the Fault Record Oscillogram for a Fault Record. 

Note:  This procedure assumes the APP ClearView software was installed to path C:\APP 
ClearView. If the software was installed to a different drive or directory, please make the 
appropriate adjustments during this procedure. 
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3.1.1 Step 1: Create the Data and Setup Folders  

➢ To Create the Data and Setup Folders 

1. Use Windows Explorer to access the APP ClearView folder. 

2. Create two new folders. Name them Data and Setup. After creating the folders the directory 

should look similar to the figure below.  

Figure 13: APP ClearView Folder with Data and Setup Folders 

3.1.2 Step 2: Start ClearView and Specify the Minimum Configuration Settings 

➢ To Start ClearView and Specify the Minimum Configuration Settings 

1. Start APP ClearView. You can do this by clicking its name from the Windows Start menu or by 

double-clicking the ClearView.exe file, which is found in the APP ClearView folder. 

The following message box appears. 

2. Click the OK button.  

Figure 14: Message Box, New Master Configuration File 

  



Quick Start Guide 3-4 

The ClearView Configuration window appears.  

 

Figure 15: ClearView Configuration Window 

3. Enter your company name, data path, and setup path as shown in the figure and then click Save.  

The following message box appears.  

Figure 16: Message Box, No R##.par File 

This message indicates that ClearView is looking for a Point Assignment Record in the APP 

ClearView folder. You will create one later in this chapter.  

4. Click the OK button.  
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The APP ClearView window opens. The Fault Summary tab appears. It displays no fault data. 

Figure 17: APP ClearView Window 

3.1.3 Step 3: Add a New Point Assignment (PA) Record 

➢ To Add a New Point Assignment (PA) Record 

1. In the APP ClearView window, from the Edit menu, point to Point Assignment Record and 

then click Add PA Record.  

 

Figure 18: Point Assignment Menu 

The Add Point Assignment Record message box appears. 

Figure 19: Add Point Assignment Record Window 

2. Type the recorder ID of the APP-Recorder with which you want to communicate. For example, 1.  
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3. Click the OK button. A confirmation message box appears. 

4. Click the OK button.  

The Edit Point Assignment Record window appears.  

 Figure 20: Edit Point Assignment Record Window 

5. In the Station box, type the station name in which the APP Recorder is located. In this example, 

the location of APP Recorder number 1 is named “XYX Substation.”  

Note: These special characters are not allowed: \ / : * ? " < > |. If you use those, they will 

automatically be converted to a dash (-). 

6. From the menu bar, click Save. A message box appears confirming that a new Point Assignment 

Record has been created and saved. 

7. Click the OK button. 

The APP ClearView window appears. 

3.1.4 Step 4: Set up the Phone and Network List 

➢ To Set up the Phone and Network List 

1. In the APP ClearView window, from the Edit menu, click Phone and Network List. 

Note: If running Window 10 The dial capability will not exist. No phone option will be able to 
function. 

 

Figure 21: Edit Menu—Phone and Network List Option 
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If a Phone and Network List has not been created, an error message will appear. Click OK and the 

Phone and Network List window appears. 

 

Figure 22: Phone and Network List Window 

2. Do one of the following: 

If the APP Recorder is connected to a phone line, then from the list, select Phone#. Then in 

the corresponding box, type the phone number. You can use any standard Windows format.  

Click the Add button. 

If the APP Recorder is connected to an IP address, then from the list select IP Addr. Then in 

the corresponding box, type the IP address. You can use any standard Windows format. Click 

the Add button. For information on configuring DialNet, see Setting Up Dial-up Networking. 

Note If the APP Recorder is connected to both a phone line and a network, then add 
both the phone number and the IP address. 

The entries appear in the window. In the following figure, the APP Recorder is connected to both 

a phone line and network.  

 

Figure 23: Phone and Network List with Entries 

3. By default, the first entry that you make is selected, as indicated by the X in the Use column. The 

entry with the “X” is the number that APP ClearView will call when it connects to or calls the 

APP Recorder. You can activate multiple phone numbers and/or IP addresses. 

 

 Do you want to activate or de-activate a phone number or IP address? 

If yes, then in the Use column, click the box next to the entry. An X appears when the entry is 

activated; it disappears when the entry is deactivated. 

If no, skip to the next step. 
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4. Do you want to delete a number? 

If yes, then right-click the number and then click Delete.  

If no, skip to the next step. 

5. Do you want to reorder entries? 

If yes, then under the Drag column, click the gray box that corresponds to the entry you want 

to move and then move it to its new position.  

If no, skip to the next step. 

6. Click the Save button. 

Your entries are saved and the Phone and Network List window closes. 

Note: If the APP Recorder has been password-protected, then you must also enter the 
appropriate password. When the APP Recorder leaves the factory, no passwords 
have been setup. 

3.1.5 Step 5: Choose the Modem 

➢ To Choose the Modem 

Note: If running Windows 10, the Modem is not available and is disabled. 

1. In the APP ClearView window, from the Connect menu, point to Modem, and then click Choose 

Modem.  

 

Figure 24: Modem Menu 

The Choose Modem window appears. 

Figure 25: Choose Modem Window 
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2. Click the modem that you want and then click the OK button.  

Note:  If the only entry in the window is Auto, then ClearView did not detect a modem 
connected to your master station computer and you cannot communicate with the APP 
Recorder via a modem. 

3.1.6 Step 6: View the Communication Screen 

➢ To View the Communication Screen 

1. In the APP ClearView window, from the Connect menu, click Show Connection Screen. 

 

Figure 26: Connect Menu 

The Connection Status window appears. 

Figure 27: Connection Status Window (Empty) 

This window shows messages related to master station and recorder communications and data 

transfer progress. This window is very useful in determining if a successful connection has been 

established between the master station and the APP Recorder. Right-clicking in the 

communication window will display cut, copy, paste, and delete functions. 

2. Leave the Connection Status window open as you proceed with the next step in the procedure. 
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3.1.7 Step 7: Connect to the APP Recorder 

➢ To Connect to the APP Recorder 

1. In the APP ClearView window, from the Connect menu, click Connect to Recorder. 

 

Figure 28: Connect to Recorder Menu Option 

The APP ClearView software attempts to connect to the APP Recorder using the phone number or 

IP Address you entered.  

2. Observe the Connection Status window as it shows the details of a successful connection. In 

addition, observe the tray at the bottom of the APP ClearView window, which shows that APP 

ClearView is logged into the APP Recorder. 

Figure 29: Connection Status Window and Login Tray 

Note: If you are unable to connect to the APP Recorder, recheck the phone number or IP 
address, check your physical wiring connections, and ensure that the APP Recorder is 
powered up and the APP Recorder Software is running.  
 
If you are attempting to communicate through a modem, verify that you selected the 
correct modem.  
 
If you cannot establish communications, call the APP factory for assistance at (317) 536-
5300. 
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3.1.8 Step 8: Retrieve a Point Assignment Record 

➢ To Retrieve a Point Assignment Record 

If the most up-to-date Point Assignment Record is loaded on the APP Recorder, you should retrieve it.  

1. In the APP ClearView window, from the Edit menu, point to Point Assignment Record, and 

then click Get PA Record from Recorder.   

2. Does the following message appear?  

 

Figure 30: Message Box—Point Assignment Records Are Different 

If yes, then the Point Assignment Record at the APP Recorder does not match the PA Record 

at the master station. Click the OK button. The Point Assignment Record is uploaded 

immediately to the master station and is displayed. 

If no, then the Point Assignment Record at the APP Recorder match the PA Record at the 

master station. You do not need to take any further action to complete this step. 

3. You can view the Point Assignment Record and then decide whether to save it on the master 

station or cancel the upload.  

For more information see section on Managing Point Assignment (PA) Records. on Page 6-1 

*CAUTION* If you save the Point Assignment Record from the APP Recorder, it 
will overwrite the Point Assignment Record at the master station. 
However, a backup copy will be created prior to overwriting. 

3.1.9 Step 9: Retrieve the APP Recorder Configuration File 

➢ To Retrieving the APP Recorder Configuration File 

1. In the APP ClearView window, from the Edit menu, point to Recorder Config. and then click 

Get Recorder Config. 

2. Does the following message appear? 

 

Figure 31: Message Box—Recorder Configurations Are Different 

If yes, then the APP Recorder Configuration file at the APP Recorder does not match the file 

at the master station. Click the OK button. The APP Recorder Configuration file is uploaded 

immediately to the master station and is displayed.   

If no, then the APP Recorder Configuration file matches the file at the master station. You do 

not need to take any further action to complete this step. 

3. You can view the APP Recorder Configuration file and then decide whether to save it on the 

master station or cancel the upload.  

For more information Section 9 Configuring a Recorder 
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Figure 32: APP Recorder Configuration in APP Clearview 

*CAUTION* If you save the APP Recorder Configuration file from the APP 
Recorder, it will overwrite the APP Recorder Configuration file at the 
master station. However, a backup copy will be created prior to 
overwriting. 

3.1.10 Step 10: Retrieve the Line Group Record  

➢ To Retrieve the Line Group Record 

If the most up-to-date Line Group Record is loaded on the APP Recorder, you should retrieve it.  

1. In the APP ClearView window, from the Edit menu, point to Line Group Record and then click 

Get Line-Group Record from Recorder. 

2. Does the following message appear? 

 

Figure 33: Message Box—Recorder Configurations Are Different 

If yes, then the Line Group Record at the APP Recorder does not match the file at the master 

station. Click the OK button. The Line Group Record is uploaded immediately to the master 

station and is displayed.   

If no, then the Line Group Record matches the file at the master station. You do not need to 

take any further action to complete this step. 

3. You can view the Line Group Record and then decide whether to save it on the master station or 

cancel the upload.  

For more information see Power Quality Recording for Inverter Based Resources 
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3.2 Introduction 

The increase in penetration levels of inverter-based resources (IBRs) will significantly change the dynamic 

performance of the bulk electric system. As the penetration levels of inverter-based resources increase and 

the technology of inverter-based resources evolves, recording equipment with PQ-DDR capabilities are 

needed to address the performance requirements of inverter-based resources. APP Recorders can provide a 

one solution system to meet the recording requirements of PRC-002-05, PRC-028, IEEE 2800 Table 19, 

and allow for model validation per MOD 25, 26, and 27. Points of measure can include the HS of the MPT, 

low side of the MPT, solar feeder circuits, BESS feeder circuits, cap banks, and other supplemental 

locations within an IBR plant. 

Regarding IEEE-2800, APP recorders can comply with the requirements of IEEE-2800 Table 19 if the 

proper elements are connected and setup for the APP Data Chassis recording at the point of interconnect 

with the transmission or sub-transmission system (the plant level). The recorder can perform PQ-DDR on 

elements with harmonics being recorded or derived out to the 50th harmonic. PQ-DDR and triggering can 

include Pst, Plt, RVC, very short-term harmonics, short-term harmonics, long-term harmonics, apparent 

power, active power, reactive power, power factor, frequency, and change of frequency. These quantities 

can be continuously recorder and trended with the files being in COMTRADE format and can be 

automatically converted to PQDIFF format. 

3.3 IEEE-2800 Table 19 Measurement Data  

The following table is based on IEEE 2800 Table 19 and describes the data type, points, sampling rate, 

retention and duration for Power Quality continuous recording APP Recorder includes. Retention values 

listed are typical and can be set in the Point Assignment Record. See Section 6.19 Configuring General 

Settings 
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3.4 PQ Hardware 

There are some PQ hardware component required in order for the APP Recorder to receive signals from 

IBRs for PQ. There are three Analog boards involved when recording for PQ. Analog channels are wired to 

both Standard Analog boards and to Voltage or Current specific PQ Analog boards. The IBR needs to send 

voltage signals through a PQ sensor to a PQ Analog Voltage Board. Voltage channels are also wired to a 

standard analog board for recording and triggering on other conditions. PQ Analog Current boards are 

wired in series to a standard analog board wired for current channels. 

PQ Sensor connected to a PQ Voltage analog channel with 1Meg Input Impedance 

PQ Board connected to a PQ Current analog channel with a fixed full scale of about 5A 

The following diagrams illustrate the wiring from a PQ sensor to a PQ Voltage board and an Analog 

Current board. You will notice these boards have only Current connections or Voltage connections, not 

both like the standard Analog board. 

The Voltage board is connected directly to a PQ Sensor. 

 

Figure 105 PQ Voltage board wiring 
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PQ Current boards are wired in series to a standard Analog board wired for the same Current channels 

being recorded. 

 

Figure 106 PQ Current Board wiring 

3.5 Point Assignment Analog TAB settings 

There are PAR settings required or recommended when setting up PQ analog channels. Please see Section 

6-1 Managing Point Assignment (PA) Records for more information on the full PAR set up. 

To measure out to the 50th Harmonic you must use a Transient Sampling rate of 9600 or higher. 

The Transient Sampling rate is recommended to be no higher than 15360. 

When setting up PQ current channels, use Full Scale Setting of 5 and ABS to 20.  This will change 

slightly when calibration is done. 

When setting up PQ voltage channels, Full Scale must be set to 115. 

 

3.6 Power Quality Data Recorder sample Trigger settings 

The plant level Data Chassis PQ settings enable you to trigger for Transient Recording as well as 
Triggers for PQ Continuous Recording. Ideally these triggers will be set up for channels 
in Data Chassis 1. The Figure below shows the typical Trigger settings for recording PQ 
based on IEEE 2800 Table 19. 

Note: When using DSP 7 or higher there is no restriction on how many RVC triggers, or 
which triggers they are assigned to. With DSP 6 or lower, RVC triggers are limited 
to six per data chassis and must be assigned to 1 or more of the first 6 triggers 
only. 
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3.6.1 Power Quality Data Recorder (PQ DDR) 

When utilizing DSP7 or higher in the Data Chassis and running APP Recorder software 3.3.6 or higher the 

following data shown in the table below is recorded when you have checked the Include PQ Data option 

in the Point assignment Record General Settings TAB and have enabled HD, THD, or TRD Triggers in the 

Triggers TAB.  

Note If you have DSP6 or below and have Include PQ Data checked, you will receive the 
five files in Table 8 but not the Harmonics files discussed in this section. 

Note: If you have both HD and THD triggers set on a channel, only one continuous 
recording file will be created for the channel (i.e. it won’t be duplicated). If you have 
either HD or THD and TRD Triggers on the same channel, 2 PQ continuous 
recording files will be recorded for the channel. 
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Table 8 PQ Data Recorded 

Description File Name Interval 
Typical for IEEE-2800 Triggering & 

Continuous Recording for Each 

Mapped Analog Channel 

Typical 

Circular 

Buffer 

3-sec Trigger 

Value  yyyymmddTrR##_3sec 3 seconds, 

daily 
 3p-Vrms, 3p-Irms, 3p-W, 3p-Vr, V-Hz, 

V-Hz Sign, 3p-RVC,  3p-V HD,  3p-I 

HD,  3p-V THD,  3p-I THD, TRD 
10 Days 

10-minTrend 

Trigger Value yyyymmddTrR## 10 minutes, 

daily  Same as above 90 Days 

2-hr Trend 

weekly Trigger 

Value 
yyyymmddTrR##_Weekly 2 hours, 

weekly  Same as above 365 Days 

Trend Flicker Pst yyyymmddFkrR## 10 minutes, 

daily  Selected Volt Channels  90 Days 

Trend Flicker Plt yyyymmddFkrR##_Weekly 2 hours, 

weekly  Selected Volt Channels 90 Days 

3.6.2 Individual Harmonics files  

If you check the Include Individual Harmonic Data check box in the PAR General Settings TAB/Power 

Quality box, Individual Harmonic files are created to enable easier identification of which Harmonic Order 

is the largest and above the Standard. The files will be created for any HD, THD, or TRD triggers set. See 

table below with more details. The following is a summary of the files created and more detail about each 

file name and sampling intervals. 
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Table 9 Harmonics File names and descriptions 

Note: The HD and THD measurements are based on IEC 61000-4-7, -30 and IEEE Std 519 up 
to the harmonic, see table below. Any harmonics beyond the 50th harmonic is not 
measured or recorded by the DFR.  

Transient Sampling Up to Harmonic 

2400 Hz 19th 

4800 Hz 39th 

9600 Hz and above 50th 

3 Second Daily Harmonics - one file per Analog Channel with HD, THD or TRD trigger 3 

second samplings daily starting at 5:00 AM for a year. The filename is 

[YYYYMMDD]IHR[RecID]T[Trigger#]A[Channel#]_VShort_3sec_Daily. Each file contains 50 

X-axes to extract the harmonic order values for each analog channel. Typical Retention is 30 days. 

10 Minute Weekly Harmonics - one file per analog channel with HD, THD or TRD Trigger 

sampled every 10 minutes starting 5am Sunday for a week. The filename is 

[YYYYMMDD]IHR[RecID]T[Trigger#]A[Channel#]_Short_10min_Weekly. Each file contains 

50 X-axes to find the 95th percentile. Typical Retention is 90 days. 

  

Description File Name Interval 

Typical 

Circular 

Buffer 

3-sec Very Short Time 
Individual Harmonic and THD 

yyyymmddIHR##T##A##_VShort_3sec_Daily 

3 seconds, daily (1 file a day per Analog 
Channel with HD as trigger) 
Each file contains 50 X-axes analyzed to 
extract the harmonic order values for each 
analog channel. 

30 Days 

10-min Short Time Individual 
Harmonic and THD 

yyyymmddIHR##T##A##_Short_10min_Weekly 

10 min., weekly (5am daily) (1 file a week per 
Analog Channel with HD as trigger) 
50 X-Axes in the file, to find what is the largest  
harmonic for each analog channel 

90 Days 

10-min weekly 95th percentile  yyyyIHR##T##A#_Short_10min_Weekly_95 

7 days, yearly (5am Sunday) (1 file a year per 
Analog Channel with HD as trigger) 
50 X-Axes in a file, 1 point per week to find the 

95
th

 percentile 

365 Days 

10-min weekly 99th percentile  yyyyIHR##T##A#_Short_10min_Weekly_99 

7 days, yearly (5am Sunday) (1 file a year per 
Analog Channel with HD as trigger) 
50 X-Axes in a file, 1 point per week to find the 

99
th

 percentile (values that exceed 1% for the 
week) 

365 Days 

3-sec weekly 95th percentile  yyyymmddIHR##T##A#_VShort_3sec_Daily_95 

1 day, yearly (5am daily) (1 file a year per 
Analog Channel with HD as trigger) 
50 X-Axes in a file, 1 point per week to find the 

95
th

 percentile 

365 Days 

3-sec weekly 99th percentile  yyyymmddIHR##T##A#_VShort_3sec_Daily_99 

1 day, yearly (5am daily) (1 file a year per 
Analog Channel with HD as trigger) 
50 X-Axes in a file, 1 point per week to find the 

99
th

 percentile (values that exceed 1% for the 
week) 

365 Days 
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Yearly Harmonic Percentile - The following Harmonics recording files are contained in 

APPRecorder\Data\PqData\PQHar folder. You set the retention for all three types of files 

described below in this field (see Section 6.19 Configuring General Settings). Typical Retention 

is 365 days. 

3 Second 95th Percentile Harmonic files - one file per Analog Channel with HD, THD or 

TRD trigger sampled daily at 5am for a year. The filename is 

[YYYYMMDD]IHR[RecID]T[Trigger#]A[Channel#]_VShort_3sec_Daily_95. Each file 

contains 50 X-axes 1 sample per week to find the 95th percentile. 

3 Second 99th Percentile Harmonic files - one file per Analog Channel with an HD trigger 

sampled daily at 5am for a year. The filename is 

[YYYYMMDD]IHR[RecID]T[Trigger#]A[Channel#]_VShort_3sec_Daily_99. Each file 

contains 50 X-axes 1 sample per week to find the 99th percentile. 

10 Minute weekly 95th Percentile Harmonic files - one file per analog channel with an HD 

Trigger sampled weekly (5am Sunday) for a year. The filename is 

[YYYY]IHR[RecID]T[Trigger#]A[Channel#]_Short_10min_Weekly_95. Each file contains 

50 X-axes 1 sample per week to find the 95th percentile. 

10 Minute weekly 99th Percentile Harmonic files - one file per analog channel with an HD 

Trigger sampled weekly (5am Sunday) for a year. The filename is 

[YYYY]IHR[RecID]T[Trigger#]A[Channel#]_Short_10min_Weekly_99. Each file contains 

50 X-axes 1 sample per week to find the 99th percentile. 

3.6.3 Convert COMTRADE to PQDIF 

If you have checked the Convert COMTRADE to PQDIF Every Day in the Power Quality area of the 

PAR General settings TAB, Recorder will create PQDIF files in the APP 

Recorder\Data\PQDATA\PQDIFData folder. The following table lists the PQDif files created 

automatically every day. 

Table 10 Convert to PQDIF files 

Location: Description File Name Interval 

APPRecorder\Data\PQData\ 
PQDIFData 

3-sec Trigger Value  yyyymmddTrR##_3sec 3 seconds, daily 
10-minTrend Trigger 
Value 

yyyymmddTrR## 10 minutes, 
daily 

2-hr Trend weekly 
Trigger Value 

yyyymmddTrR##_Weekly 2 hours, weekly 

Trend Flicker Pst yyyymmddFkrR## 
10 minutes, 
daily 

Trend Flicker Plt yyyymmddFkrR##_Weekly 2 hours, weekly 
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3.6.4 Viewing PQ Continuous recording files 

View the PQ continuous recording files in Clearview by opening a new Graph then navigating to the APP 

Recorder/Data/PQData folder and opening the desired file. The following figures show examples of 

viewing PQ files. See Section 14.2 Opening the Graphic and Data Analysis Window. Look at the Figure 

captions below each image and the filenames at the top to identify which file examples each figure shows. 
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3.6.5 Harmonics Reports 

In addition to viewing Harmonics files in Clearview, five reports to enhance analysis of Harmonics to 

pinpoint more easily if and where the Standard is not being met based on IEEE-2800 Table 19. These 

reports are saved in  APP Recorder\Data\PQData\PQReport folder and written in HTML format. When you 

open a report file it will open in your browser application. You can use your browser functions to save to a 

PDF and Print etc.. 

Following are the report descriptions. 

YYYYMMDD[RecID]VshortHarDailyReport.html  

Daily report of individual Harmonics Order by Trigger and Analog Channel. Vshort indicates 3 second 

sampling. It Identifies the Largest Order and Largest Range. Includes Min (%), Avg(%), Max(%), and 

99th(%). 

You can Filter on a Harmonic Order by selecting one or more from the Filter Rows box. Refresh the 

browser to reset the view back to all rows. 

 

 

Figure 115 Sample Daily Harmonics Report 

 

YYYYMMDD[RecID]VshortHarWeeklyReport.html  

Weely report of each Daily individual Harmonics Order by Trigger and Analog Channel. Vshort indicates 3 

second sampling. It Identifies Largest Order each day for the week. Includes Largest MAX Order, Largest 

MAX, Largest Range(%), MAX THD(%), THD 99th(%). 

YYYYMMDD[RecID]shortHarWeeklyReport.html  

Weely report of each Daily individual Harmonics Order by Trigger and Analog Channel. short indicates 10 

minute sampling. It Identifies Largest Order each day for the week. Includes Largest MAX Order, Largest 

MAX, Largest Range(%), MAX THD(%), THD 99th(%) and 95th(%). 

You can Filter on Date by selecting one or more from the Filter Rows box. Refresh the browser to reset the 

view back to all rows. 
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Figure 116 Sample Weekly Harmonics Report 
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YYYY[RecID]VshortHarYearlyReport.html  

Yearly report of each Weekly individual Harmonics Order by Trigger and Analog Channel. Vshort 

indicates 3 second sampling. It Identifies Largest MAX Range, MAX THD, MAX THD 99th(%)for each 

week yearly. Includes Largest MAX(%), Largest Range(%), MAX THD(%), THD 99th(%). 

YYYY[RecID]shortHarYearlyReport.html  

Yearly report of each Weekly individual Harmonics Order by Trigger and Analog Channel. short indicates 

10 minute sampling. It Identifies Largest MAX Range, MAX THD, MAX THD 99th(%)for each week 

yearly. Includes Largest MAX(%), Largest Range(%), MAX THD(%), THD 99th(%) and 95th(%).  

You can Filter on “Week of” Date by selecting one or more from the Filter Rows box. Refresh the browser 

to reset the view back to all rows. 

 

 

Figure 117 Sample Yearly Report 
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Managing Line Group Records Page 7-1. 

*CAUTION* If you save the Line Group Record from the APP Recorder, it will 
overwrite the Line Group Record at the master station. However, a 
backup copy will be created prior to overwriting. 

3.6.6 Step 11: Retrieve the Calibration File 

➢ To retrieve the Calibration File 

If the most up-to-date Calibration File is on the Recorder, you should retrieve it.  

In the APP Clearview Window, from the Edit Menu, point to Point Assignment Record, then click Get 

RxxExCal.ini. 

*CAUTION* Once you click “Get RxxExCal.ini” the calibration file will be 
immediately uploaded and saved to the APP Clearview setup folder. It 
will overwrite the existing RxxExCal.ini file at the Master Station 

3.6.7 Step 12: Retrieve the Fault Summary File 

➢ To Retrieve the Fault Summary File 

The Fault Summary file shows a summary of faults and associated triggers for the APP Recorder that is 

selected in the APP ClearView window. The number of faults contained inside the Fault Summary file is 

controlled by a setting in the APP Recorder’s configuration. Typically, the APP factory sets the number to 

250, but it can be changed at your discretion. The larger the number, the longer it takes to retrieve the Fault 

Summary file.  

1. In the APP ClearView window, from the APP Recorder list, select the APP recorder for which 

you want to retrieve the Fault Summary file. 

2. Right-click anywhere in the table portion of the APP ClearView window. The menu shown in the 

following figure appears.  

Figure 34: Summary and Fault Menu 

3. Click Get Fault Summary File.  
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Tip: You can also retrieve the Fault Summary file by clicking the icon shown in the 
following figure. 

 

Figure 35: Get Fault Summary File Icon 

4. The Fault Summary file is immediately uploaded. In the APP ClearView window, the Fault 

Summary tab is populated with transient and extended fault records.  

Figure 36: APP ClearView Window with Retrieved Fault Summary Information  

Note: Only the Fault Summary file is retrieved. Oscillograms cannot be viewed because 
the data has not been retrieved. Also notice that there are no check marks in the 
Retrieved column. 

File Type Definitions: 

• F – Transient Fault Record 

• E – Extended Oscillography Record 

• M – RMS Plot Data (Derived from Extended Oscillography Record, E file)  

Show All in folder check box will cause Clearview to display fault records from all the recorders in the 

data folder and adds the recorder number next to the fault number. 

 

UTC check box if checked time will display the Universal Time in the fault list without any offset that 

may have been defined in the configuration. 
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3.6.8 Step 13: Retrieve Specific Fault Records from the APP Recorder 

The Fault Summary tab of the APP ClearView window now displays all of the fault records from the 

APP Recorder. However, none of them have been saved to the master station computer. You need to 

complete the retrieval process by selecting specific fault records. 

Retrieved records are in COMTRADE format.  You can view them with the APP ClearView software or 

with any COMTRADE viewer.  

The time it takes to retrieve data is dependent on the record length(s), the number of records being 

retrieved, and the type of connection between the master station and the APP Recorder (i.e. Modem or 

Network). 

➢ To Retrieve Specific Fault Records from the APP Recorder 

1. In the Fault Summary tab, click the row(s) of the fault record(s) that you want to retrieve. To 

retrieve multiple records at the same time, highlight multiple rows by using the standard Windows 

Control and Shift key functions.  

2. Do one of the following: 

Right-click any of the selected rows. From the menu that appears, click Get Fault Files. 

Click the  icon. 

Note: If you are not already connected to the APP Recorder, the master station will first 
attempt to connect to it automatically. 

Once a fault record has been retrieved, a check mark will appear in its row under the Retrieved 

column, as shown in the following figure.  

By default, APP ClearView places retrieved records in the C:\APP Recorder\Data folder. 

However, if you specified a different path during the installation process, ClearView places the 

retrieved records there instead. 

 

Figure 37 APP ClearView Window with Retrieved Fault Records 
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3.6.9 Step 14: View the Fault Record Oscillogram for a Fault Record 

➢ To View the Fault Record Oscillogram for a Fault Record 

1. In the Fault Summary tab, do any of the following: 

Double-click a retrieved fault record.  

Right-click a retrieved fault record and then click Graphic and Data Analysis of XXXX 

(XXXX represents the fault ID number).  

Click the fault record and then click the  icon.  

From the Tools menu, click New Graph.  

An empty oscillogram window appears.  From the File menu, point to Open Data and then 

click Open Data 1. Browse to the location of your desired COMTRADE record and then 

open it.  

Note: This method also allows you to open two COMTRADE records 
simultaneously.  

The following figure illustrates a sample oscillogram window. 

 

Figure 38: Sample Oscillogram Graph Window 
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4. Using the APP ClearView Window 
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The APP ClearView window is the first window that appears when the APP ClearView Program starts. 

This window has multiple tabs, which appear along the right-hand side of the window. 

4.1 Setting the Administrator Password 

In the APP ClearView window, you can optionally set an administrator password to restrict access to 

administrative features.  If you set an administrator password, then only the people that know the password 

will be able to perform the following functions: 

▪ Changing passwords 

▪ Configuring the ClearView software 

▪ Configuring the APP Recorder software 

▪ Modifying the Point Assignment Record 

▪ Modifying the Line Group Record 

Note:  By default, there is no administrator password. 

➢ To Set an Administrator Password 

1. From the File menu, select Administrator. 

2. From the File menu, click Change Administrator Password.  

A Change Administrator Password box appears. 

3. Enter the desired password and click the OK button.  

The Change Administrator Password box reappears. 

4. Re-type your new password and click the OK button. 

The password is now set. 

Note: If the Password box does not appear when you select an administrative feature, then 
you have not set an administrative password. 
 
Also, if a check mark does not appear next to the Administrator menu item, and there is 
an administrative password, then the Change Administrator Password option will not 
appear on the File menu. 

4.2 Setting the Exit Password 

If you set an exit password, then that password must be entered before ClearView can be closed. 

Note:  By default, there is no exit password. 

➢ To Set an Exit Password 

1. From the File menu, select Change Exit Password. 

A Change Exit Password box appears. 

2. Enter the desired password and click the OK button.  

The Change Exit Password box reappears. 

3. Re-type your new password and click the OK button. 

The password is now set. 
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4.3 Changing the Master Directory 

Use Change Master Directory if you are working with multiple DFRs and need to change the directory 

where Clearview is pointing to get Configuration and Point Assignment for a different DFR. 

1. From the File menu, select Change Master Directory 

2. The Windows file explorer appears, navigate to the folder you want to make the master directory 

and select it. 

3. If files do not appear in the folder selected, the Clearview Configuration screen appears for you to 

define Data and Setup folders. 

4.4 Selecting and Configuring the Printer  

Before you print, select and configure the printer that you want to use. 

➢ To Select and Configure the Printer 

1. From the File menu, select Printer Setup. 

The standard Windows Print Setup dialog box appears. 

2. From the Name list, select the printer that you want to use. 

3. Complete the other fields in this dialog box and then click the OK button. 

4.5 Reinitializing the ClearView Program 

You may need to reinitialize the ClearView to perform troubleshooting or maintenance. When you 

reinitialize the ClearView program, the Fault Summary tab is updated. 

*CAUTION* During this process, the communications between ClearView and the APP 
Recorder will be disconnected. 

➢ To Reinitialize the ClearView Program 

In the APP ClearView window, from the menu bar click Reinitialize. 

The ClearView program is reset and restarted.  

4.6 Run APP Clearview Monitor 

APP Clearview can be set up to automatically restart if Clearview is shutdown. When APPCWMonitor is 

running, APP Clearview will restart within 60 seconds of being closed. This ensures no manual 

intervention is required to maintain APP Clearview operation. 

From the File menu, select Run APPCWMonitor 

4.7 Exiting ClearView   

➢ To Exit ClearView 

In the APP ClearView window, from the File menu, click Exit. 

4.8 Using the Fault Summary (Summary Tab) 

By default, the Fault Summary tab appears when the APP ClearView window is opened. The following 

figure identifies key controls in the tab.  
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Show All in folder check box will cause Clearview to display fault records from all the recorders in the 

data folder and adds the recorder number next to the fault number. 

UTC check box if checked will display the Universal Time in the fault list without any offset that may 

have been defined in the configuration. 

For each fault shown in the Fault Summary tab, the following information is listed: 

• Fault ID Number 

• Date & Time 

• Duration in Milliseconds 

• Synchronization status (Sync) 

• lock 

• no Signal 

• bad Signal 

• initializing 

• unstable 

• <2.5h 

• wrong year 

• unknown 

• SNTP 

• If a user defined Logic Filter (LF) was passed 

• Type: Indicates Fault Record Type. It can be one of four types: 

o T – Transient 

o Ext – Extended 

o D – Disturbance (Only possible if defined Disturbance in Point Assignment 

Record) 

o T/D both Transient and Disturbance 

• FL/LG: If a distance to fault or lightning location was calculated 

o F – indicates fault location was calculated 

o L – indicates lightning location was calculated (requires Vaisala Lightning 

account see 13.4 Vaisala Lightning Configuration) 

Figure 39 Fault Summary Tab 
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• Test/G: If the listed fault is a manually initiated test run or a Goose Message TAG 

triggered fault 

o Y – Test Run 

o G – Goose Message/TAG fault 

• If extended recording is enabled, the Fault Summary tab also contains this 

information: 

• A summary of extended RMS records  

• A summary of extended oscillography records  

• Description associated with a Traveling Wave (TW) Channel involved 

in the Fault 

For information on working with the fault records that appear in this tab, see Working with Fault Records. 

on page 5-1 

4.9 Finding Records in the Fault Summary Table 

You can search the Fault Summary Table for a specific fault ID number, time, date, duration, etc. 

➢ To Find Records in the Fault Summary Table 

1. In the APP ClearView window, on the Fault Summary tab, from the Edit menu, click Find.  

The Find window appears, as shown in the following figure. 

 

Figure 40 The Find Window 

2. Type any value that you want to search for and then click the Find Next button. 

ClearView highlights the row(s) where the value appears. 

Note: You can search again for the same value at any time until you either close ClearView or 
change the search value.  To search again, press the F3 button or choose Find Next 
from the Edit menu. 

4.10 Using the Configuration (Cfg) Tab 

The Configuration tab displays information related to the exact configuration of the APP Recorder when a 

particular fault record was generated. This configuration file follows the requirements of the COMTRADE 

standard ANSI/IEEE C37.111.  
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Figure 41: The Configuration Tab 

 

➢ To View the Configuration for an APP Recorder 

On the Cfg tab, from the APP Recorder list, select the APP Recorder that you want to view. 

The following configuration information appears in the Information box: 

• Station Name 

• Device ID 

• COMTRADE Revision Year 

• Number of Analog Channels 

• Number of Digital Channels (Including 30 triggers) 

• The Frequency of the Line(s) Being Recorded 

• Transient Sampling Rate #1 

• Last Sample # 

• How Many Data Samples Per Channel? 

• Time of the First Data Sample 

• Time of the Fault 

• Data Format (Binary, ASCII) 

• Time Stamp Multiplication Factor 

• Prefault Length 

• Postfault Length 
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4.11 Using the Analog Channels Tab 

 

Figure 42: The Configuration Tab—Analog Channels Tab 

The analog channel configuration saved with each record contains the following information: 

▪ The user-defined channel description 

▪ Channel number 

▪ Unit - Type of channel (voltage or current) 

▪ Full scale value 

▪ Current transformer or potential transformer ration (CT/PT) 

▪ Full scale value is primary or secondary (P=Primary) (S=Secondary) 

▪ The amount of time skew in the data (for systems that use sample and hold technology) 

4.12 Using the Digital Channels Tab 

 

Figure 43: The Configuration Tab—Digital Channels Tab 
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The digital configuration saved with each record contains the following information: 

▪ The user-defined channel description 

▪ Channel number 

▪ The normal state of the input (Normally Open or Normally Closed) 

4.13 Using the Header (Hdr) Tab 

You can use the Header (Hdr) tab to save a header file for an APP Recorder.  

 

Figure 44: The Header Tab 

➢ To Save a Header for a Fault Record 

1. On the Hdr tab, from the APP Recorder list, select the APP Recorder that you want. 

2. Click anywhere in the blank area and type a report or comment concerning the fault.  

3. At the bottom of the area, click the Save button.  

The header file is now part of the COMTRADE file structure that includes the data file, vendor 

information (inf) file, configuration file, and optional header file.  

4.14 Using the Vendor Specific Information (Inf) Tab  

The Inf Tab displays the COMTRADE inf. file, which holds vendor-specific information related to the 

data. For APP Recorders, it displays the username, recorder ID, events/triggers, time information, and fault 

location information.  
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Figure 45: The INF Tab 

➢ To View the Vendor-specific Information 

On the Inf tab, from the APP Recorder list, select the APP Recorder that you want. 

The information appears in the tab.  
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4.15 Using the SER Tab 

You use the SER tab to retrieve specific Sequence of Event Reports. 

You can configure Event Channels as DFR, SER, or both. If an event channel is configured as SER or 

Both, any changes in its state will be logged in the Sequence of Event Report. The APP Recorder creates 

Sequence of Event Reports by date. A report is created under two conditions: 

▪ An SER channel changes state. 

▪ At the end of the day, there are one or more channels in an abnormal state.  

If IEC 61850 GOOSE Capture is set up, GOOSE messages will also appear in the SER report. Reflecting a 

change of State if any have occurred in the time range being viewed. 

Note: It is common practice to set or wire a channel in an abnormal state. In this way, a 
report will be generated every day. If a SER Report is supposed to be generated 
every day, it is easy to determine if any SER recording problems have arisen. 

Show All in folder check box will cause Clearview to display fault records from all the recorders in the 

data folder and adds the recorder number next to the fault number. 

4.15.1 Retrieving the Sequence of Event Report 

To retrieve Sequence of Event Reports, you should first retrieve the Dates file and then retrieve reports for 

the specific dates of interest. If one channel is set or wired in a constant abnormal state, the list of dates 

should be continuous.  

➢ To Retrieve Sequence of Events Reports 

1. On the Fault Summary tab, at the bottom of the window, click the SER Data tab. 

Figure 46 The SER Tab 



Using the APP ClearView Window 4-11 

2. In the Retrieved column (below the Retrieved heading), right-click. 

The following menu appears. 

 

Figure 47: The SER Menu 

3. Click Retrieve Dates. 

The communication process and file transfer begins.  

4. The Retrieved column displays new dates.  

The retrieved file name is “RxxDates.ser,” where xx is the unique recorder ID number. The file is 

saved in C:\APPClearView\Data\R01-APP Demo 1\SerData. The format of the date file is 

ASCII. 

5. Retrieve a report for one day or for multiple days.  

▪ To retrieve a report for one day, double-click that date or right click it and click Retrieve 

File.  

▪ To retrieve multiple reports for multiple dates, use the standard Windows control and 

shift functions. Right click on one of the highlighted dates, and then select Retrieve 

Files.  

 

The report file name for a specific date would look something like 20170507Rxx.ser. The file 

name consists of the year, month, day, and unique recorder ID number. The file is saved in 

C:\APP ClearView\Data\R01-APP Demo 1\SerData. The format of this file is ASCII. 

Note: A Sequence of Event Report can be quite long. You can select the Show Only These 
Events check box, which appears below the Retrieved column. Specify the SER 
channels that interest you. Separate multiple channels with commas. 

6. After a report is retrieved, a checkmark appears next to its date in the Retrieved column. 

A Sequence of Event Report is shown in the following figure. 
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Figure 48: SER Report 

The Sequence of Event Report includes the following information: 

▪ Date and time of the event 

▪ Event channel number 

▪ Current state of the event (O = Open, C=Closed) 

▪ Whether the event is in its normal state (A = Abnormal, N = Normal) 

▪ Whether the APP Recorder received a synchronized satellite signal (U = Unsynchronized, S = 

Synchronized)  

▪ User-defined channel description. The channel description could contain the following 

information. 

(M. Stop) this indicates that the channel was manually placed in a stop condition via the Point 

Assignment Record. 

(Stop) this indicates that the channel was automatically placed in a stopped condition. 

Settings that will auto stop an SER channel are located in the Point Assignment Record. 

(End) this indicates that the channel was in an abnormal condition at the end of the day. 

For Goose messages, the Sequence of Event Report includes the following information: 

Date and time of the event 

GOOSE ID = Gx where x is the id 

State - is not used 

Normal - is defined as (A = Abnormal= Closed, N = Normal= Open) 

Sync - is not used  

User-defined GOOSE Entry Description as entered in the GOOSE Points Record.  
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4.15.2 Copying an SER Report 

You can copy SER reports to user-defined backup paths or to the specific copy destination that you browse 

to. You specify the backup paths in the ClearView Configuration window. For information on setting 

these values, see Section  4.17.2 Configuring the Main Configuration Settings 

➢ To Copy an SER Report 

1. On the SER tab, in the Retrieved column, right-click the date for which you want to copy the 

SER report. 

The following menu appears.  

 

Figure 49: SER Menu 

2. Point to Copy File(s) and then do one of the following: 

To copy the file to the primary backup drive, click Copy to Backup 1 Drive. 

To copy the file to the secondary backup drive, click Copy to Backup 2 Drive. 

To browse to a different backup folder, click Copy to… and then browse to the folder where 

you want to save the copied file.   

A message box appears to confirm the copy. 

3. Click Yes. 

4.15.3 Deleting a SER Report 

➢ To Delete an SER Report 

1. On the SER tab, in the Retrieved column, right-click the date for which you want to delete the 

SER report.  

2. Click Delete File(s). 

The report associated with the selected date(s) is deleted. The date(s) will remain in the retrieved 

column, but the check mark(s) will be removed.  

4.15.4 Changing the Viewing Path 

You can change the viewing path in order to view other folders where saved SER reports are stored. 

*CAUTION* Changing the viewing path changes it for the “Fault Summary Table 
and “SER Summary Table.” 

1. On the SER tab, in the Retrieved column, right-click the date for which you want to change the 

viewing path.  

2. Click Change Viewing Path. 

A menu of possible paths appears. 

3. Select the path. 
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4.15.5 Adding SER Files 

➢ To Add Files 

1. On the SER tab, in the Retrieved column, right-click the date for which you want to add files. 

2. Click Add Files. 

3. Browse to the .SER file that you wish to insert into the Sequence of Events Report for the selected 

date. The Sequence of Events Report for the selected date appears with the new or added entries. 

4.15.6 Showing SER Files 

1. On the SER tab, in the Retrieved column, right-click the date for which you want to show files. 

2. Click Show Files. 

3. Browse to the .SER file that you wish to view into the Sequence of Events Report for the selected 

date. The Sequence of Events Report for the selected date appears with the selected entry. 

4.15.7 Saving the Display 

You can create an ASCII file containing the sequence of events (SER) for the date(s) that you select. 

➢ To Save Display 

1. On the SER tab, in the Retrieved column, right-click the date for which you want to add files. 

2. Click Save Display. 

3. Browse to the desired path, name the file, and click Save.  

Note: Saving Display also saves to PRC format. 

4.16 Selecting the APP Recorder  

You can select the APP Recorder for which you want to view fault records. You can select any APP 

Recorder that is connected to the master station. When you select a new APP Recorder, the Summary tab 

is immediately updated with fault records from that APP Recorder. 

➢ To Select the APP Recorder to Display 

On the Summary tab, from the APP Recorder list, click the down arrow to view the list and 

select the APP Recorder that you want. 

 

Figure 50: Recorder Pull Down Menu 
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➢ To Sort the APP Recorder List 

You can sort the APP Recorder list by station name or recorder ID number.  

1. Right-click the APP Recorder list.  

 

Figure 51: Recorder Sorting Menu 

2. The option that appears by default depends on the current sort order of the list. Click Sort by 

Station Names or Sort by Recorder IDs, depending on whichever appears.  

The list is sorted immediately. 

4.16.1 Saving a Station List 

You can create a comma-delimited text file containing the list of the APP Recorders and key details about 

them. Information inside the Station.lst includes recorder ID number, station name, recorder model number, 

number of analog channels, number of trigger channels, number of event channels, the transient sampling 

rate, and the extended sampling rate. 

➢ To Save a Station List 

Right-click the APP Recorder list and then click Save to Stations.lst. 

The list is saved in the location specified in the Data Path box in Main tab of the ClearView 

Configuration window. See Configuring the Main Configuration Settings  

4.17 Configuring Clearview 

Some minimum configuration parameters must be setup for the ClearView program and the master station 

to operate. For example, it must know where to place the retrieved data and where to find point assignment 

information  

Note: The required configuration fields are Data Path and Setup Path. 

4.17.1 Types of Configuration Settings 

You can configure the following types of settings for the ClearView program: 

▪ Main configuration settings 

▪ Automatic Tasks 

▪ Options 
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4.17.2 Configuring the Main Configuration Settings 

Main configuration settings are integral to the basic functioning of the ClearView program. 

➢ To Configure the Main Configuration Settings 

1. In the APP ClearView window, from the Edit menu, click ClearView Configuration. 

The ClearView Configuration window appears. By default, the Main tab is selected. 

 

Figure 52: ClearView Configuration Window 

2. In the Company Name field, enter any name you would like. This name will appear at the top of 

the ClearView main page. At the factory, the name of the company or person that purchased the 

system is entered. 

3. (Required) In the Data Path field, click  and enter the location of the physical file where 

transient and extended recording information will be written. Typically, the path is C:\APP 

ClearView\Data. You can change this value to any other path you want.  

4. Transient and extended recording information can be written to more than one path. To create a 

second location, select the check box next to Backup 1 Path, click , and then enter the path 

to the desired location. You can specify any path you want.  

5. To create a second backup location, select the check box next to Backup 2 Path, click , and 

then enter the path to the desired location. You can specify any path you want.  
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6. Do you want to convert all retrieved COMTRADE data to PQDIF data daily and store it as PQDIF 

data?  

If yes, then select the check box next to the PQDIF Path box. Then click  and enter the 

path to the folder where the PQDIF data should be stored. You can specify any path you want. 

The PQDIF folder will have the same structure as the folder specified in the Data Path box. 

If no, then skip to the next step. 

7. Do you want to keep all COMTRADE files from all APP Recorders in the  

C:\APP Recorder\Data folder? This allows you to segregate COMTRADE records from different 

APP recorders. 

If yes, then select the All Data in One Folder (else auto create folder for each Recorder data). 

If no, then do not select this check box. A folder for each APP Recorder will be automatically 

created inside the folder specified in the Data Path box.  

Note: This check box also affects the PQDIF Path since it has the identical directory 
structure as the Data Path. 

8. (Required) Next to the Setup Path box, click the  and then specify the path the location for 

saving Point Assignment Records.  

9. Do you want to specify a Backup path for Point Assignment Records? 

If yes, then select the check box next to the Backup Path box. Then click the  and then enter 

the path to the desired location. You can specify any path you want. 

10. From the menu bar, click Save. 

4.17.3 Configuring the Automatic Tasks  

The master station can perform a variety of automatic tasks, which appear on the window that is shown in 

Figure 53. By configuring the automatic tasks, you can take full advantage of the master station’s ability to 

become an integral part of your substation or plant automation. 

There are several types of automatic tasks that you can configure. 

▪ Whether ClearView should auto-poll the APP Recorders, and if so, how it should happen 

▪ Whether or not to automatically print fault-related information when an APP Recorder calls in or 

when auto-polling 

▪ Whether or not to automatically send an email when an APP Recorder calls in or when auto-

polling 

4.17.4 Accessing the Automatic Tasks Tab  

You configure all of the automatic tasks on the Automatic Tasks tab of the ClearView Configuration 

window. 

➢ To Access the Automatic Tasks Tab of the ClearView Configuration Window 

1. In the APP ClearView window, from the Edit menu, click ClearView Configuration. 

The ClearView Configuration window appears. By default, the Main tab is selected.  

2. Click the Automatic Tasks tab. 

The Automatic Tasks tab appears, as shown in the following figure. 
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Figure 53: Configuration Automatic Tasks Tab 

4.17.5 Configuring Auto-Polling 

You can configure whether or not ClearView performs auto-polling. If auto-polling occurs, you can also 

configure how it occurs: 

▪ Whether or not master station automatically polls the APP Recorders for new fault data 

▪ The meaning of the data that is transmitted from the APP Recorders 

▪ Whether un-retrieved, old records are retrieved 

▪ The number of attempts the master should make to contact an APP Recorder 

▪ Whether or not to accept multiple simultaneous calls from different APP Recorders 

▪ Whether the time on the APP Recorders should be synced with the master station 

▪ Which APP Recorders should be automatically polled 

➢ To Configure Auto-Polling 

1. In the ClearView Configuration window, click the Automatic Tasks tab. 

2. From the Auto Polling Recorders list, select the appropriate option: 

NO: No auto-polling. 

Yes – always (Get FSum Only) 

At the specified time, the master station will call the selected APP Recorders and upload a 

fault summary file.  The number of faults in the file depends on a user-defined setting in each 

APP Recorder’s configuration file. 

Yes – always (Get FSum and Data) 

At the specified time, the master station will call the selected APP Recorders and upload the 

Fault Summary file and any new fault records.  If any of the check boxes in the Data means 

these only group are selected, then only the new record(s) with the corresponding check 
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mark(s) will be uploaded to the master station.  If none of the options are selected, then all 

new records will be uploaded to the master station. 

Yes – if logic true (Get FSum Only) 

At the specified time, the master station will call the selected APP Recorders and upload a 

Fault Summary file.  Contrary to the title, the master station will always retrieve a Fault 

Summary file. 

Yes – if logic true (Get FSum and Data): At the specified time, the master station will call 

the selected APP Recorders and upload a Fault Summary file.  If a user-defined Boolean 

Logic Equation (filter) has been entered at the APP Recorder and a recorded fault passes the 

filter, the master station will upload its fault data. If any of the check boxes in the Data 

means these only group are selected, then only the new record(s) with the corresponding 

check mark(s) will be uploaded to the master station.  If none of the options are selected, then 

all new records will be uploaded to the master station. Contrary to the title, the master station 

will always retrieve a Fault Summary file. 

Yes – always (FSum), if logic true (Data) 

At the specified time, the master station will call the selected recorders and upload a fault 

summary file.  If a user-defined Boolean Logic Equation (filter) has been entered at the APP 

Recorder and a recorded fault passes the filter, the master station will upload its fault data. If 

any of the check boxes in the Data means these only group are selected, then only the new 

record(s) with the corresponding check mark(s) will be uploaded to the master station.  If 

none of the options are selected, then all new records will be uploaded to the master station. 

3. In the at box, specify the hour at which the auto-polling should occur. This is a 24-hour clock. 

4. In the then every XX hours box, specify the time interval between the auto-poll cycles. 

Note: The time of day takes priority over the number of every hours.  
 

For example, if you specify , ClearView will 

automatically change it to  to ensure that the auto-
polling will occur at 02:00 every day. 

Also note that ClearView will not wait until 02:00 to start the first polling. For 
example, if the configuration has been saved at 03:00, the first auto-polling will be 
at 08:00 (2:00 + 6 Hours). 

5. Retrieve any un-retrieved old records during auto Polling, this function is to ensure all 

COMTRADE Records on the Recorder is retrieved into APP Clearview. Check the box if you 

want Clearview to pull any fault records during polling/auto polling existing in the Recorder and 

has not yet been retrieved. 

Note: If the fault summary list (.lst file) is retrieved manually then the Recorder is auto 
polled, Clearview may not retrieve any un-retrieved fault records until the next 
polling cycle. 

6. Do you want to retrieve continuous RMS records (Trend Only) during auto polling? 

If yes, select the Retrieve continuous RMS records (Trend Only) during auto polling check 

box. 

If no, skip to the next step 
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7. In the Data means these only group, select the types of records that you want the auto-polling 

process to retrieve.  

Figure 54: Data Means These Only Options 

Note: If you select any one of these check boxes, then ClearView will retrieve only 
records of that type. However, if you select none of these check boxes, then 
ClearView will retrieve all of these types of records. 

8.  In the Max # of Attempt box, type the maximum number of times the master station should 

attempt to contact a particular APP Recorder before giving up.  

9. In the #Rings before answering box, type the number of times the master station should allow an 

incoming phone call to ring before it picks up the call and makes the connection.  

Note: The Monitor Call menu option on the Connect menu must be enabled before 
this entry has an effect  

10. Do you want to allow multiple APP Recorders (up to 5) to call in simultaneously through an 

Ethernet connection? 

Note:  Five instances of the ClearView program will be opened simultaneously, but only 
one will be visible on the master station screen. 

If yes, then select the Accept multi-recorder to call-in simultaneously through Ethernet 

option. In addition, you must select the Monitor Call option on the Connect menu. Also, for 

each APP Recorder, you must select the ClearView allows multi-recorders call-in 

simultaneously thru Ethernet check box. This is found on the Automatic Tasks tab in the 

Recorder Configuration window. 

If no, skip to the next step. 

4.17.6 Configuring ClearView Actions  

You can configure which of the following actions ClearView takes when an APP Recorder calls in, or 

when auto-polling occurs. 

Print a graph 

Print a Fault Summary report 

Print a Sequence of Events report 

Send an Email 

Sync the Recorder time with ClearView 

➢ To Configure the Automatic Printing of a Graph 

1. In the ClearView Configuration window, click the Automatic Tasks tab. 

2. Under When Recorder Call-in or Auto Polling, Do, select the Auto Print Graph check box.  

3. Click the Graph Format button. 

The Format All Wave Printing window appears, as shown in the following figure.  



Using the APP ClearView Window 4-21 

 

Figure 55: All Wave Printing Window 

4. On the Format All Wave Printing window, from the Analog Channel list, select one of the 

following:   

YScale Optimized (peak) 

This option prints the highest peak value measured to the right-hand side of each oscillogram 

printed.  

YScale Optimized (unit/cm) 

This option prints a volts/cm or amps/cm scale to the right-hand side of each oscillogram 

printed.  

Note: Print fewer oscillograms on a page to increase the resolution on the Yscale. 

YScale = Channel Full Scale Optimized (unit/cm) 

This option prints a volts/cm or amps/cm scale to the right-hand side of each oscillogram 

printed. The value is based on the Full Scale setting in the Point Assignment Record and the 

number of oscillograms printed on the page.  

Note: Print fewer oscillograms on a page to increase the resolution on the Yscale. 

Yscale = User Select Scale (unit/cm) 

If you select this option, a Yscale box appears. Enter your preferred  volts/cm or amps/cm 

scale. This option prints a volts/cm or amps/cm scale to the right-hand side of each 

oscillogram printed, which is based on the Yscale you entered.  

Yscale Optimized (RMS) 

This selection prints the RMS value to the right side of each oscillogram printed. 

Note: Print fewer oscillograms on a page to increase the resolution on the Yscale. 
If the scale you specify is too small, waveform clipping will occur.  
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5. From the Channels list, select one of the following:  

▪ All 

This option prints an oscillogram for each analog channel listed in the Point 

Assignment Record. 

▪ Selected 

If you select this option, a Select Channels button appears. Click this button and 

then select the specific channels to print. 

▪ Group 

When selected, specific preset line groups can be printed. 

6. From the Data Range list, select one of the following options:  

▪ All 

This option prints the entire length (X-axis) of all the oscillograms selected for 

printing. 

▪ Selected 

Each data point in an oscillogram has a number. The starting number is “0” which is 

usually the prefault portion of the waveform. The ending number depends on how 

long the fault or recording lasted.  To print a partial record, X-axis length, enter the 

data range. 

7. In the #Channels/Page box, enter the number of oscillograms you want on each printed page.  

Note: Print fewer oscillograms on a page to increase the resolution on the Yscale. 

8. Limited to 100 Cycles per Page check box causes the report to limit to 100 Cycles per page for 

each channel displayed on a page. 

9. There are two types of triggers, analog triggers and event triggers. You can print these triggers in 

conjunction with oscillograms. Triggers are represented by horizontal lines at the bottom of a 

printed or displayed page.  In the Digital Channel Format list, select how the trigger line should 

appear, whether it is normal or abnormal: 

▪ Sequence Of Events /Triggers (Line on Abnormal) 

This selection only prints the event channels or analog triggers that caused the 

system to trigger and record. The state of other event channels is not printed. If a line 

is shown it represents the period of time the event was abnormal.  

▪ Sequence Of Events /Triggers (Line on Normal) 

This selection only prints the event channels or analog triggers that caused the 

system to trigger and record. The state of other event channels is not printed. If a line 

is shown it represents the period of time the event was normal.  

▪ All Events/Triggers (Line on Abnormal) 

This selection prints the analog triggers and event channels that were in an 

 abnormal state when the record was created. If a line is shown it represents the 

period of time the analog trigger or event channel was abnormal. 

▪ All Events/Triggers (Line on Normal) 

This selection prints the analog triggers and event channels that were in an abnormal 

state when the record was created. If a line is shown it represents the period of time 

the analog trigger or event channel was normal. 

10. Spread digital among graphs, if Spread Digital check box is not checked, the Analog channels 

are printed, then the Event Channels, on each page (See Figure 56). With Spread Digital check 

box checked the report shows the digital channels along with the Analog lines together (See 

Figure 57). 
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Figure 56: Default Report Format  

Figure 57: Report with Spread Digital Among Graphs Checked 
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11. No Trigger check box causes the report to exclude Analog Trigger faults from the report. An 

Event Trigger will still display if an Event Channel is set up, and an Event Channel caused the 

Trigger or an Event Channel changed state while the record was being created. 

12. In the Panel Size box, enter the percentage of space the event and analog trigger lines will use at 

the bottom of a printed page.  

13. In the Font Size Global Control box, enter the font size to be used for the title of the waveform 

pages and any annotations that may have been added. You cannot change the font on the Fault 

Summary Report.  

14. In the Font Size Title Control box, enter the font size for the title that appears at the top of each 

waveform or oscillogram page.  

15. In the Annotation Text Size box, enter the font size for any annotations that are added to a 

waveform or oscillogram page.  

16. Click the OK button.  

The ClearView Configuration window appears.  

➢ To Configure the Email Settings 

1. In the ClearView Configuration window, click the Automatic Tasks tab. 

2. Under When Recorder Call-in or Auto Polling, Do, select the Auto Email check box.  

3. Click the Email Settings button. 

The Email Settings window appears, as shown in the following figure.  

Figure 58: Email Settings Window 

4. In the From box, type a valid email address.  
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5. The Recipients list, add or delete recipients’ email addresses. The e-mail message will be sent to 

all of the recipients in this list. If no recipients are listed, click Add and specify a valid email 

address.  

• Use the “Check All” button to select all recipients at once. 

• Use the “Uncheck All” button to unselect all recipients at once. 

6. For Alarm, checking the box will cause Clearview to send an email once a day if an Alarm has 

occurred changing the Alarm List. 

7. Contact your network administrator to obtain values for the Outgoing Mail (SMTP), Port#, User 

ID fields, and Auth Password.  

Note: The master station must have a SMTP/POP3 email account and connectivity in 
order to use the email feature.  

8. Do you want ClearView to automatically email a summary of every fault each time the master 

station automatically retrieves a fault record or whenever an APP Recorder calls in a fault record?  

▪ If yes, then select the Auto Send Fault Summary if Logic Filter (LF) True check box. In 

addition, on the Automatic Tasks tab of the Recorder Configuration window for each APP 

Recorder, verify that the Logic box contains the appropriate value. For more information on 

completing the Logic box, see Defining a Boolean Logic Equation in the APP Recorder 

Operating Manual. 

▪ If no, skip to the next step. 

9. Auto Send Fault Summary, do you want the Auto Send Fault Summary function to limit what is 

sent to the Master Station to any faults less than 1 day old? 

▪ If yes, then click the Don’t Auto Send Fault Summary if older than 1 day check box. 

▪ If no, skip to the next step 

This function works only if Auto Send Fault Summary is also checked. 

10. In the Max #Email/hr: box, type the maximum number of emails that ClearView should send 

every hour.  

11. From the menu bar, click Save. At this point, you have completed configuring e-mail settings. It is 

a good idea to send a test e-mail to ensure that messages will be sent properly. To do this, 

complete the procedure, To Test the Email Function. 

➢ To Test the Email Function 

In the Send Email window, click the Message tab.  

The Message tab appears, as shown in the following figure. From here, you can type an email and 

manually send it to everyone in the Recipient list. 
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Figure 59: Send Email Window—Message Tab 

1. In the Subject box, type the subject line for the email.  

2. In the Message box, type the message.  

3. In the Attachments list, select an attachment to include. Use the Add and Delete buttons to select 

or remove additional files.  

4. The Debug checkbox is for APP Engineering use only. 

5. Click Send.  

➢ To Configure the Automatic Printing of a Fault Summary Report 

1. In the ClearView Configuration window, click the Automatic Tasks tab. 

2. Under When Recorder Call-in or Auto Polling, Do, select the Auto Print FSum check box.  

3. From the menu bar, click Save. 

➢ To Configure the Automatic Printing of a Sequence of Events Report (SER) 

1. In the ClearView Configuration window, click the Automatic Tasks tab. 

2. Under When Recorder Call-in or Auto Polling, Do, select the Auto Print SeqEv check box.  

3. From the menu bar, click Save. 

➢ To Configure the Automatic Syncing of the Times in ClearView and on the APP Recorder 

1. In the ClearView Configuration window, click the Automatic Tasks tab. 

2. Under When Recorder Call-in or Auto Polling, Do, select the Sync Recorder Time with 

ClearView check box.  

 

The date and time from the master station is downloaded to the APP Recorder. This feature is 

mainly used by companies that prefer to sync the master station instead of the individual APP 

Recorders. 

3. From the menu bar, click Save. 
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4.17.7 Selecting Recorders for Auto Polling 

You can specify which APP Recorders you want ClearView to automatically poll for fault summary files 

and fault data. 

➢ To Select Recorders for Auto Polling 

1. In the ClearView Configuration window, click the Automatic Tasks tab. 

2. Under Select Recorders for Auto Polling, select the check box for each APP Recorder that you 

want to auto-poll. 

3. From the menu bar, click Save. 

4.17.8 Configuring Options 

➢ To Configure Options 

1. In the ClearView Configuration window, click the Options tab. 

The tab appears, as shown in the following figure. 

 

Figure 60: ClearView Configuration Window—Options Tab 

2. Do you want to restrict who should be allowed to enable the Monitor Incoming Calls option? 

▪ If yes, then from the Allow Monitor Call and Auto Poll list, select the name of your 

administrator. 

▪ If no, leave the default setting of Anyone. 

3. How do you want the fault summary data to appear?  

▪ If you want to view the faulted line group or first line group, select Double click fault 

summary to show sequential graph (default: line-group). 

▪ If you want to display analog channels in sequential order when a fault record is viewed, skip 

to the next step. 
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4. After normal communication has been established between the APP ClearView and the APP 

Recorder programs, the ideal disconnect situation is for someone at the master station or someone 

at the APP Recorder to initiate a disconnect or hang up command. When this is done, both 

programs are aware of the disconnect request and can properly close down communications.  

 

However, it is possible for a communication path to be cut without notice. This results in neither 

program receiving notice of the disconnect. Therefore, a hang up timer is needed to ensure that 

both programs receive an automatic command to release the communications link.  

 

The default hang up timer for both the APP Recorder and APP ClearView programs is 10 minutes. 

However, the APP Recorder hang up timer has a delay making its effective default time 10 

minutes and 30 seconds. Therefore, in the case of no communications activity, the APP ClearView 

program will be the first to initiate a hang up action. 

 

Do you want to make the ClearView the first program to initiate a hang up action in the event of 

an unexpected disconnect?  

▪ If yes, then in the Hang up if connection to recorder has been idle for X minutes box, type a 

value less than 10 minutes. 

▪ If no, skip to the next step. 

5. Vaisala Lightning information, if you have an account with Vaisala to receive lightning strike 

information, you can use ClearView to correlate lightning strike locations with recorded faults.  

 

To enable lightning information, check the box and then follow instructions to set up Clearview 

for Correlation of lightning information in Section 13.4 Vaisala Lightning Configuration on the 

Tools menu. 

6. Dropbox, using the Dropbox feature allows you to copy fault records to another Clearview on 

another network automatically upon arrival.  

1. Outgoing: Enter or browse to the path where outgoing Fault files are  

2. Incoming: Enter or browse to the path where incoming Fault files will go. 

7. Click Save 

4.17.9 Printing Clearview Configuration 

You can print the configuration information by clicking Print at the top of the screen then selecting Print 

Preview or Print. Print Preview allows you to review the report, save, change the printer preferences, and 

print. 
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4.18 Managing the Phone and Network List 

The master phone list contains the phone numbers, IP Address, or Master ID’s of the APP Recorders which 

the master station will automatically call. It also contains the passwords that are necessary to access the 

APP Recorders. 

➢ To Configure the Master Phone List 

1. In the APP ClearView window, from the Edit menu, click Phone and Network List. 

The Phone and Network List window appears, as shown in the following figure.  

Figure 61: Master Phone & Network List Window 

2. Do you want to add a new IP address or phone number for an APP Recorder?  

If yes, then do one of the following: 

If the APP Recorder is connected to a phone line, then from the list, select Phone#. Then in 

the corresponding box, type the phone number. You can use any standard Windows format.  

Click the Add button. 

If the APP Recorder is connected to an IP address, then from the list select IP Addr. Then in 

the corresponding box, type the IP address. You can use any standard Windows format. Click 

the Add button. For information on configuring DialNet, see Setting Up Dial-up Networking. 

If no, skip to the next step. 

3. By default, the first entry that you make is selected, as indicated by the X in the Use column. The 

entry with the “X” is the number that APP ClearView will call when it connects to or calls the 

APP Recorder. You can activate multiple phone numbers and/or IP addresses. 

Do you want to activate or de-activate a phone number or IP address? 

If yes, then in the Use column, click the box next to the entry. An X appears when the entry is 

activated; it disappears when the entry is deactivated. 

If no, skip to the next step. 

4. Do you want to delete a number? 

If yes, then right-click the number and then click Delete.  

If no, skip to the next step. 

5. Do you want to reorder entries? 

If yes, then under the Drag column, click the gray box that corresponds to the entry you want 

to move and then move it to its new position.  

If no, skip to the next step. 

6. Click Save. 
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4.19 Setting Up DialNet 

Setting Up Dial-up Networking 

DialNet is for users who want to use Remote Desktop or a similar program to access the APP Recorder 

using the same phone line as the APP Recorder. The following is the procedure to set up DialNet. This 

procedure is also in Readme.txt located inside of the ClearView directory.  

Note: If Windows 10 is running Dial-Up Networking will be set to Off and unable to be turned 
ON. 

To establish dial-up networking, you must complete the setup procedures on both the APP Recorder 

(server) computer and on the ClearView (client) computer. 

For Windows 7 and 10 

Dial-up Networking using Windows 7 and 10, is supported on a case-by-case basis. To setup Dial-up 

networking with Windows 7 or above, please contact APP Engineering support at (317) 536-5300. 

Things to Remember  

▪ The Dial-up network IP Address of the Recorder is (200.200.200.200) 

▪ The Dial-up network IP Address of the ClearView computer is (200.200.200.201) 

▪ Use IP:200.200.200.200 to call the Recorder when using Remote Desktop or UltraVNC or 

whatever 

▪ The dial-up network can only be disconnected by the application that started it. 

▪ The dial-up network will stop the Internet connection and also could stop some local LAN. 

▪ The Internet will resume automatically after the dial-up network connection is disconnected. 
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5. Working with Fault Records  
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5.1 Retrieving the Fault Summary File 

The Fault Summary file shows a summary of faults and associated triggers for the currently selected APP 

Recorder. The number of faults contained inside the Fault Summary file is controlled by a setting in the 

APP Recorder’s configuration. Typically, the APP factory sets the number to 250, but it can be changed at 

your discretion. The larger the number, the longer it takes to retrieve the Fault Summary file.  

➢ To Get the Fault Summary File 

1. In the APP ClearView window, from the APP Recorder list, select the APP Recorder for which 

you want to retrieve a fault summary file. 

2. Right-click anywhere in the table portion of the APP ClearView window. The menu shown in the 

following figure appears.  

Figure 62: Summary and Fault Menu 

3. Click Get Fault Summary File.  

Tip: You can also retrieve the Fault Summary file by clicking the icon shown in the 
following figure. 

 

Figure 63: Get Fault Summary File Icon 
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4. The Fault Summary file is immediately uploaded. In the APP ClearView window, the Fault 

Summary tab is populated with transient and extended fault records.  

 

Figure 64: APP ClearView Window with Retrieved Fault Summary Information 

Note: Only the Fault Summary file is retrieved. Oscillograms cannot be viewed because the 
data has not been retrieved. Also notice that there are no check marks in the Retrieved 
column. 

File Type Definitions: 

• F – Transient Fault Record 

• E – Extended Oscillography Record 

• M – RMS Plot Data (Derived from Extended Oscillography Record, E file) 

• W – Traveling Wave Fault 

 

5.2 Retrieving the Fault File(s) 

The Fault Summary tab of the APP ClearView window now displays all of the fault records from the 

APP Recorder. However, none of them have been saved to the master station computer. You need to 

complete the retrieval process by selecting specific fault records. 

Retrieved records are in COMTRADE format.  You can view them with the APP ClearView software or 

with any COMTRADE viewer.  

The time it takes to retrieve data is dependent on the record length(s), the number of records being 

retrieved, and the type of connection between the master station and the APP Recorder (i.e. Modem or 

Network). 
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➢ To Get the Fault File(s) 

1. In the Fault Summary tab, click the row(s) of the fault record(s) that you want to retrieve. To 

retrieve multiple records at the same time, highlight multiple rows by using the standard Windows 

Control and Shift key functions.  

2. Do one of the following to get one or more files: 

• Right-click any of the selected rows. From the menu that appears, click Get Fault Files. 

• Click the  down arrow then click Get. 

Note: If you are not already connected to the APP Recorder, the master station will first attempt 
to connect to it automatically. 

Once a fault record has been retrieved, a check mark will appear in its row under the Retrieved 

column, as shown in the following figure. 

 

Figure 65: APP ClearView Window with Retrieved Fault Records  

APP ClearView places retrieved records in the C:\APP Recorder\Data folder. However, if you 

specified a different path during the installation process, ClearView places the retrieved records there 

instead. 
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5.3 Viewing the Pop-Up Menu for Fault Records 

When you right-click on a specific fault record in the Fault Summary tab, the following menu appears.  

 

Figure 66: Summary Window and Fault Record Pop-Up Menu 

Here, you can select various features related to the highlighted fault record. If you have selected multiple 

records, the record with the larger fault ID is referenced in the pop-up menu. 

The following sections describe these menu items in more detail. 

5.4 Viewing a Graphic and Data Analysis of a Fault Record 

➢ To View the Graphic and Data Analysis of a Fault Record 

In the Fault Summary tab, right-click the fault record that you want to view. 

If no other graphs are already open, then the Graphic and Data Analysis window appears. This 

window displays the oscillogram for the fault record.  

 

If one or more Graphic and Data Analysis windows are already open, then the Graphic Choices 

menu appears.  

 

Figure 67: Graphic Choices Menu  

Do one of the following: 

▪ To open another Graphic and Data Analysis window, click New Graph. 

▪ To replace the data in the first Graphic and Data Analysis window with the data for the 

selected fault data record, click on Replace Graph#1. 
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▪ To put the data for the selected fault data record as END-2 into Graph#1. If END-2 in 

Graph#1 already has data, it will be replaced. 

Tip: Open one graph as END-1 then use the APP Recorder list to switch to a different APP 
Recorder and select another fault as END-2. 

5.5 Viewing the Fault Record Information  

You can view detailed Fault Record Information for a fault, which includes the maximum and minimum 

RMS values for each analog channel as well as trigger involvement.  

➢ To View the Fault Record Information 

1. In the Fault Summary tab, single-click the fault record that you want to view. 

2. Do one of the following: 

• Right-click the fault record that you want to view and select Show Fault Record Info. 

• Click the icon. 

The Fault Record Information window appears. 

 

Figure 68: Fault Record Information Window 

3. After examining the data, you can select analog data to plot graphically by holding down the 

Control key and then clicking the desired channels. You can do one of the following: 

• To display the selected analog channels in a graph, click the Graph Selected Analog 

Channel(s) button.  

• To display the selected analog channels sequentially, click the Graph Sequentially 

button. 

4. When you are finished viewing the information, click the Close button. 
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Note: You can leave the Fault Record Information window open while you work with other fault 
records. This window will stay on top of other windows until you close it. You can choose 
a different fault record by clicking the Fault Summary tab or by switching to a different 
substation. Click this menu again to update this information displayed in this window.  

5.6 Redoing the Fault Location Calculation for a Fault Record 

There are two types of Fault Location methods available with the APP Engineering DFR. The 1st is an 

impedance-based method the 2nd is Traveling Wave method. This function applies to both methods. Below 

describes redoing the Fault location calculation for each fault location method. 

➢ Impedance Based Method 

If ClearView contains a properly configured Line Group Record, and there is sufficient transient data, the 

fault location calculation is performed automatically by the APP Recorder. However, you may want to 

perform a manually activated calculation in the following situations: 

1. The line-group record may not have been loaded on the APP Recorder at the time of the fault.  

2. A COMTRADE record for another DFR might need a manually activated fault location 

performed.  

3. Within the Graph and Data Analysis window, the user zooms in on a transient oscillogram and 

wishes to perform another calculation.  

The APP Recorders use an impedance-based method for calculating the distance to fault. The APP 

Recorder itself uses a single-ended calculation. A double-ended calculation can be performed by pulling 

data from each end of a faulted line back to the APP ClearView master station software and manually 

initiating a double-ended calculation command.  

For the system to automatically perform a single-ended fault location calculation the line length, positive 

resistance (R1), positive reactance (X1), zero resistance (R0), and zero reactance (X0) must be entered into 

the Line Group Record. Also, the analog channel physical connection must be a phase-to-ground 

connection. 

➢ Traveling Wave Method 

If Traveling Wave (TW) boards and connections as described in the APP Recorder Manual has been 

established and A Line Group and TW channels are configured Traveling Wave records can be created. 

(See Section 6.18 Configuring Traveling Wave Channels). Also, for more information see below Section 

5.7 Traveling Wave Fault Location). 

Redoing the Traveling Wave calculation may be needed if a user calibrated the C Factor or a Time 

Calibration has been done after the fault record was created then you will want to redo the fault location 

calculation.  

➢ To Redo the Fault Location Calculation for a Fault Record 

1. In the Fault Summary tab, right-click the fault record. 

2. Click Redo Fault Location of FXXXX or WXXXX(where XXXX represents the fault number). 
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5.7 Traveling Wave Fault Location 

Introduction 

Travelling Wave Fault Location (TWFL) is a method to determine the location of a fault on an electrical 

line. The level of accuracy compared to other methods is such that the time needed to visually search for 

the fault in the field is greatly reduced. 

By using the information about the length of the line, the time of when the fault was recorded, and the 

velocity at which the fault moves along the line (information which is known at the time of setup), the 

Recorder’s TWFL feature can determine the location of the fault along the line. 

Concept 

The concept of travelling wave fault location is based on the relation between distance travelled 

(displacement) and time. From classical kinematics, we know that displacement is proportional to the time 

taken for that displacement, 

𝑥 ∝ 𝑡 

where 𝑥 is displacement and 𝑡 is the time taken for the that displacement. Then the constant of 

proportionality between the two quantities is the velocity 𝑐, 

𝑥 = 𝑐𝑡 

5.7.1 Single End and Double End 

Single end and double end TWFL refers to the configuration of the TWFL apparatus. Single end TWFL, 

only one end of the line is setup to record TWFL data. Double end TWFL, both ends of he line are setup to 

record TWFL data. Because double end TWFL returns twice the amount of data compared to single end 

TWFL, double end TWFL is generally more likely to be more precise in locating faults along the line than 

single end TWFL. 

5.7.2 Double End TWFL 

Figure 69 Double Ended Traveling Wave Fault Location 

The diagram above represents a double end TWFL setup. DFR1 represents the DFR on left end of the line, 

and DFR2 represent the DFR on the right end of the line. The FAULT happens at some undetermined point 

along the line and the signals of the fault, W1 and W2, travel along the line away from the fault towards 

DFR1 and DFR2 respectively. The peak amplitude of W1 and W2 can be either positive or negative. Both 

DFR1 and DFR2 are receiving signals of GPS TIME (through IRIG-B) and therefore are synchronized in 

time. 

Let 𝑡0 be the time that the fault happens at FAULT, and W1 and W2 are generated simultaneously. W1 and 

W2 travel along the line with speed 𝑐. Let 𝑡1 be the time that the signal W1 reaches DFR1 and let 𝑡2 be the 

time that the signal W2 reaches DFR2. Let 𝐿 be the total length of the line, and 𝐿1 be the length of the line 

from DFR1 to FAULT, and 𝐿2 be the length of the line from DFR2 to FAULT. 
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𝐿1 and 𝐿2 are unknown and are the final quantities we are trying to determine. To do this, we must first 

determine 𝑡0, which is also unknown. We can do this by using the time data collected by DFR1 and DFR2, 

𝑡1 and 𝑡2. 

The time taken for W1 to travel from FAULT to DFR1 is 𝑡1 − 𝑡0. Similarly, the time taken for W2 to travel 

from FAULT to DFR2 is 𝑡2 − 𝑡0. Using the relationship between displacement and time described earlier, 

this gives us the equations, 

𝐿1 = 𝑐(𝑡1 − 𝑡0) 
𝐿2 = 𝑐(𝑡2 − 𝑡0) 

Then the sum of 𝐿1 and 𝐿2 should give us the total line length 𝐿, 

𝐿 = 𝑐((𝑡1 − 𝑡0) + (𝑡2 − 𝑡0)) 

The Recorder then uses this equation to solve for 𝑡0, and subsequently for 𝐿1 and 𝐿2. 

5.7.3 Single End TWFL 

 

 

Figure 70 Single Ended Traveling Wave Fault Location 

The diagram above represents a single end TWFL setup. DFR represents the DFR on the recorded end of 

the line. The FAULT happens at some undetermined point along the line and the signal of the fault, W, 

travels along the line away from the fault towards DFR. The peak amplitude of W can be either positive or 

negative. DFR is receiving signals of GPS TIME (through IRIG-B). When W reaches the DFR, it will 

reflect as ECHO1, which is similar to W, but diminished in amplitude, and travels away from DFR towards 

FAULT. When ECHO1 reaches FAULT, it will reflect as ECHO2, which is similar to ECHO1, but 

diminished in amplitude, and travels away from FAULT towards DFR. 

Let 𝑡0 be the time that the fault happens at FAULT, and W is generated. W travels along the line with speed 

𝑐. Let 𝑡1 be the time that the signal W reaches DFR and ECHO1 is generated. Then let 𝑡2 be the time that 

the signal ECHO2 reaches DFR. Let 𝐿 be the length of the line from DFR to FAULT. 

𝐿 is unknown and is the final quantity we are trying to determine. Because the speed at which a signal 

travels along the line remains invariant, we know that the time between ECHO1 leaving DFR and ECHO2 

reaching DFR is twice the time taken for W to travel from FAULT to DFR. Meaning, if we let Δ𝑡 be the 

time taken for a signal to travel the distance 𝐿, then the distance a signal has to travel from DFR to FAULT 

and to be reflected back to DFR from FAULT is 2𝐿, and the time it will take to travel that distance is 2Δ𝑡. 
So, the time taken for a signal to travel from FAULT to DFR, Δ𝑡 is, 

Δ𝑡 =
𝑡2 − 𝑡1

2
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Then from the relationship between displacement and time described earlier, the distance from DFR to 

FAULT is, 

𝐿 = 𝑐 (
𝑡2 − 𝑡1

2
) 

NOTE: The Recorder does not calculate single end TWFL automatically. The time-mark data and 
this equation must be used in conjunction by the user to determine the distance to the 
fault. 

5.7.4 SOFTWARE 

To use the TWFL feature, APP software version 2.9.8 greater must be installed. 

All TW fault records have a fault number prefixed with W and will have a fault type of Tw. The TW faults 

will be listed in the fault summary list with other faults. The format of the fault numbers is Wxxxx-xx and 

will increment before and after the dash accordingly for each fault or set of faults. The date and time of the 

beginning of the fault is shown in the Date-Time column to the right of the Fault column.  

Figure 71 Fault Summary, Summary Tab 

To see the information about a fault, click once on a fault to highlight the fault, then click the Inf tab to the 

right of the fault summary list, the following screen appears. 
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Figure 72 Traveling Wave Fault, Inf Tab 

➢ The fault summary values relevant to TWFL are: 

TW_t1 

For double end fault location, this value indicates the time when the fault arrived at the local DFR on the 

end of the line the fault was recorded. Therefore, TW_t1 and TW_t2 should have their respective values 

swapped for the fault recorded at the remote DFR on the other end of the line. The value is a fraction of a 

second at a nanosecond precision. 

For single end fault location, this value indicates the time when the fault arrived at the DFR on the end of 

the line the fault was recorded. 

TW_t2 

For double end fault location, this value indicates the time when the fault arrived at the remote DFR on 

the other end of the line the fault was recorded. Therefore, TW_t1 and TW_t2 should have their respective 

values swapped for the fault recorded at the remote DFR on the other end of the line. The value is a fraction 

of a second at a nanosecond precision. 

For single end fault location, this value may or may not be displayed and can be disregarded. 

TW_Desc 

This value represents the name given to the channel that recorded the fault. It is set in the PAR and the 

default format is Tw#:TWChannel #. The channels are incrementally numbered automatically in the PAR 

at time of setup. 
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TW_Line_i 

This value represents the line the channel recorded the fault from. It is set in the PAR and the format is and 

integer. The default line number is automatically to 0 in the PAR at time of setup. 

TW_LineMiles 

This value represents the length of the line the channel recorded the fault from. It is set in the PAR and the 

format is a number in miles with a 3-decimal place precision.  

For double end fault location, the length of the line from the local DFR to the remote DFR should be 

known and input into the PAR at time of setup. 

For single end fault location, the length of the line is from the local DFR to where the line terminates. 

However, this information is not used for single ended calculation.  

TW_cf 

This value represents the speed of light factor used to calculate the distance of the fault from the DFR. It is 

set in the PAR (c factor) and the format is a number that is a fraction of the speed of light with a 6-decimal 

place precision. The default line number is automatically to 0 in the PAR at time of setup. 

TW_tcal 

Time from a Fault to each end of the line should be symmetrical relative to where the fault occurred on the 

line. If differences in infrastructure of the stations at each end or some other factor causing the time not to 

be symmetrical, you can use tcal to calibrate the time to obtain a better result. Time Calibration does not 

have to be done until the first TW fault record has been created. The field is 3 decimal place precision and 

the value is 0.000 unless it is adjusted by a user using the Time Calibration process. To determine the 

calibration factor and entering it into the Point Assignment record see (5.10 Find TW Time Calibration 

(tcal). 

FaultLocs 

This value includes information about the location of the fault including the channel that recorded the fault, 

the fault type, the region the fault was recorded in, distance to the fault, and the length of the line. The 

format is ~TW^Channel^^#~|TW|NA|x.xxx|x.xxx|0 where # is the channel number and first x.xxx is the 

distance to the fault and the second x.xxx is the length of the line. 

5.8 Update Selected TW Fault Location(s) 

If a user manually copies a TW fault into the Clearview data folder then use Update Selected TW Fault 

Location to calculate the fault distance. 

1. Right click on the fault record that you would like to update the location for. 

2. Click Update Selected TW Fault Location(s) in the pop-up dialogue. 
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5.9 Find TW C Factor 

Calibration does not have to be done until the first TW fault record has been created. If the distance to 

fault result is not correct, the c factor can be recalibrated to obtain a better result. 

➢ To calibrate the c factor 

1. Right click on the fault record that you would like to recalibrate for 

2. Click Find TW c factor in the pop-up dialogue 

3. Enter the Actual Fault Location in miles 

 

4. Click OK  

5. Then enter the Other End Time from IRIG-B value.  This value is obtained from the 

corresponding TW fault record of the remote end of the line 

 

6. Click OK  

7. The c factor calculated from the two quantities entered is then shown in the text field. The user 

may choose to accept this calculated c factor value by clicking OK, or enter their own.  

 

8. To update the c factor in the Point Assignment Record, you may copy this value and paste into 

the Point Assignment Record. 

9. Click OK. 

5.10 Find TW Time Calibration (tcal) 

Time Calibration does not have to be done until the first TW fault record has been created. If the time of 

the traveling wave is not symmetrical at each end of the line, you can use tcal to calibrate for differences in 

infrastructure of the stations or other factors causing the time inconsistency. The time can be recalibrated to 

obtain a better result. 
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➢ To set the Time Calibration (tcal) 

1. Right click on the fault record that you would like to recalibrate. 

2. Click Find TW Time Calibration in the pop-up dialogue. 

3. Enter the Actual Fault Location in miles. 

 

4. Click OK  

5. Then enter the Other End Time from IRIG-B value.  This value is obtained from the 

corresponding TW fault record of the remote end of the line. 

 

6. Click OK  

7. The tcal calculated from the two quantities entered is then shown in the text field. The user may 

choose to accept this calculated Tcal value by clicking OK or enter their own.  

 

8. To update the tcal in the Point Assignment Record, you may copy this value and paste into the 

Point Assignment Record. 

9. Click OK. 

5.11 Correlating Lightning Information 

If you have an account with Vaisala to receive lightning strike information, you can use ClearView to 

correlate lightning strike locations with recorded faults. Be sure you have the “Use Vaisala Information” 

box checked in the Clearview Configuration Options Tab see Section 4.17.8 Configuring Options, and see 

Section 13.4 Vaisala Lightning Configuration for setup instructions. 

➢ To Correlate Lightning Information 

1. In the Fault Summary tab, right-click the fault record. 

2. Click Do Lightning Info. 
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5.12 Printing the Fault Summary List 

You can preview or print the list of faults displayed in the Fault Summary tab. 

➢ To Print the Fault Summary List 

1. In the Fault Summary tab, right-click anywhere. 

2. Point to Print Fault Summary List and then do one of the following: 

▪ To preview what will be printed, click Preview. 

▪ To send the contents to the printer, click Print. Then complete the fields in the Print window 

and click the OK button. 

5.13 Printing the Summary of a Fault Record 

You can preview or print the information displayed in the Fault Summary tab for a specific record.  

➢ To Print the Summary of a Fault Record 

1. In the Fault Summary tab, right-click the fault record that you want.  

The pop-up menu appears. 

2. Point to Print Fault Summary of FXXX and then do one of the following: 

▪ To preview what will be printed, click Preview. 

▪ To send the contents to the printer, click Print. Then complete the fields in the Print window 

and click the OK button. 
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5.14 Printing the Sequence of Events Report for a Fault Record 

You can preview or print the sequence of analog and digital triggers for a specific fault record. The 

following figure shows a sample report. 

 

Figure 73: Sequence of Events Report for a Fault Record 

➢ To Print the Sequence of Events Report for a Fault Record 

1. In the Fault Summary tab, right-click the fault record that you want.  

The pop-up menu appears. 

2. Point to Print Sequence of Events of FXXX and then do one of the following: 

▪ To preview what will be printed, click Preview. 

▪ To send the contents to the printer, click Print. Then complete the fields in the Print window 

and click the OK button. 

5.15 Printing All Waveforms for a Fault Record 

You can preview or print oscillograms for a specific fault. You can optionally include a fault summary.  

➢ To Print All Waveforms for a Fault Record 

1. In the Fault Summary tab, right-click the fault record that you want.  

The pop-up menu appears. 

2. Point to Print all Waveforms of FXXX and then do one of the following: 

▪ To print just the oscillogram graphs, point to Graphs. 

▪ To print the oscillogram graphs and the fault summary, point to Fsum + Graphs. 
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3. Do one of the following: 

▪ To preview what will be printed, click Preview.   

▪ To send the contents to the printer, click Print. Then complete the fields in the Print window 

and click the OK button. 

4. Did you choose to print the oscillogram graphs in step 3? 

▪ If yes, then complete the rest of this procedure.   

▪ If no, (you chose only to preview the graphs), then you have completed this procedure. 

5. After you click the OK button in the Print window, the Format All Wave Printing window 

appears, as shown in the following figure.  

 

Figure 74: Format All Wave Printing Window 

6. From the Analog Channel list, select one of the following options: 

YScale Optimized (peak) 

This selection prints the highest peak value measured to the right-hand side of each 

oscillogram.  

YScale Optimized (unit/cm) 

This selection prints a volts/cm or amps/cm scale to the right-hand side of each oscillogram. 

Fewer channels printed on a page yields more resolution on the Yscale.  

YScale = Channel Full Scale Optimized (unit/cm) 

This selection prints a volts/cm or amps/cm scale to the right-hand side of each oscillogram. 

The value is based on the full scale setting in the Point Assignment Record and the number of 

oscillograms printed on the page. Fewer channels printed on a page yields more resolution on 

the Yscale.  

Yscale = User Select Scale (unit/cm) 

If you select this, then a Yscale field appears. In this field, type your preferred volts/cm or 

amps/cm scale, which will be printed to the right-hand side of each oscillogram. If the scale 

you specify is too small, waveform clipping will occur. Fewer channels printed on a page 

yields more resolution on the Yscale.  

Yscale Optimized (RMS) 

This selection prints the RMS value to the right side of each oscillogram printed. 
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7. From the Channels list, select one of the following options: 

▪ ALL 

This selection prints an oscillogram for each analog channel listed in the Point Assignment 

Record. 

▪ Selected 

If you select this, then a Select Channels button appears. Click the button and then click the 

specific channels to be printed. 

▪ Group 

If you select this, a list of all preset line groups appears. Click the line group that you want. 

8. From the Data Range list, select one of the following options: 

▪ ALL 

This selection prints the entire length (X-axis) of all the oscillograms. 

▪ Selected 

If you select this, two entry boxes appear. Each data point in an oscillogram has a number. 

The starting number is usually the prefault portion of the waveform. The ending number 

depends on how long the fault or recording lasted.  To print a partial record, or X-axis length, 

enter the data range in these entry boxes. 

9. In the #Channels/Page box, type the number of oscillograms you want to appear on each page of 

the printout. Fewer oscillograms per page could increase the resolution of the Yscale. 

10. There are two types of triggers, analog triggers and event triggers. You can print these triggers 

with the oscillograms. Triggers are represented by horizontal lines at the bottom of a printed or 

displayed page. In the Digital Channel list, select how you want the representation of a trigger 

line as normal or abnormal to appear: 

Sequence Of Events /Triggers (Line on Abnormal) 

This selection only prints the event channels or analog triggers that caused the system to 

trigger and record a fault. The state of other event channels is not printed. If  a line is shown, it 

represents the period of time the event was abnormal.  

Sequence Of Events /Triggers (Line on Normal) 

This selection only prints the event channels or analog triggers that caused the system to 

trigger and record a fault. The state of other event channels is not printed. If  a line is shown, it 

represents the period of time the event was normal.  

All Events/Triggers (Line on Abnormal) 

This selection prints the analog triggers and event channels that were in an abnormal state 

when the fault record was created. If a line is shown, it represents the period of time the 

analog trigger or event channel was abnormal. 

All Events/Triggers (Line on Normal) 

This selection prints the analog triggers and event channels that were in an abnormal state 

when the fault record was created. If a line is shown, it represents the period of time the 

analog trigger or event channel was normal. 

11. Limited to 100 Cycles per Page check box causes the report to limit to 100 cycles per page for 

each channel displayed on a page. 

12. Spread digital among graphs, if this check box is not checked, the Analog channels are printed, 

then the Event Channels, on each page (See Figure 75). With Spread Digital check box checked, 

the report shows the digital channels along with the Analog lines together (See Figure 76). 
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Figure 75: Default Report Format 

Figure 76: Report with Spread Digital Among Graphs checked 
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13. No Trigger check box causes the report to exclude Analog Trigger faults from the report. An 

Event Trigger will still display if an Event Channel is set up, and an Event Channel caused the 

Trigger or an Event Channel changed state while the record was being created. 

14. In the Panel Size box, specify a number to define the amount of space the event and analog trigger 

lines will use at the bottom of a printed page. 

15. In the Font Size Global Control box, type the size of the font for everything except the Fault 

Summary Report, the title of the waveform pages, and any annotations that may have been added. 

16. In the Font Size Title Control box, type the size of the font for the title that appears at the top of 

each waveform or oscillogram page. 

17. In the Annotate Text Size box, type the size of the font for any annotations that may have been 

added to a waveform or oscillogram page. 

18. Click the OK button. 

The waveforms are sent to the printer. 

5.16 Copying/Backing up a Fault Record 

When fault records are retrieved from the APP Recorder, they are saved to the data path that you specified 

when you configured ClearView. On the Fault Summary tab, you can select the retrieved faults and copy 

them to another directory.  

When you configured ClearView, you also specified two backup paths. You can copy a fault record and 

save it in one or both of these backup drives, or in another location that you specify. For more information 

on specifying the backup paths, see Configuring the Main Configuration Settings on Page 9-2. 

➢ To Copy a Fault Record 

1. In the Fault Summary tab, right-click the fault record that you want to copy.  

The pop-up menu appears. 

2. Point to Copy Selected Fault and then select one of the following options: 

To copy the fault record to the first backup drive, click Copy to Backup 1 Drive. 

To copy the fault record to the second backup drive, click Copy to Backup 2 Drive. 

To copy the fault record to a different drive, click Copy to… and then browse to the folder 

where you want to save the copied fault record. Then click the OK button. 

5.17 Deleting a Fault File 

➢ To Delete a Fault Record 

1. In the Fault Summary tab, right-click the fault record that you want to delete.  

The pop-up menu appears. 

2. Click Delete Fault File(s). 

A confirmation message box appears. 

3. Click Yes. 
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5.18 Changing the Folder You View 

You can save incoming fault records to the different folders that you specified when you configured 

ClearView, and to any other path that you specify from within the Fault Summary tab. To view the 

contents of these folders, you can change the folder you view in the Fault Summary tab. 

➢ To Change the Folder, You View in the Fault Summary Tab  

1. Right-click in the Fault Summary tab. 

2. Point to Change Viewing Path and then click one of the following:  

To view the contents of the data path, click Data Path. 

To view the contents of the first backup drive, click Backup 1 Drive. 

To view the contents of the second backup drive, click Backup 2 Drive. 

To view the contents of a different drive, click Path… and then browse to the folder that you 

want to view. Then click the OK button. 

5.19 Merging or Saving Selected Faults  

➢ To Merge or Save Selected Faults  

1. In the Fault Summary tab, click on the fault record that you want to merge or save. 

Hold the <Ctrl> key and click one or more fault records to be merged (see Warning below). Right 

Click on a selected file and click Merge or Save Selected Faults As… 

A Merge or Save Data File As window appears. 

2. Browse to the folder where you want to save the merged or saved file. 

3. Do one of the following: 

To merge the selected fault(s) with an existing fault file, click the file and then click Save. 

To create a new file for the selected files, in the File name box, type the new file name and 

then click Save. 

*CAUTION* 
 
 

ClearView does not restrict the size of the merged file. Merged files 
can get very large if the records being merged are far apart in time. 
ClearView automatically populates empty rows (time between merged 
faults) with “0” 
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6. Managing Point Assignment (PA) 

Records 
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6.1 Overview of the Point Assignment Record 

The point assignment (PA) record is a user-defined record. Information in this record is used by the 

recorder to control system operation, perform calculations, and perform analysis. If Point Assignment 

information is provided by the customer, factory personnel will enter that information into the recorder 

before shipping it.  

A Point Assignment Record contains information concerning the recorder hardware, analog channels, 

analog triggers, events, sampling rates, and different types of recording. A Point Assignment Record can be 

created or edited via the APP Recorder software or the APP ClearView software. The Point Assignment 

file can be downloaded from the master station (via APP ClearView) to the APP Recorder or vice versa.  

6.2 Accessing the Edit Point Assignment Record Window 

➢ To Access the Edit Point Assignment Record Window 

1. In the APP ClearView window, from the Edit menu, point to Point Assignment Record and 

then click Edit PA Record. 

The Edit Point Assignment Record window appears, as shown in the following figure. 

Figure 77: Edit Point Assignment Record Window—Chassis Configuration Tab 
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6.3 Editing a Point Assignment Record 

You can edit a Point Assignment Record at any time. If you edit a Point Assignment Record on the master 

station, be sure to send the Point Assignment Record to the appropriate APP Recorder. 

➢ To Edit a PA Record 

1. In the APP ClearView window, from the Recorder list, select the APP Recorder for which you 

want to edit the Point Assignment Record. 

2. From the Edit menu, point to Point Assignment Record, and then click Edit PA Record. 

The Edit Point Assignment Record window appears.  

Note:  If the Setup folder for the APP Recorder that you select does not contain a Point 
Assignment Record, then clicking Edit will create an empty Point Assignment Record 
which you can edit. 

3. Complete any of the following procedures, as necessary: 

▪ Saving a Point Assignment Record 

▪ Save As to save a copy or alternative Point Assignment Record 

▪ Cancelling Your Changes to the Point Assignment Record 

▪ Printing a Point Assignment Record 

▪ Enabling Scrolling in the PA Record Window 

▪ Editing the Station Name 

▪ Configuring the Chassis 

▪ Configuring Analog Channels 

▪ Configuring Trigger Channels 

▪ Configuring Event Channels 

▪ Configuring Traveling Wave Channels 

▪ Configuring General Settings 

▪ Notes, (Include free form notes about the Point Assignment Record) 

6.4 Sending a Point Assignment Record to the Recorder 

You can use this menu option to send a Point Assignment Record to an APP Recorder. 

6.5 Deleting a Point Assignment Record 

To Delete a PA Record 

1. In the APP ClearView window, from the APP Recorder list, select the APP Recorder for which 

you want to delete the Point Assignment Record. 

2. From the Edit menu, point to Point Assignment Record, and then click Delete PA Record. 

A confirmation message appears. 

3. Click Yes. 



Managing Point Assignment (PA) Records 6-4 

6.6 Printing a Point Assignment Record 

➢ To Print the Point Assignment Record 

1. In the APP ClearView window, from the APP Recorder list, select the recorder for which you 

want to print the Point Assignment Record. 

2. From the APP ClearView window, from the Edit menu, point to Point Assignment Record, 

point to Print PA Record, and then do one of the following: 

Click Preview to view an onscreen picture of how the printout will appear. 

Click Print to print a hardcopy of the Point Assignment Record. The Print window will 

appear. Complete the fields in this window and then click the OK button.  

The entire Point Assignment Record is printed. 

6.7 Adding a Point Assignment Record 

Each APP Recorder must have its own Point Assignment Record. When you add a Point Assignment 

Record, you designate the APP Recorder ID. Each APP Recorder must have a unique ID number. The 

master station program distinguishes one APP Recorder from another by the recorder ID.  

➢ To Add a PA Record 

1. In the APP ClearView window, from the Edit menu, point to Point Assignment Record, and 

then click Add PA Record.  

The Add Point Assignment Record window appears. 

2. Type a unique, numeric recorder ID number and then click the OK button. 

The New Point Assignment Record window appears. 

3. Click the OK button. 

The Edit Point Assignment Record window appears. 

4. Complete the tabs and fields in this window. See the following procedures for details: 

▪ Saving a Point Assignment Record 

▪ Cancelling Your Changes to a Point Assignment Record 

▪ Printing a Point Assignment Record 

▪ Enabling Scrolling in the PA Record Windows 

▪ Editing the Station Name 

▪ Configuring the Chassis 

▪ Configuring Analog Channels 

▪ Configuring Trigger Channels 

▪ Configuring Event Channels 

▪ Configuring Traveling Wave Channels 

▪ Configuring General Settings 

▪ Notes, (Include free form notes about the Point Assignment Record) 

6.8 Saving a Point Assignment Record 

You can save your Point Assignment Record to the Setup path that you specified in the ClearView 

Configuration window. By default, this path is C:\APP Recorder\Setup. 

Note: If the administrator feature is used, only the administrator has privileges to save a newly 
created Point Assignment Record or to save changes to an edited Point Assignment 
Record. 
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6.9 “Save As” a Point Assignment Record 

You can “Save As” your Point Assignment Record to create a copy, or to create a separate alternative Point 

Assignment Record. You can specify the path however, the Setup path that you specified in the ClearView 

Configuration window is the default, this path is C:\APP Clearview\Setup. 

Note: The Point Assignment Record file in use for a recorder is the one named with the 
Recorder ID.par (e.g. R100.par) only. 

6.10 Cancelling Your Changes to the Point Assignment Record 

➢ To Cancel Your Changes to the Point Assignment Record 

In the Edit Point Assignment Record window, from the menu bar, click Cancel. 

The Point Assignment Record is closed without being saved. 

6.11 Enabling Scrolling in the PA Record Windows 

The Point Assignment Record can be lengthy. If you are using the APP Monitor & Keyboard chassis, then 

your LCD screen is smaller than a standard computer screen. You can enable scrolling in the Point 

Assignment Record window in order to see portions of the screen that might otherwise be cut off. 

➢ To Enable Scrolling in the Point Assignment Record Window 

In the Edit Point Assignment Record window, from the menu bar, click Enable Scrolling.  

6.12 Editing the Station Name 

When you add a new Point Assignment Record, you specify the APP Recorder for which it is associated. 

By default, the ClearView assigns the station name, “Dummy Station.” You can change this name to be 

more meaningful. 

➢ To Edit the Station Name 

1. In the Edit Point Assignment Record window, in the Station box, type the station or location 

name.  

Note: These special characters are not allowed: \ / : * ? " < > |. If you use those, they will 
automatically be converted to a dash (-). 

2. From the menu bar, click Save.  

6.13 Configuring the Chassis  

1. In the Edit Point Assignment Record window, click the Chassis Config tab. 

The tab appears, as shown in the following window. 
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Figure 78: Chassis Config. Tab 

2. Km check box, checking this box on this Tab or any Tab in the Point Assignment record 

configuration will enable the display of distance in kilometers wherever distance is displayed. 

Note: Records that include distance are always stored in Miles. Using the Km check box only 
provides a conversion to display distance in Kilometers and does not change the data. 

3. In the #Chassis box, type the total number of data chassis in your system. 

4. Click the OK button. 

The tab displays a table with a separate row for each chassis. ClearView automatically increments 

the DSP IP addresses for each chassis. 

5. You can designate the Analog, Event, and Tw boards for each slot in each Data Chassis. Each data 

chassis contains 13 card slots. Slot 7 is reserved for the DSP/IRIG board, slot 12 is reserved for the 

alarm output board, and slot 13 is reserved for the power supply board.  

 

To define an analog board, complete steps 5 and 6. 

6. To enter an analog board in the table, select the Place Analog Board option and then click in a cell 

that represents a slot for a particular chassis. By default, ClearView inserts an A in the cell where 

you click.  

 

There are 3 analog channels per analog circuit board. When an A appears in a cell, it means that all 

3 analog channels for that chassis and slot combination are active. 

 

As you click, the Analog Boards box is automatically updated with the total number of analog 

boards you have defined. 

 

(V) Virtual Channels designation. You can designate an Analog Board as Virtual to document 

virtual channels on the Chassis Config tab by placing a V in the Slot. The channels are not virtual 

however, until you go into the Analog Tab and use the If Virtual feature for the desired channels. 
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Note: An Analog Fail alarm will occur if the channels are not made virtual on the Analog 
tab. 

Note: To indicate a slot is empty, do not click on a cell. If you click accidentally, you can 
select the value and then press backspace or delete key. 

Note: You can enter any mix of analog and event boards as long as your entries 
identically match the hardware configuration. 

7. You can change the number of active channels in order to conserve memory and/or increase the 

speed of the data transfer process. To change the number of active channels, click in the appropriate 

cell and then use the keyboard to type any of the following values:  

• Enter a 2 to enable 2 channels.  

• Enter a 1 to enable 1 channel.  

• Enter a 0 to disable all the analog channels on the circuit board.  

• Enter an A to activate all 3 analog channels on the circuit board.  

8. Do you want to define an Event Board? 

If yes, complete step 9. 

If no, skip to step 10.  

9. Click the Place Event Board option button and then click in a cell that represents a slot for a 

particular chassis. ClearView inserts an E in the cell where you click. There are 8 event channels on 

each event board which can be used for event triggering, sequence of event recording or both. 

 

As you click, the Event Boards box is automatically updated with the total number of event boards 

you have defined. 

Note: To indicate that a slot is empty, do not click in a cell. If you click accidentally, you 
can select the value and then press backspace or delete key. 

10. Do you want to define a Traveling Wave Board? 

If yes, complete step 11. 

If no, skip to step 12. 

11. Click the Place TW Board option button and then click in a cell that represents a slot for a 

particular chassis. ClearView inserts a T in the cell where you click. There is 1 TW channel on each 

TW board which can be used for Traveling Wave. 

 

As you click, the TW Channels box is automatically updated with the total number of TW 

Channels you have defined. 

 

(W) TW + Virtual Channels designation. You can designate a TW Board and three virtual analog 

channels in the Chassis Config tab by placing a W in the Slot. The channels are not virtual however, 

until you go into the Analog Tab and use the If Virtual feature for the desired channels. 

Note: An Analog Fail alarm will occur if the channels are not made virtual on the Analog 
tab  

Note: To indicate a slot is empty, do not click on a cell. If you click accidentally, you can 
select the value and then press backspace or delete key. 
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12. Each DSP circuit board, one per chassis, and 618 Controller was assigned an IP address at the 

factory. That IP address must be entered in the DSP IP Address column for each chassis/DSP board 

or 618 Controller.  The IP address will be entered before the APP Recorder leaves the factory unless 

the factory is shipping an add-on Data chassis and has not been informed of its installation location.  

13. Ext 1PPS, this indicates the use of an external 1PPS source. Click on the field to place an X. Click 

the box again to remove the X. Ext 1PPS does not need to be checked for 618 controller chassis. 

14. Ignore, you can virtually remove a chassis, primarily used for trouble shooting, by clicking the 

Ignore field. Click the box again to remove the X. If there is a Traveling Wave board in the chassis 

being ignored, it will not be ignored. To ignore the TW board, go to the TW Tab and click ignore 

for that TW channel. 

15. ClearView knows which DSP or 618 controller it is communicating with by the port number. Each 

chassis/DSP must talk to the computer through a different port number. A default number of 4310 is 

entered for the first chassis/DSP. ClearView automatically assigns port numbers for the additional 

chassis (+1 for the next chassis and so on….). You can change the port number, if necessary. Do 

you want to change the port number for a DSP? 

If yes, complete step 16. 

If no, skip to step 17.  

16. To change the port number for a DSP, type the new number in the Chassis#1 Port# box. 

17. In the Master Chassis # box, enter the chassis number of the master chassis. When a reboot 

command is sent to the APP Recorder, this chassis will be rebooted last to ensure that the other 

chassis reboot. 

18. From the menu bar, click Save. 

6.14 Configuring IEEE-61850 Sampled Values 

This process is to configure the Point Assignment Record for an APP-618 Controller to receive Sampled 

Values (SV) streams. You will define one or more 618 Controllers for Sampled Values and set up the 

configuration for each chassis. 

Note: SV is only supported in APP Recorder v3.2.1 and higher. 

In the Chassis Config tab, change Slot-7 of each 618 chassis from DSP to “GPU” as shown below.  Add the 

number of analog boards to the chassis based on how many analog channels are required (3 channels per 

Analog Board).  The example below shows a chassis configured for 18 analog channels. Only place the 

number of boards for the required number of channels. See Section 6.13 Configuring the Chassis above for 

instructions and rules.  

Ext-1PPS – Do not place an X for the APP-618 Controller chassis. It does not use Ext-1PPS field as the 

618 will receive its clock from a PTP source on the Process Bus or DSP network. 

Figure 79 APP-618 Sampled Values Chassis Config 
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Next, double click on “GPU” in the Slot-7 field of the APP-618 chassis to open the GPU Cfg window 

shown below.  

 

Fill in #SV field, top left, with the number of different SV streams (maximum of 2) the chassis is to 

subscribe to and click OK.   

The streams will be populated based on the #SV entry. The C# field is preset to Chassis#Stream# (C#S#). 

The number of SV Streams and SV Analog channels will be populated on the Chassis Configuration TAB  

SVID field, enter the SVID string for each of the SV streams the chassis is subscribed to.  This is the value 

used to distinguish between different SV streams.   

MAC Address, this field is used to further label unique SV devices and is not used by the Recorder 

currently for processing. It is recommended to populate the MAC address of the SV source publishing each 

stream.   

Format, Select the source format of the stream by selecting Line for Streams from an MU.  PTP Voltage 

Module (PVM) format is NOT supported currently. 

 

#An field sets how many of the 8 channels within an SV stream the chassis will use.  Note that when using 

fewer than 8 channels, the chassis will discard channels from the end. For example, setting #An to 6 will 

cause the chassis to discard channels 7 & 8 of the stream. 

Value Type, Select from the dropdown int or short. The default will be set based on the selection in the 

Format field (Line or PVM). 

Value Type determines what format the analog values in the SV packet are recorded in. This enables the 

618 to know how to interpret the incoming data. The default will be set based on the selection in the 

Format field (Line or PVM). 

 

Figure 80 Sampled Values PAR Settings 

Figure 81 SV PAR Format Setting 
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Figure 82 SV PAR Value Type Setting 

Cell Width, like Value Type, defines the format of the incoming data. This value should not be changed 

from the default. The default will be set based on the selection in the Format field (Line or PVM). 

Primary field sets whether the SV stream contains primary or secondary values.  Yes = Primary, No = 

Secondary This should not need to be changed from the default. . The default will be set based on the 

selection in the Format field (Line or PVM). 

 

 

Figure 83 SV PAR Primary Setting 

 

Scale Factor field contains the SV scale factors for each of the channels within an SV stream with the 

values separated by ‘|’ symbols.  These values must match the scale factors used in the SV publisher.  The 

default will be set based on the selection in the Format field (Line or PVM). 

The order in which the streams are entered into the configuration determines the order in which the data 

from the streams is placed in the record.  The configuration shown above shows for Chassis#2, the values 

of analog channels 1-8 will be sourced from the stream SV1 while analog channels 9-16 are sourced from 

the stream SV2. 

The GPU configuration is saved in a separate file in the Setup Folder. The name format is RnnnCnn.gpu 

where Rnnn is the recorder ID and Cnn is the chassis number of the APP-618. 

Analog Config tab, once the Chassis config and SV config have been set up, go to the Analog TAB. Set up 

the Analog channels. When you set a Full Scale value for a channel, the AbsFS for that channel must also 

be set to the same value in order for the 618 chassis to scale the data correctly. 

Double click or right click on the Virtual\AbsFS field for the channel to open the Virtual\AbsFS setting 

window. See 6.15 Configuring Analog Channels section for more information. 
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Figure 84 SV PAR Analog Channel AbsFS settings 

Sampling Rate for APP-618 Controller 

In the General Settings tab, make sure that the transient frequency is set to 4800 Hz.  As of this writing, the 

618 Controller does not yet support other sampling frequencies. 

6.15 Configuring Analog Channels  

The Analog Channels tab contains setup information for each analog input channel. The number of analog 

channels displayed is determined by the setup in the Chassis Config tab. 

You can edit the values by first clicking the row that you want to update. You can use the Windows Shift 

and Control keys to select multiple rows simultaneously. If you select multiple rows, then your edits will be 

applied to all the selected rows. Update the values by typing in the entry fields above the column headings. 

Your entries are displayed in the selected row(s) immediately. 

*CAUTION* All entries in the Point Assignment Record should be secondary 
values. 
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➢ To Configure Analog Channels 

1. In the Edit Point Assignment Record window, click the Analog Channels tab. 

The tab appears, as shown in the following window.  

You can specify a phase for one or more channels. This will allow you to apply a color standard for 

that phase. Select the channel(s) for which you want to specify a phase. Then, in the Phase box, 

select the phase to apply.  

Note: You can select the specific color standard on the Graphic and Data Analysis window 
under (Options menu: Graph Options).  

2. Km check box, checking this box on this Tab or any Tab in the Point Assignment record configuration 

will enable the display of distance in kilometers wherever distance is displayed. 

Note: Records that include distance are always stored in Miles. Using the Km check box only 
provides a conversion to display distance in Kilometers and does not change the data. 

3. Select the channel(s) for which you want to specify a description. Then, in the Analog Channel 

Description box, update the description. ClearView puts no limit to the number of characters you can 

enter, but the COMTRADE standard limits descriptions to 64 characters. To ensure other 

COMTRADE viewers can read the fault file, be sure to keep the description to under 64 characters. 

4. Select the channel(s) for which you want to specify a type. Then, in the Type list, select the analog 

input type. Available types include AC voltage, DC voltage, AC current, DC current, frequency, watt, 

var, radians per second, rpm, Temp in ̊ F and Temp in ̊ C, P(%), b(bar), d(deg), g(gain). 

Figure 85: Point Assignment Record Window—Analog Channels Tab 
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*CAUTION* The selected type must match the hardware setup. Hardware jumpers 
must be set on the analog circuit boards to allow them to correctly 
measure voltage or current (two jumpers per channel).  

See the APP Recorder Operating Manual for additional information on 
hardware setup. 

5. You can specify the current transformer/potential transformer ratio. This value is used to calculate 

the primary values. The ratio is X to 1. Select the channel(s) for which you want to specify the 

current transformer/potential transformer ratio. Then, in the CT/PT box, enter the ratio of the 

current transformer or potential transformer being used.  

6. You can specify the secondary full scale value. Select the channel(s) for which you want to 

specify the full scale. Then, in the Full Scale box, type the maximum anticipated secondary full 

scale value. 

Note: Click any value in the Full Scale column to see its Absolute Full Scale in the tray at 
the bottom of the window. 

7. Are you using an external shunt or CT for a channel?  

If yes, click the channel and then select the Use Ext. Shunt for Current Chan. check box. 

Note: You should select this only if one or more external current sensing devices will be used. 

The Ext Shunt (mOhm) column appears. By default, if you leave the field empty, 

ClearView will use the 2-milliohm internal shunt for the channel current calculation. If you 

are using an external shunt or CT, then type the shunt value or equivalent shunt value in this 

field. 

*CAUTION* The external shunt entry should be in milliohms.  

*CAUTION* External shunts should be wired to voltage inputs but the Point 
Assignment Record should be setup as a current channel. 

If no, skip to the next step. 

8. If Virtual\Abs FS, Virtual channels are an aggregate of 2 or 3 analog channels. To define a virtual 

channel, double click the cell under If Virtual for the designated channel. Clearview will ask; 

Make Ax Virtual? Click yes, then Clearview will ask for the analog channels to be combined for 

the virtual channel. You can make the channel negative by clicking on the plus (+) and change to 

minus (-) or back to +. Enter the channel IDs up to 3. 

 

If you want to specify the Absolute Full Scale Value for a channel enter the value in the AbsFS 

field and click OK. This setting will override the Absolute full scale described below in the next 

section. 

Figure 86: Make a Channel Virtual 
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When setting up Analog channels associated with an APP-618 Controller for Sampled Values 

stream, you must set AbsFS the same value as the Full Scale value. 

9. If you are done editing PA record, click Save.  

Note: Triggers can be configured for Virtual Channels.  

➢ New Absolute Full Scale 

You can also set Abs Full Scale by selecting the channel and right clicking. A pop-up window will appear 

and allow you to enter an absolute full scale value. 

Figure 87 New Absolute Full Scale 

➢ Viewing a Chart of Max Full Scale versus Absolute Full Scale Values 

Click the Show Abs. FS Chart.  

 

The Absolute full scale (or Abs. Full Scale for short) is dependent on the channel full scale setting, but it 

reflects the absolute full scale defined by the hardware divider and gain circuitry. There are 31 absolute full 

scale values for voltage or current ranging from 0.309V to 954V and 3.093A to 954.140A. When you select 

a full scale value, ClearView automatically calculates an absolute full scale value based on the finite 

hardware choices. 

The chart will change according to each individual channel configuration. You can enter any full scale 

value between one Max Full Scale to the next, and the Absolute Full Scale will stay the same until it passes 

the next Max Full Scale.  

Note: If you specified an Absolute Full Scale value as described above in Step 8, the value 
entered will override the calculated absolute full scale. 

Note: The absolute full scale is the amplitude at which the input signal will clip.  

6.16 Configuring Trigger Channels  

The Trigger Channels tab contains settings that will cause the APP Recorder to trip and create transient 

and extended records. You can define up to a maximum of 30 triggers per chassis; you can also define rate 

of change for each type of trigger. At your discretion, some analog channels may have no triggers assigned 

to them and some analog channels may have multiple triggers assigned to them. 

You can edit the values by first clicking the row that you want to update. You can use the Windows Shift 

and Control keys to select multiple rows simultaneously. If you select multiple rows, then your edits will be 

applied to all the selected rows. Update the values by typing in the entry fields above the column headings. 

Your entries are displayed in the selected row(s) immediately.  
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➢ To Configure Trigger Channels 

1. In the Edit Point Assignment Record window, click the Trigger Channels tab. 

The tab appears, as shown in the following figure.  

The number of trigger channels displayed on this tab is determined by the number of chassis 

defined in the Chassis Config tab.  

Note: Each chassis has a total of 30 triggers reserved for it. For example, if the first Data 
chassis has 1 analog card, (3 analog channels), the first 30 triggers are reserved for 
those channels. The triggers for a second Data chassis start at trigger 31. 

2. Km check box, checking this box on this Tab or any Tab in the Point Assignment record 

configuration will enable the display of distance in kilometers wherever distance is displayed. 

Note: Records that include distance are always stored in Miles. Using the Km check box only 
provides a conversion to display distance in Kilometers and does not change the data. 

3. A#, Click the trigger(s) for which you want to specify an analog channel. Then, in the A# list, 

select the analog channel(s) for the trigger. 

Note:  In the A# column, an analog channel can appear more than one time.   

4. Description, click the triggers for which you want to specify a description. Then, in the Trigger 

Channel Description box, type a meaningful description. 

Tip:  If the trigger descriptions should be the same as the analog channel descriptions, 
right-click anywhere in the Channel Description row to display the pop-up menu 
shown in the following. Then click Use Analog Channel Description(s).  

Figure 88: Point Assignment Record Trigger Channel Tab 



Managing Point Assignment (PA) Records 6-16 

 

Figure 89: Use Analog Channel Description Menu 

If you are setting up the triggers for the first time, right-click anywhere in the 
channel description row and then select Use default A#.  

Tagging or highlighting multiple rows then using the Use default A# menu option 
can save time. 

5. Type, Click the trigger(s) for which you want to specify a trigger type. Then from the Type list, 

select the type. The available trigger types are:  

Figure 90: Trigger Type Menu 

Disabled: Disables a trigger. A trigger cannot be initiated from a channel with this setting. 

RMS: Transient recording will begin if the RMS limits are exceeded. This could be an over 

limit, under limit, or both over/under limit. Remember, this is an RMS value not a single point 

value. 

Hz_Step: This is a frequency trigger. Transient recording will begin if the frequency limits 

are exceeded. This could be an over limit, under limit, or both over/under limit, and/or 

Frequency Step. 

APP Recorder version 2.7.0 and later uses a different algorithm than prior versions to detect 

frequency disturbances. The new method measures slope by two points that are four seconds 

apart in time, and then measures another slope 1 second later by the same method. If the 

absolute value of both slopes exceeds the trigger threshold and they have the same sign, then 

the trigger activates. 
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Sample Parameter Settings: 

Parameter Setting 

Type Hz_Step 

Start Over 

Duration 1.00 

Trip if Over 61 

Trip if Under 59 

Trip if Rate > /?s 0.004 

Disturb Yes 

Then double click on the trigger to enter the extra parameter Minimum RMS. 

 

This trigger operates using the Virginia Tech FNET rate of change trigger method described 

below.  The “duration” setting sets the displacement time, and the slope time is four times the 

displacement time.  For the Eastern Interconnection a slope time of four seconds and a 

displacement time of one second is a good setting to capture events. 

The “Trip if Rate > ?/s” setting is the minimum slope required to activate the trigger.  A setting 

of 0.0038 Hz/sec will trigger for approximately 800 MW load changes. 

The delta frequency trigger described in below explains the operation of the old trigger (prior to 

Apprecorder 2.6.8) in addition to the VT trigger. 

If over or under frequency triggers are desired, it is recommended to implement a separate 

trigger for that function using the “Hz” trigger type. 
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Figure 91 HZ Step Method Illustration 

For further details about Frequency Step Trigger, download the paper “Frequency Triggers” 

published in 2006 in Fault Recorder Conference. (http://www.truc.org/papers/2006) 

Note: For all triggers that require multiple channels for calculation purposes, all of 
the analog channels must be in the same Data chassis.   

Note: To define which channels are used for the multi-channel calculation, first enter 
the trigger type. Then double-click the trigger type. A multi-channel entry 
window will appear where you can specify the values. 

0Seq: This is a zero-sequence trigger. Transient recording will begin if the zero sequence 

limits are exceeded.  

+Seq: This is a positive sequence trigger. Transient recording will begin if the positive 

sequence limits are exceeded.  

-Seq: This is a negative sequence trigger. Transient recording will begin if the negative 

sequence limits are exceeded. 

“HD”: This is a harmonic distortion trigger. Transient recording will begin if any calculated 

harmonic, (See Table below for limits), exceeds the set limits. A trigger level entry of 1 equal 

100% harmonic distortion. 

“THD”: This is a total harmonic distortion trigger. Transient recording will begin if the 

calculated sum total distortion, (See Table below for limits), exceeds the set limits. A trigger 

level entry of 1 equal 100% harmonic distortion. 

Note: The HD and THD Triggers will follow the following Harmonic limits based on Transient 
Sampling Rate. 
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Table 1 Harmonic Trigger Calculation Limits 

Transient Sampling Up to Harmonic 

2400 Hz 19th 

4800 Hz 39th 

9600 Hz and above 50th 

Note: As of Version 3.1.8 APP Recorder will show the sign (+, -) for Power related triggers. 
However, it will continue to trigger on absolute value. 

“1p-W”: This is a single-phase power trigger. Transient recording will begin if the calculated 

single phase power limits are exceeded.  

“1p-Vr”: This is a single-phase reactive power (VAR) trigger. Transient recording will begin 

if the calculated VAR limits are exceeded.  

“1p-PF”: This is a single-phase power factor trigger. Transient recording will begin if the 

calculated PF limits are exceeded.  

“3p-W”: This is a three-phase power trigger for a connection from a Phase to Ground 

(transmission line) connection. If you have a connection from a Generator, use the GEN-W 

trigger type listed below. Transient recording will begin if the calculated three phase power 

limits are exceeded.  

“3p-Vr”: This is a three-phase reactive power (VAR) trigger for a connection from a Phase to 

Ground (transmission line) connection. If you have a connection from a Generator, use the 

GEN-Vr trigger type listed below. Transient recording will begin if the calculated three phase 

VAR limits are exceeded.  

“3p-PF”: This is a three-phase power factor trigger for a connection from a Phase to Ground 

(transmission line) connection. If you have a connection from a Generator, use the GEN-PF 

trigger type listed below. Transient recording will begin if the calculated three phase PF limits 

are exceeded.  

Impulse: This is an impulse trigger. Transient recording will begin if a sudden change in 

instantaneous value (disregarding the direction of the change) comparing to last cycle at the 

same phase is larger than the value specified in the over limit box. Note: only the over limit is 

used for this trigger, and it has to be a positive value. 

Unbalance: This is a Voltage unbalance trigger. Transient recording will begin if the voltage 

becomes unbalanced between the 3 channels selected by the amount over in the Trip If over 

Parameter. “Over” is the typical start trigger setting however under or both will also work. 

After selecting the Unbalance trigger type, double click on the channel and a dialogue box 

will pop-up requesting 2 other analog channels for phases 2 and 3. 

 

Flicker: Transient recording will begin if the percentage difference between RMS and Peak 

(Peak – RMS) is more/less than X% of V where V = mid-point between RMS and Peak (Peak 

Figure 92: Extra Trigger Parameters 
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- RMS/2). (i.e. ∆v/v <> X%) The Flicker trigger will be captured based on a percentage. Enter 

the Trip if Over and/or Trip if Under in terms of percentage.  

Hz: This is a frequency trigger. Transient recording will begin if the frequency limits are 

exceeded. This could be an over limit, under limit, or both over/under limit. 

When setting the frequency trigger for PRC-002-5 compliance, you can set the Start 

Parameter for Both and set the Trip if under and Trip if Over to the desired setting. However, 

using one trigger for both conditions can make it complicated to determine which condition 

caused the fault. To more easily know which condition triggered, set up two separate Hz 

triggers, 1 for Over and the second for Under. 

Note: Do not use Duration or Priority setting with Hz trigger. 

Hz_Sign: Hz_Sign is a Frequency trigger intended to be used to record when Rate of Change 

(i.e. Trip if Rate >?/s) parameter is exceeded. To comply with PRC-002-5 Requirement 8.2 

Rate of Change Frequency Trigger, you can set two Hz_sign triggers for the same Channel. 

One Trigger for Off Normal Frequency Trigger and one for Rate of Change Frequency 

Trigger. Set the Start parameter to “OVER” for both and set the Over parameter to a value 

that will not cause a Fault to be recorded. This approach makes it easier to determine what 

condition caused the Trigger. Transient recording will begin when the rate of change limits 

are exceeded. The parameter values are Hz per Second. 

 

Table 2 PRC-002-5 Rate of Change Settings 

o Eastern Interconnection < -0.03125 Hz/sec >0.125 Hz/sec 

o Western Interconnection  < -0.05625 Hz/sec  >0.125 Hz/sec  

o ERCOT Interconnection  < -0.08125 Hz/sec  >0.125 Hz/sec  

o Hydro-Quebec 

Interconnection  

< -0.18125 Hz/sec  >0.1875 Hz/sec  

 

 

 

Figure 94: Setting Hz_Sign Triggers 

Figure 93: Recording on Percentage of Flicker Variance  
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*CAUTION* If you create a THD, HD, Flicker, Freq Step Trigger, Freq Trigger, or 
Freq Sign Trigger, double click on the Trigger Row to reveal the Min 
RMS window (below). Enter the minimum RMS to automatically 
deactivate the Trigger. This will eliminate nuisance triggers when the 
input signal(s) go below the specified minimum RMS value. 

Note: Trigger formulas are proprietary and are not shown in this manual. However, on 
a case-by-case basis and with a written confidentiality agreement, a separate 
technical document can be provided with trigger formula information. 

Gen-W: This is a three phase power trigger for a Phase to Phase connection from a 

Generator. Transient recording will begin if the calculated three phase power limits are 

exceeded. After selecting the Generator-Watts trigger type, double click on the channel and 

a dialogue box will pop-up requesting the Voltage channel for each phase and the Current 

channels for A,B, and C. 

Gen-Vr: This is a three phase reactive power (VAR) trigger for a Phase to Phase power 

connection from a Generator. Transient recording will begin if the calculated three phase 

VAR limits are exceeded.  After selecting the Generator-VARs trigger type, double click on 

the channel and a dialogue box will pop-up requesting the Voltage channel for each phase and 

the Current channels for A,B, and C. 

Gen-PF: This is a three phase Power Factor trigger. Transient recording will begin if the 

calculated three phase PF limits are exceeded.  After selecting the Generator-Power Factor 

trigger type, double click on the channel and a dialogue box will pop-up requesting the 
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Voltage channel for each phase and the Current channels for A,B, and C and the Minimum 

Power. 

MAG: This is a Magnitude trigger. Transient recording will begin if the magnitude limits are 

exceeded. 

RVC: This is a Rapid Voltage Change trigger. Transient recording will begin if the RMS 

change is over or under the thresholds. RVC uses 60 cycles as a reference for detecting RVC 

events referenced every ½ cycle. The over and/or under value is an RMS value based on a 

percentage of your nominal line voltage.  The range, based on the IEC 61000-4-30 standard, 

is 6%. 

The Start field is populated automatically with Both. Calculate the Trip If Over and Trip If 

Under by finding the percentage of the Nominal RMS you would like to trigger on and enter 

the RMS value into the Trip If Over field. The Trip If Under fields will automatically be 

populated with the negative of the value in the Trip if Over field. For example, If you want to 

use 6%, per the standard, of the nominal RMS value of 120, Enter 7.2 in the Trip If Over and 

-7.2 will populate in the Trip If Under field automatically and cannot be entered manually. 

Next, Double click on the RVC trigger line to bring up the Extra Parameter window to enter 

the Minimum RMS, Declared Input Voltage, Voltage Swell Threshold, and Voltage DIP 

Threshold. If the voltage goes below the Minimum RMS, the trigger is deactivated to 

eliminate nuisance triggers. Enter the expected Voltage in the Declared Voltage field cannot 

be 0. The Volt. Swell and Volt Dip parameters are recommended to be 10% of the Declared 

RMS. If voltage is outside either threshold, the Trigger is removed from the recording.  

 

 

Hysteresis setting is based on Trip if over and best practice is to set to 50% (.5) per the 

standard. 

Note: When using DSP 7 or higher there is no restriction on how many RVC triggers, or 
which triggers they are assigned to. With DSP 6 or lower, RVC triggers are limited 
to six per data chassis and must be assigned to 1 or more of the first 6 triggers 
only. 

TRD: This is a Total Rated-Current Distortion Trigger. Only set on Current channels, Trip if 

Under is not used. Set Trip if Over limit using a percentage value of the Rated Current, which 

you will enter in the next step below. Transient recording will begin if TRD exceeds the set limit. 

A trigger level entry of 1 equal 100%.  

 

Next, Double click on the TRD trigger line to bring up the Extra Parameter window to enter the 

Minimum RMS and Rated Current. If the RMS goes below the Minimum RMS, the trigger is 

deactivated to eliminate nuisance triggers.  
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Start, Click the trigger(s) for which you want to specify what will cause APP Recorder to begin 

observing a trigger situation. Then from the Start list, make the appropriate selection.  The 

available starts are: 

Over: Recorder will observe only the settings in the Trip if Over column.  

Under: Recorder will observe only the settings in the Trip if Under column.  

Both: Recorder will observe the settings in the Trip if Over and Trip if Under Limit 

columns. 
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6. Duration, click the trigger(s) for which you want to specify a duration. Then in the Duration box 

enter a time value, in seconds. This setting will desensitize a trigger. For example, if an RMS 

trigger is set to trip over 100 volts and a duration setting of 1 second is entered, the APP Recorder 

will not trigger unless the RMS value exceeds 100 volts for at least 1 second. 

7. Trip-if-Over, Click the trigger(s) that you want to specify as “over limit” triggers. Then in the 

Trip if Over box, enter the value which, when exceeded, will indicate a trigger situation.  

Note: Recorder ignores this Over limit if you select Under in the Start list. 

8. Trip if Under, Click the trigger(s) that you want to specify as “under limit” triggers. Then in the 

Trip if Under box, enter the value, which not reached, will indicate a trigger situation.  

Note:  Recorder ignores this Under limit if you select Over in the Start list. 

9. Trip if Rate >, You can specify a rate of change trigger which runs independently from the over 

limit trigger and/or under limit triggers. Click the trigger(s) for which you want to specify a rate of 

change trigger. Then in the Trip if Rate >?/s box, type the value. 

Note:  If the trigger type is Hz Step, then specifying a value in this box makes the trigger 
a Frequency Step difference trigger. Enter 0 (zero) to disable this trigger. 

10. Hysteresis, it is possible to overwhelm the APP Recorder with triggers. Hundreds of back-to-back 

triggers can cause the system to reboot; meaningless records will consume hard drive space. To 

prevent this, you can specify a hysteresis limit. The hysteresis limit will prevent the APP Recorder 

from recording uncontrolled triggers if a trigger limit is on the threshold for an extended period of 

time. 

 

Click the trigger(s) for which you want to specify a hysteresis limit. In the Hysteresis box, type a 

percentage (1=100%). 

*CAUTION* If you create a Hz Step trigger or Hz trigger, we recommend reducing 
the default Hysteresis to 0.001. However, the value is dependent on 
your trigger limits. 

11. Priority, if you designate a trigger as being a priority trigger, then the APP Recorder will ignore 

the fault record limit and continue to record for 10 seconds even if the trigger level is no longer 

exceeded. This may be useful in over-current situations. Select the trigger(s) that you want to 

designate as priority triggers. Then, from the Trigger list, select Yes. 

12. Disturb, if you designate a trigger as being a disturbance trigger, then the APP Recorder will 

mark the triggered fault records as disturbance records. In the Fault Summary tab, those records 

will be designated with a D in the Type column. Select the trigger(s) that you want to designate as 

disturbance triggers. Then, from the Disturb list, select Yes or None. 

 None will designate the fault as disturbance but will not cause an Alarm. 

13. Chassis #, Chassis number is displayed with the triggers and is designated on the Chassis Config 

Tab. 

Note: A fault record can be both transient “T” and disturbance “D”. If both occurred, the 
type will be “T/D”. 
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6.17 Configuring Event Channels 

The Event Channels tab contains setup information and trigger conditions for each event input channel. 

Event channels are sampled at the user defined analog channel sampling rate. The number of event 

channels displayed is determined by the setup in the Chassis Config tab. 

You can edit the values by first clicking the row that you want to update. You can use the Windows Shift 

and Control keys to select multiple rows simultaneously. If you select multiple rows, then your edits will be 

applied to all the selected rows. Update the values by typing in the entry fields above the column headings. 

Your entries are displayed in the selected row(s) immediately.  

➢ To Configure Event Channels 

1. In the Edit Point Assignment Record window, click the Event Channels tab. 

The tab appears, as shown in the following figure.  

Figure 95: Edit Point Assignment Record Window—Event Channels Tab 
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2. Km check box, checking this box on this Tab or any Tab in the Point Assignment record 

configuration will enable the display of distance in kilometers wherever distance is displayed. 

Note: Records that include distance are always stored in Miles. Using the Km check box only 
provides a conversion to display distance in Kilometers and does not change the data. 

3. Click the event channel(s) for which you want to specify a description. Then in the Description 

box, type a description. You can type up to 81 characters. You can view the Abnormal Event 

Channel Description by clicking once on the Description field and it will alternate which 

description is visible. 

 

Abnormal Event Channel Description can be entered in two ways: 

1. Right click on the Event Channel and a pop-up will appear allowing you to copy Normal 

Desc to Abnormal Desc field 

2. Go to the Abnormal Description view and edit the field. 

4. Click the event channel(s) for which you want to designate the normal state of the external contact 

connected to the event channel input. Then from the Normal State list, select either open or 

closed. 

5. You can configure events to trip the APP Recorder and create transient and extended records.  

Select the event channel(s) for which you want to define the DFR Start condition. Then from the 

DFR Start list, select the appropriate value. Table 3 shows the conditions in which the recording 

process begins. 

 

Priority Trigger, Up-Pri, Down-Pri, and Both-Pri are Priority Start Triggers. If you designate a 

trigger as being a priority trigger, then the APP Recorder will ignore the fault record limit and continue 

to record for 10 seconds. This may be useful in over-current situations. When using Priority Trigger, it 

is recommended to set the DFR/SER setting to Both in order to capture all Fault occurrences (see 

caution below). See 6.19 Configuring General Settings to further understand the impact on the Fault 

record size. 

*CAUTION* When using the Priority Start settings, be aware there may be a delay 
after recording a Priority record before the DFR can start recording 
another Fault on the channel and could result in a missed Fault 
record. However, every trigger will be logged to the SER. 
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Table 3: Event DFR Start Settings and Actions  

When the Setting of 
the DFR Start box is 
this… 

And this action occurs… Then the APP Recorder 
recognizes a trigger situation 

and begins recording  
(Yes or No) 

UP and Up-Pri N.O. contact goes closed Yes 

UP and Up-Pri  N.O. contact returns to open No 

UP and Up-Pri N.C. contact goes open No 

UP and Up-Pri N.C. contact returns to closed Yes 

DOWN and Down-Pri N.O. contact goes closed No 

DOWN and Down-Pri N.O. contact returns to open Yes 

DOWN and Down-Pri N.C. contact goes open Yes 

DOWN and Down-Pri N.C. contact returns to closed No 

BOTH and Both-Pri N.O. contact goes closed Yes 

BOTH and Both-Pri N.O. contact returns to open Yes 

BOTH and Both-Pri N.C. contact goes open Yes 

BOTH and Both-Pri N.C. contact returns to closed Yes 

INHIBITED N.O. contact goes closed No 

INHIBITED N.O. contact returns to open No 

INHIBITED N.C. contact goes open No 

INHIBITED N.C. contact returns to closed No 

6. DFR/SER, you can assign each event channel either a DFR or an SER setting to indicate what 

information should be recorded in the event of a state change. Select the channel(s) for which you 

want to designate the DFR or SER setting. Then, in the DFR/SER list, select one of the following:  

Select the DFR setting and choose (Up/Down/Both) if you want all analog and digital 

channels to be recorded when the event channel is asserted (see the table above).  

Select the SER setting if you want to record only the event channel that changes state. If you 

assign a channel the SER setting, an entry of NA will appear in the DFR Start column. In 

SER mode an Event Channel that changes state will be logged to the daily Sequence of Event 

Report. 

Select both settings if you want an Event Channel change of state to trigger the DFR and log 

to the Sequence of Event Report. If an Event Channel is set to Both and Inhibit, the DFR 

will not trigger but the Event Channel will appear in the Fault Record if it changes state 

during the time of the Fault Record.  

Note: When using a Priority DFR Start Trigger, it is recommended to use Both for DFR/SER 
setting. 
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7. SER Run, you can designate how the APP Recorder should record an SER channel in the event of 

a state change. Select the SER channel(s) for which you want to designate the SER Run setting. 

Then, in the SER Run list, select one of the following:  

 

Select Run if you want the SER feature to log to the Sequence of Events Report.   

Select Stop if you want to inhibit or disable the SER channel.  

Select Alarm if you want the SER feature to run and turn on the SER alarm when the SER 

channel changes state. Additionally, the SER Alarm, in General Settings/Recorder Setup, 

TAB must be mapped to the alarm output. 

Select Cross Trigger to configure the Event Channel for a Cross Trigger to be received from 

another DFR. This will start recording in the receiving DFR at nearly the same time as the 

first/sending DFR to create a parallel fault record for the components monitored in this DFR. 

The DFRs need to be connected to an IP network (typically to the DSP network Ethernet 

Switch) if you are using a network to communicate Cross Triggers (See Recorder Instruction 

Manual Section 4.5 for instructions on configuring Cross Triggers). The Cross Trigger Alarm 

output and the Cross Trigger Event Channel must be configured in the DFR to send Cross 

Triggers over the network.  

Alternatively, the DFRs can be hard wired from the Alarm output associated with the Cross 

Trigger in the first DFR to an event input in the second  DFR to receive the Cross Trigger. 

The Cross Trigger Alarm output in the sending DFR and the Cross Trigger Event Channel in 

the receiving DFR must be configured in the respective DFR Point Assignment Record to 

send and receive Cross Triggers. 

The Event Channel parameters used with Cross Triggers are: 

Normal State DFR Start DFR/SER SER Run IP (Cross Tr) 

Open Inhibited Both Cross Trigger 

Unique 

Computer IP 

Address 

If you are hard wiring the Cross Trigger Alarm to the Event Channel, you can leave the IP 

address blank. See section 4.6.4 in the Recorder Manual for more on configuring the DFRs 

for Cross Triggering. 

Note: The Transient Sampling rates for both DFRs must be set to the same rate. 

Select Perpetual to configure the SER alarm to remain energized when the channel goes into 

abnormal state until the channel returns to Normal State. This is similar to the Alarm setting 

above except Alarm will only stay energized for 10 seconds. The SER Alarm, in General 

Settings/Recorder Setup TAB must be mapped to the alarm output. 
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8. IP (Cross Tr), this field is used when assigning the Event Channel to send and receive cross 

triggers between DFRs across an IP network. Enter the IP address of the DFR computer sending a 

Cross Trigger to this DFR’s event input. If you are hard wiring between the DFRs, you can leave 

the IP address blank. 

Figure 96: Cross Trigger Event Channel in PAR 

9. Chassis#, displays the range of chassis the Event Channel is associated with. 

10. From the menu bar, click Save. 

Note: The Transient Sampling rates for both DFRs must be set to the same rate. 

6.18 Configuring Traveling Wave Channels 

The Traveling Wave, TW Channels tab contains setup information for each TW input channel. The 

number of TW channels displayed is determined by the setup in the Chassis Config tab. 

You can edit the values by first clicking the row that you want to update. You can use the Shift or Control 

key to select multiple rows simultaneously. If you select multiple rows, then your edits will be applied to 

all of the selected rows. Update the values by typing in the entry fields above the column headings. Your 

entries are displayed in the selected row(s) immediately.  

➢ To configure Traveling Wave Channels 

In the Edit Point Assignment Record window, click the TW Channels tab. 

The tab appears, as shown in the following figure. 
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Figure 97 Edit Point Assignment Record Window—Traveling Wave Channels Tab 

1. Km check box, checking this box on this Tab or any Tab in the Point Assignment record 

configuration will enable the display of distance in kilometers wherever distance is displayed. 

Note: Records that include distance are always stored in Miles. Using the Km check box only 
provides a conversion to display distance in Kilometers and does not change the data. 

2. Tw#, this field is automatically filled with incrementing numbers for each TW channel. It 

represents the number of the TW channel. 

3. TW Channel Description, this field is the descriptive name of the channel and should be 

appropriately named to properly identify the TW channel. It is user modifiable. The default name 

is TW Channel #, where # is the TW channel number, found in the column immediately to the left. 

4. Line#, this field is the number that identifies the line that the channel is recording. It is used to 

separate and identify the lines if one system is monitoring for TW faults on multiple channels and 

multiple lines. It is user modifiable and the default line number is 1. 

5. Line (miles), this field represents the length of the line in miles that the TW channel is recording. 

It should be entered to a 3-decimal place precision. The length of the line should be known at the 

time of setup. The default value is 1.000. 

6. CT, this field represents the CT ratio. It should be entered to a 3-decimal place precision. It is user 

modifiable but should not be changed unless the user is clear on how changing this value will 

affect the results. The default value is 1.000, which has been predetermined to be correct when 

using the current transformers supplied with the TW board. 

7. tcal, Time from a Fault to each end of the line should be symmetrical relative to where the fault 

occurred on the line. If differences in infrastructure of the stations at each end or some other factor 

causing the time not to be symmetrical, you can use tcal to calibrate the time to obtain a better 

result. Time Calibration does not have to be done until the first TW fault record has been created. 

The field is 3 decimal place precision and the value is 0.000 unless it is adjusted by a user using 

the Time Calibration process. To determine the calibration factor and entering it into the Point 

Assignment record see (5.10 Find TW Time Calibration (tcal). 

8. c factor, this field represents the speed a fault will travel along the line. The value should be a 6-

decimal place precision number between 0 and 1. The value is a decimal fraction of speed of light, 
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where 1 is the speed of light. It is user modifiable and can be calibrated using fault data and other 

information provided by the user and can be refined to give better results. The default value is 

1.000000. 

Calibration of c factor, Calibration does not have to be done until the first TW fault record has 

been created. If the distance to fault result is not correct, the c factor can be recalibrated to obtain a 

better result. To calibrate the c factor, see (5.9 Find TW C Factor). 

9. IP (Tw Board), this field represents the IP address of the local TW board. The value should be an 

IPv4 address, in the format of xxx.xxx.xxx.xxx where xxx are integers between 0 and 255. It is 

user modifiable. The default value is 192.168.203.xxx, where xxx depends on the slot position of 

the channel in the system. 

10. Tw#@IP (Other End), this field represents the TW channel number and the IP address of the 

remote TW channel at the other end of the line used for double end fault location. It is user 

modifiable. The format is Tw#@xxx.xxx.xxx.xxx, where # is the TW channel number of the 

remote TW board and xxx.xxx.xxx.xxx is the IP address of the remote TW board. It is blank by 

default. 

11. Trip if over sets the trigger noise value if over will trigger a TW fault. The default is 1.4A. The 

over-under voltage of the V-th TRIG is the trigger ratio 𝑅𝑇 multiplied by the peak noise 𝐼𝑁𝑃𝑘, 

which can be positive or negative. The peak noise is generally around 1A at the secondary. 

12. Ignore, this field allows you to virtually remove this channel from the configuration by placing an 

X in the field typically during trouble shooting. Note that ignoring a Chassis in the Chassis TAB 

will not ignore the TW board. You need to use ignore on the TW TAB to affect TW channels. 

13. Chassis#, this field represents the chassis and the slot number the TW board of the corresponding 

TW channel is in the system. The format is x-x, where the first x is the chassis number and the 

second x is the slot number the TW board of the corresponding TW channel is in. It is not user 

modifiable and is filled in automatically. 

14. IP Port#, this field represents the incoming port on the computer that will receive 

communications from the TW board. The value should be an integer from 0 to 65535. It is user 

modifiable but should not be changed unless the user is clear on how changing this value will 

affect the communication of data. The default value is 5310. 

15. IP TW Board, each TW board requires its own IPv4 address. To set this address, connect a 

programming cable from the computer to the TW board or using a UDP connection with an 

Ethernet cable to the DSP board and change the address using the Tools->DSP/TW Board’s 

Ethernet Settings dialogue in the menu bar in either ClearView or the Recorder. The way to 

change a TW board’s IP address is the same as changing the IP address of a DSP board.  

For more detail on configuring a TW Board, see Configuring a DSP/TW Board’s Ethernet and 

IP Address Settings in the APP Recorder Manual. 

6.19 Configuring General Settings 

The General Settings tab contains two tabs: Sampling and Recorder Setup. 

On the Sampling tab you can configure sampling rates and continuous recording settings. You can disable 

or enable Extended Oscillography Recording, Extended RMS Recording, Continuous RMS Recording, 

Continuous Oscillography Recording, Continuous Frequency Recording, and Continuous Phase Recording.  

*CAUTION* Disabling the Extended Recording feature, by entering a sampling rate 
of 0, also disables all of the Continuous Recording features. 

On the Recorder Setup tab, you can configure time synchronization, DNP-3, alarms, and other 

miscellaneous parameters. 
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➢ To Configure Sampling Rates and Continuous Recording Settings 

1. In the Edit Point Assignment Record window, click the General Settings tab. 

In the General Settings tab, the Sampling tab appears by default, as shown in the following 

figure.  

Figure 98: Edit Point Assignment Record Window—General Settings Tab, Sampling Tab 

2. Km check box, checking this box on this Tab or any Tab in the Point Assignment record 

configuration will enable the display of distance in kilometers wherever distance is displayed. 

Note: Records that include distance are always stored in Miles. Using the Km check box only 
provides a conversion to display distance in Kilometers and does not change the data. 

3. In the Line Freq list, select the line frequency (50Hz or 60Hz) for the analog channels that will be 

connected to the APP Recorder. 

4. CBA Phase Rotation check box: if you want to reverse the default order of the three phase 

channel rotation from ABC to CBA, click the CBA check box. 

5. Next to Frequency, from the Transient and Extended lists, select the appropriate sampling rates. 

Table 4 lists the available selections.  

6. Add Transient Rate to Extended check box, Version 3.2.4 added this as an experimental option 

This adds the Transient Rate frequency selected to the list of Extended options. The same 

restrictions for numbers of Analog Boards in a chassis still apply. 

Note: A higher frequency rate will create larger transient and extended record sizes. 
Larger records will take longer to retrieve via modem or network connection.  

Note: The continuous Oscillography samples at the same frequency as the Extended. 

Note: If you are using an APP-618 Controller for Sampled Values streaming, use 
4800Hz Transient sampling Rate only.  
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Table 4: Transient vs. Extended Sampling Rates for Line Frequency=60Hz 

Transient  

(Hz) 

Extended choices  

(Hz) 

Comment 

1200 0, 240, 600, 1200  

2400 0, 240, 480, 600, 1200  

4800 0, 240, 480, 600, 960, 1200 The defaults are 4800 and 960 

9600 0, 240, 480, 600, 960, 1200, 1920  

11520 0, 240, 360, 480, 720, 960, 1440, 

1920 

 

15360 0, 240, 480, 960, 1920  

16800 0, 240, 480, 600, 840, 1200, 1680 See Figure 99 High Speed 

Sampling Rate Limitations for 

limitations 

19200 0, 240, 480, 600, 960, 1200, 1920 See Figure 99 High Speed 

Sampling Rate Limitations for 

limitations 

24000 0, 240, 480, 600, 960, 1200 See Figure 99: High Speed 

Sampling Rate Limitations for 

limitations 

30720 0, 240, 480, 960, 1920 See Figure 99: High Speed 

Sampling Rate Limitations for 

limitations 

Note: “Include High Speed Transient Frequency” must be checked and frequency of 0 
means that recording is disabled.  
 
Table 5: Transient vs. Extended Sampling Rates for Line Frequency=50Hz 

Transient (Hz) Extended choices  

(Hz) 

Comment 

1200 0, 200, 300, 400, 600, 1200  

2400 0, 200, 300, 400, 600, 1200  

4800 0, 200, 300, 400, 600, 800,1200, 

1600 

The defaults are 4800 and 800 

9600 0, 200, 300, 400, 600, 800,1200, 

1600 

 

16800 0, 200, 300, 400, 600, 700, 

800,1200, 1400 

See Figure 99: High Speed 

Sampling Rate Limitations for 

limitations 

19200 0, 200, 300, 400, 600, 800,1200, 

1600 

See Figure 99: High Speed 

Sampling Rate Limitations for 

limitations 

24000 0, 200, 300, 400, 500, 600, 800, 

1000,1200, 1500, 1600 

See Figure 99: High Speed 

Sampling Rate Limitations for 

limitations 
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Note: “Include High Speed Transient Frequency” must be checked. 
Note: An Extended frequency of 0 means that Extended and Continuous recording is 
disabled. 

The next step is to indicate the sampling rates. Transient sampling rates of 16800Hz, 19200Hz 

24000Hz are classified as High Speed sampling rates. You can select these rates only if you first 

select the Include High Speed Transient Frequency check box. See Figure 99: High Speed 

Sampling Rate Limitations for details about the limitations to these sampling rates. 

Do you want to select High Speed transient frequency rates? 

• If yes, then select the Include High Speed Transient Frequency check box. 

• If no, skip to the next step. 

Figure 99: High Speed Sampling Rate Limitations 

7. Next to Prefault, in the Transient and Extended boxes, specify the amount of time/data the APP 

Recorder saves prior to a trigger. The range for transient recording is 50msec to 99.999sec and the 

range for extended recording is 10sec to 990sec. 

8. Next to Postfault, in the Transient and Extended boxes, specify the amount of time/data the APP 

Recorder saves after a trigger returns to a normal state or after the fault limit has been reached. 

The range for transient recording is 50msec to 99.999sec and the range for extended recording is 

10sec to 990sec. 

9. Next to Fault Limit, in the Transient and Extended boxes, specify the maximum amount of 

time/data the APP Recorder saves after a trigger occurs. If the trigger returns to normal before 

fault limit time expires, the post fault time will begin right at the “return to normal” time. If the 

trigger stays abnormal up to the fault limit time, the fault limit time ends, and the post fault time 

begins. The fault limit range for transient recording is 50msec to 99.999sec and the range for 

extended recording is 10sec to 990sec.  

Note: If the priority trigger has been enabled, the program ignores the fault limit time 
and will record until the record grows to a length of 40 seconds.  

Note: The total length of a fault record is Prefault + Fault Limit + Post Fault. The 
recorder has the capability to perform post fault retriggering. If a trigger occurs 
during the post fault time, the fault limit and post fault timers reset to zero and 
begin recounting. Post fault retriggering allows the record to automatically extend 
for easier viewing with the master station software. The post fault retriggering 
process can potentially create a transient record with a 40 second length (max) if 
post fault retriggering keeps going non-stop. If post fault retriggering continues to 
occur after 40 seconds, a new record will be created.  
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10. To overwrite old records, select the Overwrite Old Record when Disk Full check box, and set 

the “Disk Alarm on if Below NNNN NN MBytes” parameter in the Recorder Setup tab. If the 

hard drive memory falls below value, the oldest transient and extended records will be overwritten 

by new incoming records in a “First In, First Out” sequence.  

11. In the Limit #Faults in Disk to box, enter a value between 1 and 9999, representing the number 

fault records to keep at any one time on the disk. By specifying a limit, you will prevent the hard 

drive from filling up if there is a runaway trigger. The default setting is 2000. 

12. Under Extended RMS, in the # Cycles Point box, enter a number to define how often an RMS 

value is stored for extended recording. For example, if you enter 2, then one RMS value will be 

stored every 2 cycles. 

13. Plus Phase, Check this option to calculate power using Extended RMS record to include Phase 

Angle along with RMS 

14. Under Continuous Recording, specify how often RMS, Frequency, and Phase values are stored 

for continuous recording. 

15. The Continuous Oscillography recording follows the sampling rate set for the Extended 

Oscillography Recording. The number of recording days is also entered here (FIFO.) 

*CAUTION* Ensure the Recorder Hard Drive can accommodate the data generated 
by your continuous recording settings. As settings are entered, the 
required memory is displayed. We recommend 50% free space on the 
Recorder hard drive to ensure responsive operation. It is important to 
reserve enough memory to accommodate the continually recorded 
data, otherwise the hard drive will become fragmented over time. APP 
Engineering strives to obtain required customer settings before 
shipping a Recorder. This helps ensure enough memory has been 
reserved. The continuous recording settings are critical. We 
recommend calling APP Engineering if you are entering or changing 
these settings. 

16. Transient Rate Oscillography – Enter the number of days you want the unit to record 1 cycle 

every 10 minutes. The cycle is stored at the transient sample rate. Zero (00) days is the default and 

turns off the feature. When more than 00 days is entered, the TOscData folder is created in the 

C:\Recorder\Data folder and will hold files for each day for the number of days entered. This 

feature is primarily used by Power Engineers along with 3rd party PQ software tools to analyze 

Steady State Power quality. 

17. It is possible for a Trigger Channel to toggle states uncontrollably. To automatically shut down 

and restart a nuisance trigger channel, complete the fields under A Trigger Channel Auto Stop 

From Scan If. Enabling this feature can save hard drive memory. If you enter 0, the feature is 

disabled.  
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18. Include PQ Data check box – If you want to capture Power Quality Data, check the Include 

PQ Data check box in conjunction with setting the associated Triggers in the Trigger Channel 

tab. Then set the retention periods for each PQData file types in days. If you are using DSP board 

Version 7 and software version 3.3.6 higher you will receive all file types listed below. If you 

have DSP Board 6 or below you will receive a subset of the file types listed below. Hover your 

cursor over the  Information icon to see the DSP board restriction note on the screen.  

 

The minimum retention is 2 Days and cannot be set lower or turned off. The following are the file 

types to set: 

With DSP Board 6: 

• 10 Minute Daily Trend 

• Pst Flicker 

• Plt Flicker 

With DSP Board 7 or higher you receive all the available files: 

• 10 Minute Daily Trend 

• Pst Flicker 

• Plt Flicker 

• 3 Second PQ 

• 2 Hour Weekly Trend 

• 3 Second Daily Harmonic 

• 10 Minute Weekly Harmonic 

• Yearly Harmonic Percentile 

See Section 7 Power Quality Recording for Inverter Based Resources for information on these PQ files 

and retention settings. 

Note: Based on PRC-028-1 and IEEE-2800 Table 19 PQ monitoring requirements. (See 

Figure 100 Include PQData Check Box below).   
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Convert PQData files to PQDIF - If you would like the PQ trend files and Flicker files to be 
converted to PQDIF format automatically every day, click the check box for Convert 
COMTRADE to PQDIF Every Day. This will cause PQDIF format files to be saved to 
APPRecorder\Data\PQData\PQDIFData folder. The filenames will be the same as the 
original COMTRADE file it was derived from. 

Include Individual Harmonic Data – Only available when using DSP 7 and Software version 

3.3.6 or higher. This feature enables recording of Individual Harmonic and Total Harmonic 

Distortion (THD). The primary purpose for providing this data is to make it easier to identify the 

Harmonic Order which is above the standard. See Section 7.5.2 Individual Harmonics files for 

more information. 

Voltage Unbalance: Turn on Continuous Recording for Voltage Unbalance by setting 
Unbalance Triggers for the desired analog channels. Once you have set the Unbalance 
trigger type, double click on the channel and a dialogue box will pop-up requesting two 
other analog channels for phases B and C. 

PQData Check box 

Figure 100 Include PQData Check Box 



Managing Point Assignment (PA) Records 6-38 

The data will be written to the \APPRecorder\Data\PQData folder. Unbalance PQ data is written in 

COMTRADE format. This data will be contained in any of the Trend files that are created. 

Depending on if you have DSP6 or DSP 7 as described above. The file(s) contain recorded 

Unbalance data and data for other PQ triggers in COMTRADE format. 

Note: The voltage unbalance measurements are in accordance with the IEC 61000-4-30:2015. 

Flicker: To turn on continuous recording of Flicker, first enable Pst/Plt in the General Settings 

Tab of the Point Assignment Record by clicking on Select Flicker Channels button in the Power 

Quality box shown in the figure below. 

  

Figure 101: Extra Trigger Parameters 

Figure 102 Enable Pst/Plt Continuous Recording 
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The list of the Analog Channels will appear. Then changing the desired Voltage channels to Yes in 

the Flicker column. Only Voltage Channels will work on Flicker. 

As described above, be sure “Include PQ Data” Check Box is checked in the General Settings 

TAB. You will NOT need Flicker Triggers set up in the Trigger Tab for Flicker to be included in 

PQ Data recording. The data will be written to the \APPRecorder\Data\PQData folder.  

➢ Set the retention period in days for each file type described below, minimum retention is 2 Days 
and cannot be set lower or turned off.  

The retention period begins after the period (daily, weekly, yearly...) of the file is passed. For example, for 

a yearly file, a retention of 365 will keep that file for another year after it has received its last sample in the 

interval period. 

NOTE: The first three files described below are the only files created if you are using DSP 
6 or below. On the screen they are indicated by the double asterisks (**) next to 
them. 

10 min daily trend -The file name will be [YYYYMMDD]TrR[RecID].dat. This file contains 

recorded trigger values for all triggers set. If there are HD, THD, or TRD Triggers, it will contain 

the HD/THD data at their highest value. They are recorded at 10 minute intervals in COMTRADE 

format. Typical Retention is 90 days. 

Pst Flicker - Short term flicker data is written in COMTRADE format. The file name will be 

[YYYYMMDD]FkrR[RecID].dat. This file contains recorded flicker data at 10 minute intervals 

for 24 hours. Typical Retention is 90 days. 

Plt Flicker - Long term flicker is written to 

\APPRecorder\Data\PQData\[YYYYMMDD]FkrR[RecID]_Weekly.dat as a 2-hour aggregation 

of Pst data in COMTRADE and stored in the PQ folder. If needed, you can open the COMTRADE 

file anytime and Save as PQDIF. Typical Retention is 90 days. 

Figure 103 Select Flicker Channels for Continuous Recording 
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Note: The recorded Flicker data is based on IEC 61000-4-15 and -30 up to 1620 cpm which is 
equivalent to a flicker frequency of 13.5 Hz. The accuracy of the measurements will suffer 
if the flicker frequency exceeds such.  

Power Quality recording based on IEEE2800 Table 19 

If you have DSP7 or higher and are running APP Recorder Version 3.3.6 or higher, Recorder will 

also create continuous recording files based on IEEE 2800 Table 19. Please See Section  7 

Power Quality Recording for Inverter Based Resources for more information on the PQ files 

created and retention period settings. 

19. It is possible for an SER channel to toggle states uncontrollably. To automatically shut down and 

restart a nuisance SER channel, complete the fields under A SER Channel Auto Stop From Scan 

If. Enabling this feature can save hard drive memory. If you enter 0, the feature is disabled.  

20. Do you want to prevent multiple triggers due to input contact bounce?  

If yes, in the Event Debounce (ms) box, enter a time period in ms. The contact must be in a 

steady state condition for this time period before it triggers the system. 

If no, skip to the next step.  

Note: A fault record’s time will reflect the first detection of a change in state. 

Note: At the bottom of the Sampling Tab screen, the Max Fault Size is displayed based 
on the sampling settings selected 

21. From the menu bar, click Save. 

➢ To Configure Time Synchronization, DNP-3, Alarms, and Other Miscellaneous Parameters 

1. In the Edit Point Assignment Record window, click the General Settings tab. 

2. Click the Recorder Setup tab. 

The tab appears, as shown in the following figure.  

Figure 104: Edit Point Assignment Record Window—General Settings Tab, Recorder Setup Tab 

3. Time Synchronize with: The APP Recorders can synchronize with any external satellite-

controlled clock that can provide a modulated or un-modulated IRIG-B, SNTP, or PTP input. 

Under Time Synchronization with, select the synchronization approach you prefer. See Table 4 

for a description of the available options. 
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Precision Time Protocol (PTP) input Option, PTP input has been developed as an option and 

requires DSP Card version 6.4 or higher. Prior to APP Recorder 3.2.1 checking the PTP will not 

function as PTP. As of 3.2.1 there are two PTP options, End to End (E2E) and PTP (P2P). 

 

PTP (E2E) Provides Synch delay from the Master Clock using End -to-End methodology 

PTP (P2P) Provides Synch delay from the Master Clock using Peer-to-Peer methodology. 

 

Clock Settings for APP-618 Controller  

 

There are two clock connectivity options when there is one or more APP-618 Controllers included 

in the DFR. 

 

If the DFR has both APP-601 Data Chassis and APP-618 Controllers, and if the Clock source is 

PTP to the APP-601 Data Chassis (DSP 6.4 or higher)  then you will have made an APP-601 as 

the Master Chassis and other APP-601 Data Chassis will need Ext-1PPS checked. However, do 

not check Ext-1PPS for the APP-618 Controller (GPU). If your location observes Daylight Saving 

Time, you will want to check the Auto Daylight Saving check box in General Settings and be 

sure the Windows time settings have Adjust for daylight saving time automatically checked  

 

If you have the APP-601 Data Chassis using IRIG-B and APP-618 Controllers in the DFR, the 

618 Controllers will need a PTP clock source via the Process Bus network. The APP-601 Data 

chassis will receive IRIG-B to the Master Chassis and Ext-1PPS to the other APP-601 Data 

Chassis. 

 

*CAUTION* A hardware jumper on the DSP/IRIG circuit board must follow the time 
synchronization software setting shown in the Table below.  

Note: See the section, “Time Quality,” in the APP Recorder Operating Manual for more 
information. 

Table 6: Sync Method and Corresponding Hardware 3-PIN Jumper Position  

Sync Method JP2 3-PIN Jumper (DSP/IRIG Circuit Board) 

Un-modulated IRIG-B Jumper the middle pin & pin closest to the panel 

Modulated IRIG-B Jumper the middle pin & pin furthest from the panel 

SNTP (External Clock) N/A (LAN ENET interface) 

PTP (E2E) Option N/A (LAN ENET interface) 

PTP (P2P) Option N/A (LAN ENET interface) 

Note: There are “unmod” and “mod” labels on back of the DSP board under the JP2. 

4. Auto Daylight Saving, checking this box works with the PTP option sync method and enables 

the time stamp on Fault Records to take Daylight Saving Time into account. Auto Daylight 

Saving uses the Computer Time Zone and time setting as the reference and will adjust for 

Daylight Saving Time if checked.  
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Note: PC Region setting accuracy is required for accurate Daylight Saving Time. The PC 
setting for Daylight Saving Time will not conflict with the setting in the Point Assignment 
Record.  

5. # Hours Different to GPS, this creates an offset to adjust the time stamp on Fault Records from 

UTC. An example is to use this setting to cause the time stamp to be local time. 

If you want to have the Fault Time stamp to be an alternative time from UTC, put in the desired 

UTC offset number of hours (e.g., -5 for Eastern Time) 

If not, skip to the next step 

Note: # Hours Different to GPS only applies to IRIG-B time source. This will not adjust 
time from PC time. 

6. Do you want the APP Recorder to send PMU data?  

If yes, then select the PMU check box.  

If no, skip to the next step. 

Note: The settings for PMU are accessible only through the Recorder Driver window 
due to its real-time requirement. See the APP Recorder Operating Manual for 
further details. 

7. Do you want to enable the DNP-3/Modbus option? 

If yes, then select the DNP-3/Modbus check box.  See the APP Recorder Operating Manual 

for further details. 

If no, skip to the next step 

8. Do you want to enable Goose Capture? 

The Goose Capture check box will enable Generic Object Oriented Substation Event (GOOSE) 

Protocol as defined in IEC 61850. This enables APP Recorder to aggregate status data from 

devices not connected to an APP Recorder with data from devices connected to an APP Recorder. 

APP 601 Recorder captures relevant messages from configured Intelligent Electrical Devices 

(IEDs) and writes them to the Sequence of Event Report (SER) file. 

You will need to follow the setup instructions and install additional software. More information 

can be found in the APP-601 Recorder Operating Manual. For more information, please contact 

APP Engineering at (317) 536-5300. 

If Yes, select the GOOSE Capture check box 

If No, skip to the next step 
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9. The alarm circuit board contains 8 relay outputs. Each relay uses an onboard hardware jumper that 

will allow the contact to be either normally open or normally closed. The board is labeled for easy 

jumper placement.  

 

For each of the alarms described in the following table, enter a number 1-8 to establish the 

mapping between the alarm and the relay output. You can use a number more than once; in other 

words, you can map more than one alarm to each relay. Additionally, an alarm can be mapped to 

multiple outputs. 

Table 7: Alarm Descriptions  

Alarm Description 

Power The relay is energized when system power is applied. Most users will 

put contact in the normally closed position. We recommend Power be 

mapped to its own output, no other alarm should be mapped to this 

output. 

Online The relay is energized when the system program starts and the system is 

recording. Most users will put this contact in the normally closed 

position. We recommend Online be mapped to its own output, no other 

alarm should be mapped to this output. 

Offline The relay is energized when the system program, APP Recorder, is 

stopped. Most users will set this contact to the normally open position. 

Clock Sync Loss The relay is energized when the DSP/IRIG board has completely lost its 

IRIG-B input, such as disconnecting the cable, or the satellite clock 

sends a signal (4 bits per the IEEE standard) that an error greater than 

1ms has occurred. The relay will stay energized until a synchronized 

condition is reestablished. Most users will set this contact as normally 

open. 

Chassis to Chassis 

Communication Error 

The relay will energize if any data acquisition chassis stops 

communicating with the computer control chassis for a period of two 

minutes or more. The relay will stay energized until the problem chassis 

begins proper communication. Most users will set this contact in the 

normally open position. 

Chassis to Master Station 

Communication Error 

The relay will energize if the recorder modem or network card stops 

communicating with the APP recorder software. The relay will remain 

energized until the problem is fixed. Most users will set this contact in a 

normally open position. 

Disk Full The relay will energize when the computer hard drive memory falls 

below the “Disk Alarm on if Below NNNNNN MBytes” parameter in 

the Recorder Setup tab. The relay will remain energized until the hard 

drive free space goes above the limit. However, if the “Overwrite Old 

Record when Disk Full” is enabled in the Sample tab, the alarm relay 

will not energize. Most users set this contact in the normally open 

position. 

Transient Record The relay will energize when the recorder triggers, the relay will remain 

energized for the time set in “Fault/SER LED/Alarm Duration” in the 

Sampling tab. The default is 10 seconds. Most users will set this contact 

in the normally open position. 

Disturbance Record If a trigger has been defined as a disturbance trigger with YES in the 

Point Assignment Record, the relay will energize when the recorder 

trips. The relay will remain energized for the time set in “Fault/SER 
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Alarm Description 

LED/Alarm Duration” in the Sampling tab. The default is 10 seconds. 

Most users will set this contact in a normally open position. If NONE is 

used the Alarm will not energize. 

SER Record If a digital point has been setup as an Alarm point in the Point 

Assignment Record, the relay will energize when any SOE/SER point 

goes abnormal. The relay will remain energized for the time set in 

“Fault/SER LED/Alarm Duration” in the Recorder Setup tab. The 

default is 10 seconds. 

If a digital point has been setup as a Perpetual point in the Point 

Assignment Record, the relay will energize when any SOE/SER point 

goes abnormal. The relay will remain energized until the channel returns 

to Normal status. 

DSP Temperature If the DSP temperature sensor measures a temperature that exceeds the 

setting in the Point Assignment Record, the relay will energize and 

remain energized until the temperature drops below the user setting. The 

user selectable range is 65 to 85° C. The default setting is 70°C. 

Continuous Record If the continuous recording feature has been enabled in the Point 

Assignment Record, the relay will energize if the continuous recording 

begins. This alarm will not clear until the Alarm condition is cleared. 

Continuous Recording should not be mapped with any other alarm 

output. 

PC Health This alarm monitors the hard drive(s) and Hard Drives and CPU 

temperature. This relay will energize if the temperature of the hard drive 

exceeds 70° C. A program called HDSentinel and Speedfan must be 

installed on the recorder computer for this alarm to be functional.  

APP Recorder monitors HDSentinel for active drives, if there are fewer 

active drives in HDSentinel than the number entered in the “# of 

HD/SSD field, in the PAR General Settings Tab, this relay will 

energize. PC Health should not be mapped with any other alarm output. 

PC Health and Sync Loss alarms cannot be mapped together. 

Analog Fail This alarm is activated if the system detects any analog channel signal 

has hit the amplifier limits for an extended period. This may indicate the 

analog channel within the recorder has a component failure. The alarm 

relay will energize. 

Cross Trigger This alarm output is to trigger another DFR when a fault is encountered. 

This starts the recording in the second DFR at nearly the same time as 

the first DFR to create a parallel fault record for the components 

monitored in the second DFR. The DFRs needs to be connected to a 

network and IP addresses provided in the Point Assignment 

Record/Cross Trigger Event Channel OR wired from the alarm output 

associated with the Cross Trigger in the first DFR to a digital event 

input and configured in the second DFR to receive the Cross Trigger. 

See Section 4.6 in the Recorder Manual for more information. 

TW Fail The TW Fail alarm monitors communications with Traveling Wave 

boards. If you have Traveling Wave boards installed and configured in 

the Point Assignment Record, TW Fail Alarm will energize if the TW 

board(s) are not communicating with the Recorder Driver. 
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10. In the Fault/SER LED/Alarm Duration (sec) box, enter the number of seconds the transient 

record LED and transient record output alarm will remain illuminated and energized after a system 

trigger occurs. This cannot be zero. 

11. Sync Loss Delay, enter the number of minutes to delay alarm LED and Sync Loss Relay Output. 

This will reduce or eliminate Sync Loss Nuisance alarms. 

12. Disk Alarm On if Below XXX Mbytes box, enter the number of megabytes Not to go below, that 

determine when the Disk Full LED and Disk Full output alarm will illuminate and energize.  

Note: If the Overwrite Old Record when Disk Full check box is selected on the 
Sampling tab (Edit Point Assignment Record window, General Settings tab), 
the disk full LED and disk full alarm will not illuminate/energize. 

13. Do you want the alarm’s change-of-state to be recorded in the Sequence of Event Report (SER)? 

If yes, then select the Report Alarm States as SER check box. 

If no, skip to the next step. 

Note: The APP Recorder will also record the timestamp and status of the recorder 
(either online or offline) at the end of every day. 

14. There is a temperature sensor on every DSP board. You can set an alarm to activate in the event 

the temperature exceeds a user defined limit in Celsius. The default setting is 70 degree Celsius. 

Do you want to set the temperature alarm? 

If yes, then in the DSP Board Temperature Alarm Limit box, enter a temperature between 

65 and 85 degrees Celsius.  

If no, skip to the next step. 

15. # of HD/SSD (PC-Health), This setting is used to indicate how many Drives are to be monitored 

for the PC-Health alarm. HDSentinel needs to be active, and the drives included are only those 

that can be detected by HDSentinel, (i.e. hard drives and solid state drives) within the recorder 

computer. Drives NOT included: Flash, USB drives, or network drives. APP Recorder will 

generate a PC Health alarm to let you know a drive is not active/failed. No LED is lit for PC 

Health. 

Enter the number of drives to be monitored, usually 3. 

If you enter 0, PC Health will not alarm on hard drive failure but will still alarm on hard drive 

temperature. 

16. Click Save. 
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6.20 Copying a Point Assignment Record 

In the ClearView Configuration window, you can specify the Backup 1 Path and a Backup 2 Path. When 

you copy a Point Assignment Record, you can save the copied record to either of these folders, or to a 

different folder altogether. For information on specifying the Backup 1 and Backup 2 Paths, see Section 

4.17 Configuring Clearview 

➢ To Copy a PA Record 

1. In the APP ClearView window, from the APP Recorder list, select the recorder for which you 

want to copy the Point Assignment Record. 

2. From the Edit menu, point to Point Assignment Record, and then click one of the following:  

▪ To copy the Point Assignment Record to backup location 1 select Copy to Backup 1. 

▪ To copy the Point Assignment Record to backup location 2, select Copy to Backup 2. 

▪ To select a different location to save the copied record, select Copy to… A Browse for 

Folder window appears. Navigate to and select the folder you want and then click the 

OK button. 
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7. Power Quality Recording for Inverter 

Based Resources 
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7.1 Introduction 

The increase in penetration levels of inverter-based resources (IBRs) will significantly change the dynamic 

performance of the bulk electric system. As the penetration levels of inverter-based resources increase and 

the technology of inverter-based resources evolves, recording equipment with PQ-DDR capabilities are 

needed to address the performance requirements of inverter-based resources. APP Recorders can provide a 

one solution system to meet the recording requirements of PRC-002-05, PRC-028, IEEE 2800 Table 19, 

and allow for model validation per MOD 25, 26, and 27. Points of measure can include the HS of the MPT, 

low side of the MPT, solar feeder circuits, BESS feeder circuits, cap banks, and other supplemental 

locations within an IBR plant. 

Regarding IEEE-2800, APP recorders can comply with the requirements of IEEE-2800 Table 19 if the 

proper elements are connected and setup for the APP Data Chassis recording at the point of interconnect 

with the transmission or sub-transmission system (the plant level). The recorder can perform PQ-DDR on 

elements with harmonics being recorded or derived out to the 50th harmonic. PQ-DDR and triggering can 

include Pst, Plt, RVC, very short-term harmonics, short-term harmonics, long-term harmonics, apparent 

power, active power, reactive power, power factor, frequency, and change of frequency. These quantities 

can be continuously recorder and trended with the files being in COMTRADE format and can be 

automatically converted to PQDIFF format. 

7.2 IEEE-2800 Table 19 Measurement Data  

The following table is based on IEEE 2800 Table 19 and describes the data type, points, sampling rate, 

retention and duration for Power Quality continuous recording APP Recorder includes. Retention values 

listed are typical and can be set in the Point Assignment Record. See Section 6.19 Configuring General 

Settings 
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7.3 PQ Hardware 

There are some PQ hardware component required in order for the APP Recorder to receive signals from 

IBRs for PQ. There are three Analog boards involved when recording for PQ. Analog channels are wired to 

both Standard Analog boards and to Voltage or Current specific PQ Analog boards. The IBR needs to send 

voltage signals through a PQ sensor to a PQ Analog Voltage Board. Voltage channels are also wired to a 

standard analog board for recording and triggering on other conditions. PQ Analog Current boards are 

wired in series to a standard analog board wired for current channels. 

PQ Sensor connected to a PQ Voltage analog channel with 1Meg Input Impedance 

PQ Board connected to a PQ Current analog channel with a fixed full scale of about 5A 

The following diagrams illustrate the wiring from a PQ sensor to a PQ Voltage board and an Analog 

Current board. You will notice these boards have only Current connections or Voltage connections, not 

both like the standard Analog board. 

The Voltage board is connected directly to a PQ Sensor. 

 

Figure 105 PQ Voltage board wiring 
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PQ Current boards are wired in series to a standard Analog board wired for the same Current channels 

being recorded. 

 

Figure 106 PQ Current Board wiring 

7.4 Point Assignment Analog TAB settings 

There are PAR settings required or recommended when setting up PQ analog channels. Please see Section 

6-1 Managing Point Assignment (PA) Records for more information on the full PAR set up. 

To measure out to the 50th Harmonic you must use a Transient Sampling rate of 9600 or higher. 

The Transient Sampling rate is recommended to be no higher than 15360. 

When setting up PQ current channels, use Full Scale Setting of 5 and ABS to 20.  This will change 

slightly when calibration is done. 

When setting up PQ voltage channels, Full Scale must be set to 115. 

 

7.5 Power Quality Data Recorder sample Trigger settings 

The plant level Data Chassis PQ settings enable you to trigger for Transient Recording as well as 
Triggers for PQ Continuous Recording. Ideally these triggers will be set up for channels 
in Data Chassis 1. The Figure below shows the typical Trigger settings for recording PQ 
based on IEEE 2800 Table 19. 

Note: When using DSP 7 or higher there is no restriction on how many RVC triggers, or 
which triggers they are assigned to. With DSP 6 or lower, RVC triggers are limited 
to six per data chassis and must be assigned to 1 or more of the first 6 triggers 
only. 
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7.5.1 Power Quality Data Recorder (PQ DDR) 

When utilizing DSP7 or higher in the Data Chassis and running APP Recorder software 3.3.6 or higher the 

following data shown in the table below is recorded when you have checked the Include PQ Data option 

in the Point assignment Record General Settings TAB and have enabled HD, THD, or TRD Triggers in the 

Triggers TAB.  

Note If you have DSP6 or below and have Include PQ Data checked, you will receive the 
five files in Table 8 but not the Harmonics files discussed in this section. 

Note: If you have both HD and THD triggers set on a channel, only one continuous 
recording file will be created for the channel (i.e. it won’t be duplicated). If you have 
either HD or THD and TRD Triggers on the same channel, 2 PQ continuous 
recording files will be recorded for the channel. 

  

Figure 107 Plant Level Data Chassis PQ Settings example 



Power Quality Recording for Inverter Based Resources 7-6 

Table 8 PQ Data Recorded 

Description File Name Interval 
Typical for IEEE-2800 Triggering & 

Continuous Recording for Each 

Mapped Analog Channel 

Typical 

Circular 

Buffer 

3-sec Trigger 

Value  yyyymmddTrR##_3sec 3 seconds, 

daily 
 3p-Vrms, 3p-Irms, 3p-W, 3p-Vr, V-Hz, 

V-Hz Sign, 3p-RVC,  3p-V HD,  3p-I 

HD,  3p-V THD,  3p-I THD, TRD 
10 Days 

10-minTrend 

Trigger Value yyyymmddTrR## 10 minutes, 

daily  Same as above 90 Days 

2-hr Trend 

weekly Trigger 

Value 
yyyymmddTrR##_Weekly 2 hours, 

weekly  Same as above 365 Days 

Trend Flicker Pst yyyymmddFkrR## 10 minutes, 

daily  Selected Volt Channels  90 Days 

Trend Flicker Plt yyyymmddFkrR##_Weekly 2 hours, 

weekly  Selected Volt Channels 90 Days 

7.5.2 Individual Harmonics files  

If you check the Include Individual Harmonic Data check box in the PAR General Settings TAB/Power 

Quality box, Individual Harmonic files are created to enable easier identification of which Harmonic Order 

is the largest and above the Standard. The files will be created for any HD, THD, or TRD triggers set. See 

table below with more details. The following is a summary of the files created and more detail about each 

file name and sampling intervals. 
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Table 9 Harmonics File names and descriptions 

Note: The HD and THD measurements are based on IEC 61000-4-7, -30 and IEEE Std 519 up 
to the harmonic, see table below. Any harmonics beyond the 50th harmonic is not 
measured or recorded by the DFR.  

Transient Sampling Up to Harmonic 

2400 Hz 19th 

4800 Hz 39th 

9600 Hz and above 50th 

3 Second Daily Harmonics - one file per Analog Channel with HD, THD or TRD trigger 3 

second samplings daily starting at 5:00 AM for a year. The filename is 

[YYYYMMDD]IHR[RecID]T[Trigger#]A[Channel#]_VShort_3sec_Daily. Each file contains 50 

X-axes to extract the harmonic order values for each analog channel. Typical Retention is 30 days. 

10 Minute Weekly Harmonics - one file per analog channel with HD, THD or TRD Trigger 

sampled every 10 minutes starting 5am Sunday for a week. The filename is 

[YYYYMMDD]IHR[RecID]T[Trigger#]A[Channel#]_Short_10min_Weekly. Each file contains 

50 X-axes to find the 95th percentile. Typical Retention is 90 days. 

  

Description File Name Interval 

Typical 

Circular 

Buffer 

3-sec Very Short Time 
Individual Harmonic and THD 

yyyymmddIHR##T##A##_VShort_3sec_Daily 

3 seconds, daily (1 file a day per Analog 
Channel with HD as trigger) 
Each file contains 50 X-axes analyzed to 
extract the harmonic order values for each 
analog channel. 

30 Days 

10-min Short Time Individual 
Harmonic and THD 

yyyymmddIHR##T##A##_Short_10min_Weekly 

10 min., weekly (5am daily) (1 file a week per 
Analog Channel with HD as trigger) 
50 X-Axes in the file, to find what is the largest  
harmonic for each analog channel 

90 Days 

10-min weekly 95th percentile  yyyyIHR##T##A#_Short_10min_Weekly_95 

7 days, yearly (5am Sunday) (1 file a year per 
Analog Channel with HD as trigger) 
50 X-Axes in a file, 1 point per week to find the 

95
th

 percentile 

365 Days 

10-min weekly 99th percentile  yyyyIHR##T##A#_Short_10min_Weekly_99 

7 days, yearly (5am Sunday) (1 file a year per 
Analog Channel with HD as trigger) 
50 X-Axes in a file, 1 point per week to find the 

99
th

 percentile (values that exceed 1% for the 
week) 

365 Days 

3-sec weekly 95th percentile  yyyymmddIHR##T##A#_VShort_3sec_Daily_95 

1 day, yearly (5am daily) (1 file a year per 
Analog Channel with HD as trigger) 
50 X-Axes in a file, 1 point per week to find the 

95
th

 percentile 

365 Days 

3-sec weekly 99th percentile  yyyymmddIHR##T##A#_VShort_3sec_Daily_99 

1 day, yearly (5am daily) (1 file a year per 
Analog Channel with HD as trigger) 
50 X-Axes in a file, 1 point per week to find the 

99
th

 percentile (values that exceed 1% for the 
week) 

365 Days 
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Yearly Harmonic Percentile - The following Harmonics recording files are contained in 

APPRecorder\Data\PqData\PQHar folder. You set the retention for all three types of files 

described below in this field (see Section 6.19 Configuring General Settings). Typical Retention 

is 365 days. 

3 Second 95th Percentile Harmonic files - one file per Analog Channel with HD, THD or 

TRD trigger sampled daily at 5am for a year. The filename is 

[YYYYMMDD]IHR[RecID]T[Trigger#]A[Channel#]_VShort_3sec_Daily_95. Each file 

contains 50 X-axes 1 sample per week to find the 95th percentile. 

3 Second 99th Percentile Harmonic files - one file per Analog Channel with an HD trigger 

sampled daily at 5am for a year. The filename is 

[YYYYMMDD]IHR[RecID]T[Trigger#]A[Channel#]_VShort_3sec_Daily_99. Each file 

contains 50 X-axes 1 sample per week to find the 99th percentile. 

10 Minute weekly 95th Percentile Harmonic files - one file per analog channel with an HD 

Trigger sampled weekly (5am Sunday) for a year. The filename is 

[YYYY]IHR[RecID]T[Trigger#]A[Channel#]_Short_10min_Weekly_95. Each file contains 

50 X-axes 1 sample per week to find the 95th percentile. 

10 Minute weekly 99th Percentile Harmonic files - one file per analog channel with an HD 

Trigger sampled weekly (5am Sunday) for a year. The filename is 

[YYYY]IHR[RecID]T[Trigger#]A[Channel#]_Short_10min_Weekly_99. Each file contains 

50 X-axes 1 sample per week to find the 99th percentile. 

7.5.3 Convert COMTRADE to PQDIF 

If you have checked the Convert COMTRADE to PQDIF Every Day in the Power Quality area of the 

PAR General settings TAB, Recorder will create PQDIF files in the APP 

Recorder\Data\PQDATA\PQDIFData folder. The following table lists the PQDif files created 

automatically every day. 

Table 10 Convert to PQDIF files 

Location: Description File Name Interval 

APPRecorder\Data\PQData\ 
PQDIFData 

3-sec Trigger Value  yyyymmddTrR##_3sec 3 seconds, daily 
10-minTrend Trigger 
Value 

yyyymmddTrR## 10 minutes, 
daily 

2-hr Trend weekly 
Trigger Value 

yyyymmddTrR##_Weekly 2 hours, weekly 

Trend Flicker Pst yyyymmddFkrR## 
10 minutes, 
daily 

Trend Flicker Plt yyyymmddFkrR##_Weekly 2 hours, weekly 
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7.5.4 Viewing PQ Continuous recording files 

View the PQ continuous recording files in Clearview by opening a new Graph then navigating to the APP 

Recorder/Data/PQData folder and opening the desired file. The following figures show examples of 

viewing PQ files. See Section 14.2 Opening the Graphic and Data Analysis Window. Look at the Figure 

captions below each image and the filenames at the top to identify which file examples each figure shows. 

Figure 109 Short-Term Flicker (Pst) 

Figure 108 Long-Term Flicker (Plt) 
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Figure 110 3 Sec. PQ DDR + Triggering 

Figure 111 Very Short-Term Harmonics to the 50th 
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Figure 112 Short-Term Harmonics to the 50th 

Figure 113 Long-Term Harmonics to the 50th 
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7.5.5 Harmonics Reports 

In addition to viewing Harmonics files in Clearview, five reports to enhance analysis of Harmonics to 

pinpoint more easily if and where the Standard is not being met based on IEEE-2800 Table 19. These 

reports are saved in  APP Recorder\Data\PQData\PQReport folder and written in HTML format. When you 

open a report file it will open in your browser application. You can use your browser functions to save to a 

PDF and Print etc.. 

Following are the report descriptions. 

YYYYMMDD[RecID]VshortHarDailyReport.html  

Daily report of individual Harmonics Order by Trigger and Analog Channel. Vshort indicates 3 second 

sampling. It Identifies the Largest Order and Largest Range. Includes Min (%), Avg(%), Max(%), and 

99th(%). 

You can Filter on a Harmonic Order by selecting one or more from the Filter Rows box. Refresh the 

browser to reset the view back to all rows. 

 

Figure 114 Rapid Voltage Change (RVC) 
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Figure 115 Sample Daily Harmonics Report 

 

YYYYMMDD[RecID]VshortHarWeeklyReport.html  

Weely report of each Daily individual Harmonics Order by Trigger and Analog Channel. Vshort indicates 3 

second sampling. It Identifies Largest Order each day for the week. Includes Largest MAX Order, Largest 

MAX, Largest Range(%), MAX THD(%), THD 99th(%). 

YYYYMMDD[RecID]shortHarWeeklyReport.html  

Weely report of each Daily individual Harmonics Order by Trigger and Analog Channel. short indicates 10 

minute sampling. It Identifies Largest Order each day for the week. Includes Largest MAX Order, Largest 

MAX, Largest Range(%), MAX THD(%), THD 99th(%) and 95th(%). 

You can Filter on Date by selecting one or more from the Filter Rows box. Refresh the browser to reset the 

view back to all rows. 

 

 

Figure 116 Sample Weekly Harmonics Report 
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YYYY[RecID]VshortHarYearlyReport.html  

Yearly report of each Weekly individual Harmonics Order by Trigger and Analog Channel. Vshort 

indicates 3 second sampling. It Identifies Largest MAX Range, MAX THD, MAX THD 99th(%)for each 

week yearly. Includes Largest MAX(%), Largest Range(%), MAX THD(%), THD 99th(%). 

YYYY[RecID]shortHarYearlyReport.html  

Yearly report of each Weekly individual Harmonics Order by Trigger and Analog Channel. short indicates 

10 minute sampling. It Identifies Largest MAX Range, MAX THD, MAX THD 99th(%)for each week 

yearly. Includes Largest MAX(%), Largest Range(%), MAX THD(%), THD 99th(%) and 95th(%).  

You can Filter on “Week of” Date by selecting one or more from the Filter Rows box. Refresh the browser 

to reset the view back to all rows. 

 

 

Figure 117 Sample Yearly Report 

  



Managing Line Group Records 8-15 

 

8. Managing Line Group Records 
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8.1 Overview of Line Group Records 

The Line Group Record is a user-defined record. Here channels that form a line group are linked together. 

This permits ClearView to perform distance to fault calculations, various power calculations, and provides 

a quick convenient means for viewing oscillograms for different line groups.  

If your line group information is provided before the equipment ships, factory personnel will enter that 

information into the APP Recorder. In addition, you can create or edit a Line Group Record via the APP 

Recorder software or the APP ClearView software. The line group file can be downloaded from the master 

station (APP ClearView) to the APP Recorder, or vice versa.  

Note: If the administrator feature is used, only the administrator has privileges to save a newly 
created record or save changes to an edited record. 

8.2 Editing a Line Group Record 

➢ To Edit a Line Group Record 

1. In the APP ClearView window, from the APP Recorder list, select the APP Recorder for which 

you want to edit a Line Group Record.  

2. From the Edit menu, point to Line Group Record and then click Edit Line-Group Record. 

The Edit Line-Group Record window appears. 

  

Figure 118: Edit Line-Group Record Window 

Note: If the Setup folder for the APP Recorder that you select does not contain a Line Group 
Record, then clicking Edit will create an empty Line Group Record which you can edit. 

3. In the Line Name list, select the line group’s name. 

4. In the Line ID box, type the line ID. 
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5. Breaker 1 and Breaker 2 ID, allows you to identify the breaker(s) 1 and/or 2 associated with a 

Line Group. This will show Breaker ID(s) in the configuration file. This can be used with 3rd party 

analysis tools to capture associated breaker IDs to the Line Group. 

6. Station ID, allow you to identify your Station ID associated with this Line Group 

7. In the Auto Find Fault Location, do one of the following: 

Select No if you do not want the APP Recorder Program to perform a distance fault 

calculation after a system trigger occurs.  

Select Yes if you want the APP Recorder program to attempt to perform a distance to fault 

calculation after a system trigger occurs, provided that the fault line decision logic is true. 

You can specify the fault line decision logic at the bottom of the window. 

8. No Negative Fault Distance, click this box if you want to limit the fault distance reported to only 

positive distance values. A negative value can otherwise result from finding a fault behind the 

station. 

9. Include Reclose check Box, if a fault occurs on a line group and this box is checked, ClearView 

will do a subsequent calculation including the breaker reclose and display it in the Fault 

Loc/Lightning area when viewing the fault record. 

10. The APP Recorders use an impedance-based method for calculating the distance to fault. The APP 

Recorder uses a single-ended calculation. However, a double-ended calculation can be performed 

by pulling data from each end of a faulted line back to the APP ClearView master station software 

and manually initiating a double-ended calculation command.  

 

For the system to automatically perform a single-ended fault location calculation you must enter 

the line length in Miles or Kilometers (click the box to the right of the Line Length field to toggle 

between MI and KM), positive resistance (R1), positive reactance (X1), zero resistance (R0), 

and zero reactance (X0). These need to be entered as Primary Values. Also, the analog channel 

physical connection must provide phase-to-ground voltages and currents. Enter the Series 

Reactance if any. 

 

A Line Group consists of Va, Vb, Vc, Ia, Ib, Ic, In, and Vn. You must complete the line group 

table, shown in the following figure, in order to view line group oscillograms and perform 

distance-to-fault calculations. 

11. This is Generator check box, click this box to indicate the Line Group is connected to a 

Generator. This pre-sets the recorder to calculate Megawatts and Megavars based on a Delta 

Connection automatically rather than a default Phase to Ground Y connection as with a 

transmission line. 

12. The  button opens the list of channels and allows you to select any or all and inserts 

them into the line group. Select the channels in the correct sequence they should appear. 

*CAUTION*  When Using Quick Pick to select channels You need to click the check Boxes in 
the correct order. Not doing so could result in lost data. 

Note: Before you select the channels for the line group, be sure that the Point 
Assignment Record is complete. 
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Figure 119: Line Group Table 

Note: If you need to make the channels negative, click the channel button once to change to 
negative or back to positive (e.g., Va to –Va etc.). 

13. The Max Tree Impedance field should be set at 0 for normal operations. It is used to manually 

gain better accuracy of distance calculations for high impedances. However, if you change it to a 

different value, be sure to reset it to 0 in order for manual calculations to be accurate. 

 

To select channels click on a row, such as Va, and then select your desired channel from the list of 

channels that pull down. Continue selections for the other phase voltages, currents, and neutral.  

Note: The first channel in the channel pull down box is a virtual channel. If the APP 
Recorder is missing a physical connection of Ia, Ib, Ic, or In, you can select 950: 
Virtual Channel and the missing phase or neutral current will be automatically 
calculated by the software. A virtual channel should only be used for a missing 
current, not for a missing voltage.  

14. Channel Mapping allows you to document what Analog and/or Triggers are associated with the 

line. The information is included in the .inf file and does not cause any action. 

15. If you want to filter automatic fault calculations, you can enter a Boolean logic equation in the 

Fault Line Decision Logic (OR=”|”, AND=”&”) field. The following table contains available 

equation variables and field entries.  

Table 11: Fault Line Decision Logic Filter, Variables, and Entries 

Entry Description 

0 False, nothing will pass filter 

1 True, everything passes filter 

Blank (Nothing Entered) True, everything passes filter 

T1, T2, T3….. Represents Analog Channels 

t1, t2, t3….. Also Represents Analog Channels 

E1, E2, E3…. Represents Event Channels 

e1, e2, e3…. Also Represents Event Channels 

16. Click Save 

8.3 Adding a Line Group Record 

1. In the APP ClearView window from the APP Recorder list, select the APP Recorder for which 

you want to add a Line Group Record.  

2. From the Edit menu, point to Line Group Record and then click Edit Line-Group Record. 

The Edit Line-Group Record window appears. 
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3. Next to the Line Name list, click the Add button. 

An Add New Line window appears. 

4. In the box, type the name of the new line and then click the OK button. 

The Edit Line-Group Record window refreshes. All fields are reset to their default values. For 

information on completing these fields, see Editing a Line Group Record. 

8.4 Sending a Line Group Record to the APP Recorder 

If you make changes to a Line Group Record on the master station, you can send the updated Line Group 

Record to the APP Recorder. 

➢ To Send a Line Group Record to the APP Recorder 

1. In the APP ClearView window, from the APP Recorder list, select the recorder to which you 

want to send a Line Group Record. 

2. From the Edit menu, point to Line Group Record and then click Send Line-Group Record to 

Recorder. 

8.5 Getting a Line Group Record from an APP Recorder 

If changes are made to a Line Group Record on the APP Recorder, you can get an updated Line Group 

Record from the master station. 

➢ To Get a Line Group Record from an APP Recorder 

1. In the APP ClearView window from the APP Recorder list, select the recorder from which you 

want to get a Line Group Record.  

2. From the Edit menu, point to Line Group Record and then click Get Line-Group Record. 

8.6 Deleting a Line Group Record 

You can delete a Line Group Record. 

1. In the APP ClearView window, form the APP Recorder list, select the recorder from which you 

want to delete a Line Group Record.  

2. From the Edit menu, point to Line Group Record and then click Delete Line-Group Record. 

A confirmation window appears. 

3. Click the Yes button. 

8.7 Printing a Line Group Record 

➢ To Print the Line Group Record 

1. In the APP ClearView window, from the APP Recorder list, select the recorder for which you 

want to print the Line Group Record. 

2. From the APP ClearView window, from the Edit menu, point Line Group Record, point to 

Print Line-Group, and then do one of the following: 

Click Preview to view an onscreen picture of how the printout will appear. 

Click Print to print a hardcopy of the Line Group Record. The Print window will appear. 

Complete the fields in this window and then click the OK button.  

The entire Line Group Record is printed. 
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8.8 Copying a Line Group Record 

In the ClearView Configuration window, you can specify the Backup 1 Path and a Backup 2 Path. When 

you copy a Line Group Record, you can save the copied record to either of these folders, or to a different 

folder altogether. For information on specifying the Backup 1 and Backup 2 Paths, see 4.17 Configuring 

the Main Configuration Settings. 

➢ To Copy a Line Group Record 

1. In the APP ClearView window from the APP Recorder list, select the recorder for which you 

want to copy the Point Assignment Record. 

2. From the Edit menu, point to Line Group Record, and then click one of the following:  

To copy the Point Assignment Record to the backup location 1 select Copy to Backup 1. 

To copy the Point Assignment Record to backup location 2, select Copy to Backup 2. 

To select a different location to save the copied record, select Copy to… Browse for Folder 

window appears. Navigate to and select the folder you want and then click the OK button. 

8.9 Save As a Line Group Record 
You can “Save As” your Line Group Record to create a copy, or to create a separate alternative Line Group 

Record. You can specify the path, however, the Setup path that you specified in the ClearView 

Configuration window, the default is (C:\APP Clearview\Setup). 
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9. Configuring a Recorder 
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9.1 Factory Settings 

Note: You should not alter the Recorder ID, Data Path, or the Setup Path without thoroughly 
understanding how the APP Recorder runs. Incorrectly changing these values can 
prevent the APP Recorder from running. 

• The Recorder ID is needed for the recorder to read and save configuration and data files such as 

the Point Assignment Record, Line Group Record, COMTRADE data files, and so on. 

• The Data Path has reserved memory in it.  

• The Setup Path has all the configuration information. 

9.2 Types of Configuration Settings 

You can configure the following types of settings for the APP Recorder: 

▪ Main configuration settings 

▪ Automatic Tasks 

▪ Allowed IPs 

9.3 Getting the Recorder Config from the Recorder 

You can retrieve the Recorder Configuration from the Recorder to view and update it in APP Clearview 

Click Edit/Recorder Config/Get Recorder Config. 

 

9.4 Configuring the Main Configuration Settings 

Main configuration settings are integral to the basic functioning of the APP Recorder.  

APP Computer Chassis Data Storage Architecture: 

The APP 601 standard configuration, the computer chassis storage setup is C:\ drive with RAID 1 + hot 

spare. Two 1TB hard drives are in RAID 1 configuration with the 3rd 1TB hard drive acting as a hot spare. 

The RAID hard drives will contain both the operating system and the Setup and Data folders for the 

Recorder program.  

Typically, the Setup folder contains the Point Assignment Record, Line Group Record, Calibration File, 

and Trace Files. The Data folder contains the triggered transient records, triggered extended records, and 

various continuous recording folders such as continuous RMS, continuous frequency, continuous phase, 

and continuous oscillography. 

Figure 120: Get Recorder Configuration 



Configuring a Recorder 9-3 

Remember, you received a complete backup hard drive with the original factory settings along with your 

computer chassis. 

Note: If you want to use the C: drive/Flash for storing fault records, please consult APP 
Engineering Inc. before configuring APP 601 Computer. 

The APP 501 Computer Chassis includes a single conventional hard drive for storing the OS and 

configuration files as well as the fault records. Remember, you received a complete backup hard drive with 

the original factory settings along with your computer chassis. 

To Change Main Configuration Settings 

1. In the APP Recorder window, from the Edit menu, click Recorder Config. 

The Recorder Configuration window appears. By default, the Main tab is selected. 

 

Figure 121: Example of APP 601 Recorder Configuration Window—Main Tab 

 

2. (Required) Recorder ID field, specify a unique recorder ID. This allows the master station 

program (APP ClearView) to identify the recorder with which it is communicating. 

*CAUTION*  Do not use duplicate Recorder IDs.  
Before shipping the Recorders, APP Engineering Inc. will assign 
Recorder IDs and configure each of your Recorders accordingly. 
Recorders will be numbered sequentially. 

3. Company Name field, enter any name you would like. This name will appear at the top of the 

APP Recorder Program main page. At the factory, the name of the company who purchased the 

system is entered. 

4. (Required) Data Path field, click  and enter the location of the physical file where transient 

and extended recording information will be written. By default, the factory creates the path: 

C:\APP Recorder\Data  
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You can change this value to any other path you want. However, you should not change the 

path without understanding how the APP Recorder runs. Incorrectly changing the path can 

prevent the APP Recorder from running.  

5. Transient and extended recording information can be written to more than one path. To create a 

second location, next to Backup, click  and enter the desired path.  

6. Flash: Using Flash has a very limited application. If you would like to use Flash for Data, please 

consult APP Engineering Inc. before setting up the use of Flash. 

7. (Required) Next to the Setup Path box, click the  to specify the location of files such as the 

Point Assignment Record, calibration factors, Line Group Record, trace files, and diagnostic 

record. By default, the factory creates the path C:\APP Recorder\Setup. You can change this 

value to any other path you want. However, you should not change the path without understanding 

how the APP Recorder runs. Incorrectly changing the path can prevent the APP Recorder from 

running. 

8. In the Max #Faults in FSum: box, specify the number of Fault record IDs included in the Fault 

Summary upload to the master station (i.e. remote APP ClearView), when a Fault Summary file is 

created. The larger the number, the longer it takes to get the summary file. Typically, a reasonable 

number for this “fast” retrievable file is between 50 and 500. 

Note: The APP Recorder AND APP Clearview program should be configured to share the same 
Data folder (i.e. C:\APP Recorder\Data). All Fault records are available to APP Clearview 
with this configuration. 

9. After normal communication has been established between the APP ClearView and the APP 

Recorder programs, the ideal disconnect situation is for someone at the master station or someone 

at the APP Recorder to initiate a disconnect or hang up command. When this is done, both 

programs are aware of the disconnect request and can properly close down communications.  

 

However, it is possible for a communication path to be cut without notice. This results in neither 

program receiving notice of disconnect. Therefore, a hang up timer is needed to ensure that both 

programs receive an automatic command to release the communications link.  

 

The default hang up timer for both the APP Recorder and APP ClearView programs is 10 minutes. 

However, the APP Recorder hang up timer has a delay that makes it effective default time 10 

minutes and 30 seconds. Therefore, in the case of no communications activity, the APP ClearView 

program will be the first to initiate a hang up action. 

 

Do you want to make the APP Recorder the first program to initiate a hang up action in the event 

of an unexpected disconnect? 

If yes, then in the Hang up if connection to ClearView has been idle for X minutes 

box, type a value less than 10 minutes. 

If no, skip to the next step. 
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10. Have you already set up dial-up networking for the APP Recorder?  

If yes, then select the Dial-up Networking has been setup check box. See Setting Up 

Dial-up Networking for instructions on setting up dial-up networking. 

If no, skip to the next step.  

11. If you want the Point Assignment Record and Line Group Record saved with Transient Record, 

click the check box: Save .par and .lgp with Transient Record. 

12.  If you want the Transient Alarm triggered during a Test Run, click the check box: Turn 

Transient Alarm on during Test Run.  

13. From the menu bar, click Save. 

9.5 Setting Up Dial-up Networking 

➢ For computers with Windows 7 or 10 

Dial-up Networking using Windows 7 or 10 is supported on a case-by-case basis. To setup Dial-up 

networking with Windows 7 or above, please contact APP Engineering support at (317) 536-5300. 

Note: If running Windows 10, the Modem is not available and is disabled. 

DialNet is for users who want to use Remote Desktop or a similar program to access the recorder using the 

same phone line as the recorder. 

To establish dial-up networking, you must complete the setup procedures on both the APP Recorder 

(server) computer and on the ClearView (client) computer. 

➢ Things to Remember  

▪ The Dial-up network IP Address of the Recorder is (200.200.200.200) 

▪ The Dial-up network IP Address of the ClearView computer is (200.200.200.201) 

▪ Use IP:200.200.200.200 to call the Recorder when using Remote Desktop or UltraVNC or other 

remote access services 

▪ The dial-up network can only be disconnected by the application that started it. 

▪ The dial-up network will stop the Internet connection and also could stop some local LAN. 

▪ The Internet will resume automatically after the dial-up network connection is disconnected. 

9.6 Defining a Boolean Logic Equation  

You can define a Boolean Logic equation to automatically filter, or limit, when the APP Recorder does any 

or all of the following:  

▪ Calls the master system 

▪ Prints the Fault Summary File and fault-related data 

▪ Sends an email notification 

▪ Sends transient fault record via FTP 

Note:  You can define only one logic entry.   
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The following table lists the available equation variables and field entries. 

Table 12: Defining a Boolean Logic Filter—Variables and Entries 

Entry Description 

0 False, nothing will pass filter 

1 True, everything passes filter 

Blank (Nothing Entered) True, everything passes filter 

T1, T2, T3….. Represents Analog Channels 

t1, t2, t3….. Also Represents Analog Channels 

E1, E2, E3…. Represents Event Channels 

e1, e2, e3…. Also Represents Event Channels 

9.7 Configuring Automatic Tasks 

The APP Recorder can perform a variety of automatic tasks, which appear on the window shown in Figure 

122. By configuring the automatic tasks, you can take full advantage of the APP Recorder’s ability to 

become an integral part of your substation or plant automation. 

There are several types of automatic tasks that you can configure. 

▪ Automatic tasks that occur when a fault arrives, (See Section 9.9), including: 

Whether or not the APP Recorder calls the master station, and what type of data it sends about 

the fault 

The format of printed reports 

The email settings for automated notifications 

The FTP settings for automated notifications 

▪ Automatic tasks that occur when an SER Event occurs, see Section 9.14 

▪ Automatic tasks that occur when alarms occur, see Section 9.15 

▪ Setting up the Master Phone List and the Passwords for login to the Master Station see 

Section 9.16 Configuring the Master Phone List. 

Note:  The factory configures all the settings for automatic tasks before shipping the APP 
Recorder to you. You can optionally change these settings as needed. 

9.8 Accessing the Automatic Tasks Tab  

You configure all of the automatic tasks on the Automatic Tasks tab of the Recorder Configuration 

window. 

➢ To Access the Automatic Tasks Tab of the Recorder Configuration Window 

1. In the AP Clearview window, click EDIT, click Recorder Config. 

The Recorder Configuration window appears. By default the Main tab is selected.  

2. Click the Automatic Tasks tab. 

The Automatic Tasks tab appears, as shown in the following figure. 
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Figure 122: Recorder Configuration Window—Automatic Tasks Tab 

9.9 Configuring Automatic Tasks that Occur when a Fault Arrives 

You can configure whether or not the APP Recorder calls the master station, and what type of data it 

sends about the fault. 

Note:  In order for the APP Recorder Program to call the master station and transfer data, 
the master station must be running the APP ClearView Program. The APP 
ClearView Program must be set to monitor incoming calls 

➢ To Configure Whether or Not the APP Recorder Calls the Master Station   

1. Open the Automatic Tasks tab of the Recorder Configuration window. 

2. In the Call Master list, what you want the APP Recorder to do if a fault occurs. The 

following table describes the available options. 
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Table 13: Configuring Automatic Tasks—Options in the Call Master List 

If a fault triggers the Recorder Select this option Also set the values of 
these fields 

What should it 
upload? 

When? 

A Fault Summary 

File 

Always   Yes– always  

(Send FSum Only) 

 

 

 

Max #Faults in FSum 

box on the Main tab 

 

This determines the 

number of fault files in 

the Fault Summary 

record. 

A Fault Summary 

File, and associated 

data 

Always   Yes – always  

(Send FSum and 

Data) 

Data means these only  

check boxes 

 

These determine the type 

of data sent. 

 

If all of the boxes are 

unchecked, then all of the 

types of data will be sent. 

A Fault Summary 

File 

Only when 

certain 

conditions occur  

Yes – if logic true  

(Send FSum Only) 

 

 

Max #Faults in FSum 

box on the Main tab 

Logic (OR=1, AND =&) 

box 

 

 

Data means these only  

check boxes 

A Fault Summary 

File, and associated 

data 

Only when 

certain 

conditions occur 

Yes – if logic true 

(Send FSum and 

Data) 

Logic (OR=1, AND =&) 

box 

 

Data means these only  

check boxes 

A Fault Summary 

File (always) 

 

and associated data 

(sometimes) 

Always print a 

Fault Summary 

Report 

 

but 

 

Print all analog 

waveforms and 

all event graphs 

only when 

certain 

conditions occur  

Yes – always 

(FSum), if logic 

true (Data) 

Max #Faults in FSum 

box on the Main tab 

 

Logic (OR=1, AND =&) 

box 

 

Data means these only  

check boxes 
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3. In the Max # Attempt box, type the number of times the APP Recorder Program will 

attempt to call the master station, via modem or network, before stopping. 

4. Data Means These Only, do you want to limit the type of data sent when a fault occurs?  

If yes, then under Data means these only, select the appropriate check boxes. If you 

select none of the check boxes, then Transient, Disturbance, Extended RMS, and 

Extended Oscillography data are all sent. 

If no, all data will be sent, skip to the next step. 

5. Retrieve any un-retrieved old records during auto Polling, this function is to ensure all 

COMTRADE Records on the Recorder is retrieved into APP Clearview. Check the box if 

you want Clearview to pull any fault records during polling/auto polling existing in the 

Recorder and has not yet been retrieved.   

Note: If the fault summary list (.lst file) is retrieved manually then the Recorder is auto polled, 
Clearview may not retrieve any un-retrieved fault records until the next polling cycle. 

6. Do an Auto Test Run if no fault occurs in a week, this will automatically initiate a test 

run if there have been no faults recorded in the past week. This is to provide a way to ensure 

the recorder is functioning and can provide proof for audit purposes. Click the check box to 

have Auto Test Run turned on.  

7. Clearview allows multi-recorders call-in simultaneously thru. Ethernet, has the Master 

Station (Clearview) been configured to receive calls simultaneously from multiple recorders 

(up to five) over Ethernet? 

 

If yes, then select the Clearview Allows Multi-recorders call-in simultaneously thru. 

Ethernet. 

If no, skip to the next step. 

 

Note: Five instances of the ClearView program will be opened simultaneously, but only one 

will be visible on the master station screen. 

8. Logic Box, this box indicates the condition(s) that must be met in order for the Recorder to 

send the data to the master station. Do you want to set conditions for sending data to the 

Master? 

 

If yes, then complete the Logic box. For more information, see 9.6 Defining a Boolean Logic 

Equation. 

 

If no, then skip to the next step. 

9. From the menu, click Save. 

9.10 Configuring Printing 

Note:  In order for the APP Recorder to print, there must be a local or network printer connected 
to the recorder. 
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➢ To Configure Printing 

1. Open the Automatic Tasks tab of the Recorder Configuration window. 

2. In the Print list, select the specific printing function that you want APP Recorder to perform. 

The following table describes the available options. 

Table 14: Configuring Automatic Tasks—Options in the Print List 

If a fault triggers the Recorder Select this option Also set the values of 
these fields 

What should it 
upload? 

When? 

Nothing  

 

Note:    You can 

still manually 

activate printing. 

n/a No  

 

 

 

n/a 

A Fault Summary 

File 

Always   Yes– always (Print 

FSum Only) 

 

n/a 

A Fault Summary 

File, and associated 

data 

Always   Yes – always (Print 

FSum and Data) 

Data means these only  

check boxes 

A Fault Summary 

File 

Only when 

certain 

conditions occur  

Yes – if logic true  

(Print FSum Only) 

 

 

Logic (OR=1, AND =&) 

box 

A Fault Summary 

File, and associated 

data 

Only when 

certain 

conditions occur  

Yes – if logic true 

(Print FSum and 

Data) 

Logic (OR=1, AND =&) 

box 

Data means these only  

check boxes 

A Fault Summary 

File (always) 

 

and associated data 

(sometimes) 

Always print a 

Fault Summary 

Report 

but 

Print all analog 

waveforms and 

all event graphs 

only when 

certain 

conditions occur  

Yes – always 

(FSum), if logic 

true (Data) 

Logic (OR=1, AND =&) 

box 

Data means these only  

check boxes 

3. Logic Box, this box indicates the condition(s) that must be met in order for the Recorder to 

send the data to the master station. Do you want to set conditions for sending data to the 

Master? 

If yes, then complete the Logic box. For more information, see 9.6 Defining a Boolean Logic 

Equation. 

If no, then skip to the next step. 
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4. Do you want to configure the format of printed reports? 

If yes, continue with the procedure, Configuring the Format of Printed Reports below. 

 

If no, from the menu bar, click Save. 

9.11 Configuring the Format of Printed Reports 

➢ To Configure the Format of Printed Reports 

1. Open the Recorder Configuration window and open the Automatic Tasks tab. 

2. Click the Printing Format button.  

The Format All Wave Printing window appears.  

Figure 123: Format All Wave Printing Window 

3. From the Analog Channel Format list, select the appropriate format: 

YScale Optimized (peak) 

Prints the highest peak value measured to the right-hand side of each oscillogram printed. 

YScale Optimized (unit/cm) 

Prints a volts/cm or amps/cm scale to the right-hand side of each oscillogram  printed. 

YScale = Channel Full Scale Optimized (unit/cm) 

Prints a volts/cm or amps/cm scale to the right-hand side of each oscillogram  printed. The 

value is based on the full scale setting in the Point Assignment Record and the number of 

oscillograms printed on the page. 

Yscale = User Select Scale (unit/cm) 

If selected, a user programmable Yscale field appears. The user can enter their desired 

volts/cm or amps/cm scale. Prints a volts/cm or amps/cm scale to the right-hand side of each 

oscillogram printed. The value is based on a user entered Yscale (unit/cm). If the scale is too 

small waveform clipping will occur. 

Yscale Optimized (RMS) 

This selection prints the RMS value to the right side of each oscillogram printed. 

Note: Print fewer channels on a page to increase the resolution on the Yscale. 
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4. From the Print Channels list,  select one of the following choices: 

All 

Prints an oscillogram for each analog channel listed in the Point Assignment Record. 

Selected 

After you select this, click the Select Channels button to select the specific channels to print. 

Lines 

Specific preset line groups can be printed. 

5. From the Print Data Range list, select the range of records to print: 

All 

Prints the entire length (X-axis) of all the oscillograms selected for printing. 

Selected 

Each data point in an oscillogram has a number. The starting number is “0”  which is usually 

the prefault portion of the waveform. The ending number depends on how long the fault or 

recording lasted.  To print a partial record, X- axis length, enter the data range. 

6. In the #Channels/Page box, enter the number of oscillograms you want to appear on each page of 

the printout.  

Note: Print fewer oscillograms on a page to increase the resolution on the Yscale. 

7. Limited to 100 Cycles per Page check box causes the report to limit to 100 Cycles per page for 

each channel displayed on a page. 

8. There are two types of triggers, analog triggers and event triggers. You can print these triggers in 

conjunction with oscillograms. Triggers are represented by horizontal lines at the bottom of a 

printed or displayed page.  In the Digital Channel Format list, select how the trigger line should 

appear, whether it is normal or abnormal: 

Sequence Of Events /Triggers (Line on Abnormal) 

This selection only prints the event channels or analog triggers that caused the system to 

trigger and record. The state of other event channels is not printed. If a line is shown it 

represents the period of time the event was abnormal.  

Sequence Of Events /Triggers (Line on Normal) 

This selection only prints the event channels or analog triggers that caused the system to 

trigger and record. The state of other event channels is not printed. If a line is shown it 

represents the period of time the event was normal.  

All Events/Triggers (Line on Abnormal) 

This selection prints the analog triggers and event channels that were in an abnormal state 

when the record was created. If a line is shown it represents the period of time the analog 

trigger or event channel was abnormal. 

All Events/Triggers (Line on Normal) 

This selection prints the analog triggers and event channels that were in an abnormal state 

when the record was created. If a line is shown it represents the period of time the analog 

trigger or event channel was normal. 

9. Spread digital among graphs, if Spread Digital check box is not checked, the Analog channels 

are printed, then the Event Channels, on each page (See Figure 124). With Spread Digital check 

box checked the report shows the digital channels along with the Analog lines together (See 

Figure 125 ). 
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Figure 124: Default Report Format 

 

Figure 125: Report with Spread Digital Among Graphs Checked 
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10. No Trigger check box causes the report to exclude Analog Trigger faults from the report. An 

Event Trigger will still display if an Event Channel is set up, and an Event Channel caused the 

Trigger or an Event Channel changed state while the record was being created. 

11. In the Panel Size box, enter the percentage of space the event and analog trigger lines will use at 

the bottom of a printed page. 

12. In the Font Size Global Control box, enter the font size to be used for the title of the waveform 

pages and any annotations that may have been added. You cannot change the font on the Fault 

Summary Report. 

13. In the Font Size Title Control box, enter the font size for the title that appears at the top of each 

waveform or oscillogram page. 

14. In the Annotation Text Size box, enter the font size for any annotations that are added to a 

waveform or oscillogram page. 

15. Click the OK button. 

9.12 Configuring Email Settings 

You can configure the APP Recorder to automatically email fault summary information to the master 

station. When the APP Recorder sends an email, it sends a plain text e-mail message containing a summary 

of a fault. The following information is included in the report:  

▪ Recorder ID 

▪ Fault ID number 

▪ Fault date and time 

▪ Fault duration 

▪ Fault location report (if calculable) 

Note: The Recorder must have an SMTP/POP3 email account and connectivity for the Email 
feature to work properly.  

➢ To Configure Email Settings  

1. Open the Recorder Configuration window and open the Automatic Tasks tab. 

2. Select the Email check box. 

Note:  If the Email check box is not selected, the APP Recorder will not automatically send 
emails with fault summary information. 
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3. Click the Email Settings button. 

The Main tab of the Send Email window appears. 

Figure 126: Send Email Window—Main Tab 

4. In the From field, enter a valid email address. 

5. In the Recipients list, add or delete recipients’ email addresses. The e-mail message will be sent to 

all of the recipients in this list. If no recipients are listed, click Add and specify a valid email 

address. 

• Use the “Check All” button to select all recipients at once. 

• Use the “Uncheck All” button to unselect all recipients at once. 

 

6. For Alarm, checking the box will cause Clearview to send an email once a day if an Alarm has 

occurred changing the Alarm List. 

7. Secure check box, check Secure if you are using an email service that requires a password. Most 

common email platforms are secure (gmail, Microsoft etc..) and would not use the Secure check 

box. 

8. Contact your network administrator to obtain values for the Outgoing Mail (SMTP), Port#, User 

ID, and Auth Password fields.  
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9. Do you want the APP Recorder to automatically email a summary of every fault each time the 

master station automatically retrieves a fault record or whenever a fault record is automatically 

called in? 

If yes, then select the Auto Send Fault Summary if Logic Filter (LF) True check box. On the 

Automatic Tasks tab of the Recorder Configuration window, verify that the Logic box contains 

the appropriate value. For more information on completing the Logic box, see 9.6 Defining a 

Boolean Logic Equation.  

If no, skip to the next step. 

10. Do you want the Auto Send Fault Summary function (above) to limit what is sent to the Master 

Station to any faults less than 1 day old? 

If yes, then click the Don’t Auto Send Fault Summary if older than 1 day check box. 

If no, skip to the next step 

This function works only if Auto Send Fault Summary is also checked. 

11. From the menu bar, click Save. At this point, you have completed configuring e-mail settings. It is 

a good idea to send a test e-mail to ensure that messages will be sent properly. To do this, 

complete the procedure, To Test the Email Function. 

➢ To Test the Email Function 

1. In the Send Email window, click the Message tab.  

The Message tab appears, as shown in the following figure. From here, you can type an email and 

manually send it to everyone in the recipient list. 

Figure 127: Manual Emailing Window 
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2. In the Subject box, type the subject line for the email. 

3. In the Message box, type the message. 

4. In the Attachments list, select an attachment to include. Use the Add and Delete buttons to select 

or remove additional files. 

Note: Attachments will only be sent if the Secure check box is unchecked on the Main Tab  

5. The Debug checkbox is for APP Engineering use only. 

6. Click Send. 

9.13 Configuring FTP Settings  

You can configure the APP Recorder to automatically send the most recently generated transient fault 

record to a host directory. 

9.13.1 Account Tab 

➢ To Configure FTP Settings  

1. Open the Recorder Configuration window and open the Automatic Tasks tab. 

2. Select the FTP check box. 

Note:  You must set this up if you want the APP Recorder to send transient records through 
FTP. 

3. Click the FTP Settings button. 

The FTP Settings dialog box appears in the Account tab, as shown in the following figure. 

 

Figure 128: FTP Account Settings Window 
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4.  (Required) In the Host field, type the URL for the host computer. 

5. (Required) In the Port field, type the port for the host.  

Note: A common port setting is 21. 

6.  (Required) In the User ID field, type the user ID to log in to the host. 

7. (Required) In the Password field, type the password to log in to the host.  

8. Do you want to use a proxy server? 

If yes, then select the Proxy Server check box. In the Proxy Server box, type the name of the 

proxy server. In the Proxy Port box, type the port number for the proxy server. 

If no, skip to the next step. 

9. Do you want to create a logic filter to identify when the transient record should be sent to the host 

directory?  

If yes, then select the Auto Upload Fault Files if Logic Filter (LF) True check box. On the 

Automatic Tasks tab of the Recorder Configuration window, verify that the Logic box 

contains the appropriate value. For more information on completing the Logic box, see 9.6 

Defining a Boolean Logic Equation. 

If no, skip to the next step. 

10. In the Max #Upload/hr box, enter the maximum number of fault records that will sent to the host 

directory per hour. Specify a limiter here to stop the host directory from being inundated with data 

in the event that the APP Recorder has an unexpected runaway tripping event. 

Note: You can reset the counter manually via the Reset Upload button. The Reset 
Upload button is for emergency purposes if the maximum upload number has 
been exceeded, but you still want additional fault records to be sent. 

11. In the Max #Retry of each Upload box, enter a limiter that determines how many times the 

software will try to send a new record to the host directory. If the limit is reached due to some 

connection or setting problem, a message will appear in the APP Recorder trace file. 

12. Time Between each Retry : Randomized Between, enter the two times in seconds, between 

which FTP retries should occur. APP Recorder will attempt at random intervals between the range 

specified, to resend data. 

13. Delay 1st Send (by retry time) check box. Check this to delay 1st send by the Retry time 

specified above. 

14. From the menu bar, click Save. 
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9.13.2 Directory Tab 

Click the Directory tab. The Directory tab appears, as shown in the following figure. 

 

Figure 129: FTP Settings Window—Directory Tab 

1. The Local Dir. field automatically displays the value that was entered in the Data Path field on the 

Main tab of the Recorder Configuration window. This setting tells the FTP program from where to 

retrieve the new fault records that it will place in the host directory. 

Note: You can change the path while testing the FTP function 

2.  (Required) In the Remote Dir. field, type the path to the remote directory that is located on the 

host site to which the transient records will be sent (for example, /storage).  

Note: The backward slash (\) may need to be included in the path. 

3. Do you want to test the connection to the remote directory?  

If yes, click Show Remote Dir Content. 

If communication is established, you will see the remote directory in the message window. 

If the FTP settings are incorrect, you will see nothing in the message window. In the tray 

below the message window you might see error messages. 

If no, skip to the next step. 

From the menu bar, click Save. 
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9.13.3 Performing a Test Upload  

You can use the Upload tab to test the upload process. This tab allows the transfer of any file from the 

local directory to the remote directory. If the file is successfully transferred, an “Upload Succeed” message 

will appear in the FTP Status pane. If the file is not transferred, an “Upload Fail” message will appear 

instead. 

 

Figure 130: FTP Settings Window—Upload Tab 

➢ To Perform a Test Upload 

1. In the Local File box, type the name of the file you wish to send to the remote file. This file must 

be located in the local directory that is defined on the Directory tab. 

2. Do you want the file name to remain the same when it is placed in the remote directory? 

If yes, then in the Remote File field enter the same file name that you entered in the Local 

File box. 

If no, type a different file name. 

3. Click Upload. 

The test file transfer process begins.  

4. After the transfer is successful, click the Show Remote Dir Content button. The file appears in 

the remote directory that you specified on the Directory tab.   

➢ To Stop the Automatic Retry Attempts 

If the transfer fails and you wish to stop the automatic retries, click Abort. 
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➢ To Clear the Buffer of Any Fault Record 

Note: You can clear the buffer for troubleshooting or testing purposes. 

Click Clear FIFO to clear the buffer of any fault record or test file that the APP Recorder is trying to 

send to the remote directory. 

9.14 Configuring Automatic SER Reports 

If a receipt printer is connected to the parallel port of the computer running the APP Recorder, the APP 

Recorder can automatically print an SER report when a SER (SOE) channel experiences a change of state.  

The printed report includes the date, time, channel description, channel number, and if the channel has 

switched to a normal or abnormal state. 

➢ To Configure Automatic SER Reports 

1. Open the Recorder Configuration window and open the Automatic Tasks tab. 

2. Select the Auto Print SER Reports On Receipt Printer check box.  

3. From the menu bar, click Save. 

9.15 Calling the Master Phone List when Alarms Occur 

You can configure the APP Recorder to automatically call the numbers in the master phone list when 

alarms occur. For information on configuring the master phone list see Section 9.16 Configuring the Master 

Phone List. 

➢ To Configure whether the APP Recorder Calls the Master Phone List when Alarms Occur 

1. Open the Recorder Configuration window and open the Automatic Tasks tab.  

2. Under the When Alarms Occurred, Do section, do one of the following: 

If you want the APP Recorder to call the numbers in the Master Phone list, select the Call 

Master… check box. 

If you want the APP Recorder to not call the numbers, de-select the Call Master… check 

box.   

3. From the menu bar, click Save 

Note: The Fault alarm is not affected by the setting of the Call Master… check box. 

9.16 Configuring the Master Phone List 

To configure the master phone list, you can specify: 

The phone numbers, IP Address, or Master ID’s of the master stations that the APP Recorder 

Program will automatically call. 

The password that APP Recorder should use to log in to the master station 
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➢ To Configure the Master Phone List 

1. Open the Recorder Configuration window and open the Automatic Tasks tab.  

2. Click the Master Phone List button. 

The Master Phone & Network List window appears, as shown in the following figure.  

Figure 131: Master Phone & Network List Window 

3. Do you want to add a new IP address or phone number?  

If yes, then do one of the following: 

If the APP Recorder is connected to a phone, then from the list, select Phone#. Then in the 

corresponding box, type the phone number. You can use any standard Windows format.  

Click the Add button. 

If the APP Recorder is connected to an IP address, then from the list select IP Addr. Then in 

the corresponding box, type the IP address. You can use any standard Windows format. Click 

the Add button. For information on configuring DialNet, see 9.5 Setting Up Dial-up 

Networking. 

If no, skip to the next step. 

4. By default, the first entry that you make is selected, as indicated by the X in the Use column. The 

entry with the “X” is the number that APP ClearView will call when it connects to or calls the 

APP Recorder. You can activate multiple phone numbers and/or IP addresses. 

 

Do you want to activate or de-activate a phone number or IP address? 

If yes, then in the Use column, click the box next to the entry. An X appears when the entry is 

activated; it disappears when the entry is deactivated. 

If no, skip to the next step. 

5. Do you want to delete a number? 

If yes, then right-click the number and then click Delete.  

If no, skip to the next step. 

6. Do you want to reorder entries? 

If yes, then under the Drag column, click the gray box that corresponds to the entry you want 

to move and then move it to its new position.  

If no, skip to the next step. 

7. Click Save.  
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➢ To Configure the Recorder Password 

1. Open the Recorder Configuration window and open the Automatic Tasks tab.  

2. Click the Recorder Password button. 

The Recorder Password dialog box appears. 

3. Type the new APP Recorder password. 

Note: The password is case-sensitive. 

4. Click the OK button.  

➢ Ping Master every 5 minutes 

Click this check box to continually test the connection between the DFR and the Master Computer. The 

Master has to be set up in the Master Phone list, Call Master has to be set to “Yes”. If a failure occurs, it 

will cause a Master Comm Error. You must Map that alarm in the Point Assignment Record, General 

Settings, Recorder Setup Tab to have a hard alarm displayed. 

➢ Do Test Run Periodically 

Do TestRun Periodically allows you to set up test runs on a schedule defined by a date range and interval 

in minutes. The test run will occur precisely at the top of the minute and is accurate to the sample point. 

To cause a periodic test run, enter the Start Date and Time, the End Date and Time and the number of 

minutes between Test Runs. Once the end date and time has passed no more scheduled Test Runs will 

occur. 

9.17 Configuring Allowed IPs 

The APP Recorder includes a security feature that will limit remote connections to the APP Recorder. Only 

specified IP addresses will be permitted remote access to the APP Recorder.  

Note:  If you specify no IP addresses, then all IP address will be allowed access to the APP 
Recorder. 

➢ To Configure Allowed IPs 

1. Open the Recorder Configuration window and open the Allowed IPs tab.  

The Allowed IPs tab appears, as shown in the following figure. 

 

Figure 132: Allowable IPs Entry Window (Security Feature) 



Configuring a Recorder 9-24 

2. In the box, type the IP addresses. Press the Enter key between each IP address. 

3. To delete an IP address, right-click the IP address and click Delete. 

Note: You can also use the Undo, Cut, Copy, and Paste options from the pop-up 
menu. 

4. From the menu bar, click Save. 

9.18 Printing Recorder Configuration 

You can print the configuration information by clicking Print at the top of the screen then selecting 

Print Preview or Print. Print Preview allows you to review the report, save, change the printer 

preferences, and print. 

9.19 Sending Recorder Configuration to the Recorder 

Once you have updated the configuration you can send it to the recorder for its use. 

Click Edit/Recorder Config/Send Recorder Config. 

Figure 133: Sending the Recorder Config to the Recorder 
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9.20 Copying Recorder Configuration 

In the Recorder Configuration window, you can specify the Backup 1 Path and a Backup 2 Path. When 

you copy a Configuration record, you can save the copied record to either of these folders, or to a different 

folder altogether. For information on specifying the Backup 1 and Backup 2 Paths, see 9.4 Configuring the 

Main Configuration Settings. 

➢ To Copy a Recorder Configuration 

From the Edit menu, point to Recorder Config, and then click one of the following:  

To copy the Point Assignment Record to the backup location 1 select Copy to Backup 1. 

To copy the Point Assignment Record to backup location 2, select Copy to Backup 2. 

To select a different location to save the copied record, select Copy to…, A Browse for 

Folder window appears. Navigate to and select the folder you want and then click the OK 

button. 

 

Figure 134: Copy Recorder Configuration 
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10.  Connecting to a Recorder  
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10.1 Connecting to an APP Recorder 

The software uses the phone number or IP address entered in the Phone and Network List. For information 

on setting up this information, see 4.18 Managing the Phone and Network List. 

➢ To Connect to an APP Recorder 

1. In the APP ClearView window, from the APP Recorder list, select the recorder to which you 

want to connect.  

2. From the Connect menu, click Connect to Recorder. The software immediately attempts to 

establish a connection.  

3. To view the connection attempt, click Show Connection Screen from the Connect menu.  

10.2 Disconnecting from Recorder 

You can manually tell ClearView to break the communication connection with an APP Recorder at any 

time. 

If ClearView automatically connected to an APP Recorder, then it will automatically disconnect when it 

completes its data transfer. 

➢ To Disconnect to an APP Recorder 

In the APP ClearView window, from the Connect menu, click Disconnect from Recorder.  

10.3 Viewing the Connection Status Window 

While the master station is connected to an APP Recorder, you can view real-time messages related to the 

communications and data transfer progress between the computers in the Connection Status window. This 

window is useful in determining if a successful connection has been established between the master station 

and APP Recorder.  

➢ To View the Connection Status Window 

In the APP ClearView window, from the Connect menu, click Show Connection Screen.  

The Connection Status window appears, as shown in the following figure.  

 

Figure 135: Communication Screen 

Note:  You can leave this window open while you access other functionality in 
ClearView. 
 
Select text in the Connection Status window and then right-click to access cut, 
copy, paste, and delete functions. 
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➢ To view the Trace File 

From the Connection Status Window, you can view the Ctrace file by clicking on the  button. The 

CTrace file will open. 

10.4 Choosing and Configuring a Modem 

You can view the currently installed modems and choose which modem the APP Recorder should use. 

Clearview must be disconnected from the Recorder to view modems. 

Note: If running Windows 10, the Modem is not available and is disabled. 

Note:  After choosing your modem, you should not need to configure it; the process is 
automated for you. The instructions for accessing the Modem Connection Preferences 
window are included in this section in case you need to verify or adjust settings during 
troubleshooting. 

➢ To Choose the Modem  

In the APP ClearView window, from the Connect menu, point to Modem and then click Choose Modem. 

The Choose Modem window appears. 

Figure 136: Choose Modem Window 

1. Click the modem to use. 

2. Click the OK button. 

➢ To View the Modem Connection Preferences Window 

In the APP Recorder window, from the Connect menu, point to Modem and then click Configure 

Modem. 

The Modem Connection Preferences window appears.     

10.5 Monitoring Incoming Calls 

You can monitor incoming calls from APP Recorders. This is used when Recorders are configured to auto 

connect to a Mater Station computer running APP Clearview. 

Note:  ClearView must be running in Administrator mode, and you must correctly enter the 
administrator password in order to enable this feature. 
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➢ To Monitor Incoming Calls 

In the APP ClearView window, from the Connect menu, click Monitor Call. 

The feature is enabled immediately.  

 

To verify that the feature is working, look at the menu Monitor Call menu item. If it has a check mark 

next to it, then the feature is working. Also, the tray at the bottom of the window displays “Monitoring 

income call.” 

10.6 Setting the Network Port # 

The default network port number of 1024 is automatically configured for the master station. You can 

change the port number, if necessary. 

*CAUTION*  The Comm Port at the Recorder must match the Comm Port in 
Clearview. 

➢ To Set the Network Port Number 

1. In the APP ClearView window, from the Connect menu, click Set Network Port#. 

The Network Port# dialog box appears. 

2. Enter the network port number and click the OK button. 

10.7 Setting the Transfer Rate to the Highest Speed 

You can change the packet sizes that are used when transferring files between ClearView and the APP 

Recorders. The default packet size for Ethernet is 45kb and 4kb for modem. The largest packet size for 

the modem is 16 kb. The largest packet size for the Ethernet is 65 kb. 

➢ To Set the Transfer Rate to the Highest Speed 

In the APP ClearView window, from the Connect menu, click Set to Highest Speed. 

ClearView makes the change immediately. 

10.8 Turning On or Off Dial-up Networking 

If you have configured dial-up networking, you can manually turn it on or off as necessary. See 4.19 

Setting Up Dial-up Networking for instructions on setting up dial-up networking. 

➢ To Turn On or Off Dial-up Networking 

In the APP ClearView window, from the Connect menu, click Recorder Dial-up Networking. 

If the menu option says, Off, then clicking this option immediately turns on dial-up 

networking. 

If the menu option says, On, then clicking this option immediately turns off dial-up 

networking. 

10.9 Stopping a File Transfer 

Note: You can view partially transferred data files with the APP ClearView Software. 

➢ To Stop a File Transfer 

In the APP ClearView window, from the Connect menu, click Stop File Transfer. 
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11.1 Overview 

Use the Maintenance menu options to perform a variety of regular ClearView maintenance tasks. 

11.2 Viewing the Auto Poll/Call-In Report 

The Auto Poll/Call-In Report is automatically displayed or updated after each automatic poll by the master 

station or automatic call-in by any APP Recorder. The report lets you know that an automatic operation has 

been carried out. 

You can manually view this report at any time. 

➢ To View the Auto Poll/Call-In Report 

In the APP ClearView window, from the Maintenance menu, click Show Auto Poll/Call-In Report. 

 

Figure 137: Auto Poll/Call-In Report 

If the same APP Recorder calls-in multiple times, use the First Received and Last Received columns 

to see when files were automatically transferred.  

The Fault Summery File (FSum) is transferred each time an automatic transfer is carried out. Each 

time that information is transferred, the # New FSum column is automatically incremented by one.  

The information in the Auto Poll/Call-In Report window is kept until you specifically delete it. To 

delete a row of information, right-click that row and then click Delete. To delete all items in the table, 

right-click anywhere in the table and then click Delete All. 

11.3 Viewing and Getting Trace Files 

You can use trace files to help during troubleshooting. There is a separate trace file for ClearView and for 

each APP Recorder and APP Driver. 

Each trace file lists the major processes carried out by its respective program, either the APP Recorder or 

the APP Driver. When a trace file grows to approximately 500 Kbytes, it will automatically be closed and 

given an incremented extension (for example, .001, .002, and so on.) A new trace file will be created.  

There is also an All Trace (ATrace) file available. The ATrace is intended for use with software to parse 

the ATrace log for specific trace information. The ATrace is not simply a consolidation of the Recorder and 

Driver trace files. The Atrace includes additional trace information from: Recorder, Driver, PMU, DNP3, 

Modbus, IRIG-B and is intended for diagnostics and correlation of log entries. 

On the APP Recorder, the trace files are stored in the C:\APP Recorder\Setup on the APP 501 computer 

or D:\APP Recorder\Setup for the 601 computer directory. After the trace files are transferred to the 

master station computer, they are stored the C:\APP ClearView\Setup directory. 
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➢ To View the Trace File for ClearView 

In the APP ClearView window, from the Maintenance menu, point to Trace Files and click Show 

ClearView Trace File. 

The trace file for ClearView appears. 

➢ To Get the Trace File for an APP Recorder 

1. In the APP ClearView window, from the APP Recorder list, select the APP recorder for which 

you want to view the respective Recorder trace file. 

2. From the Maintenance menu, point to Trace Files and then click Get Recorder Trace File. 

ClearView contacts the selected APP Recorder, uploads its trace file, and saves it to the master 

station’s hard drive. 

➢ To View the Trace File for an APP Recorder 

1. In the APP ClearView window, from the APP Recorder list, select the APP recorder that you 

want.  

2. From the Maintenance menu, point to Trace Files and click Show Recorder Trace File. 

The trace file for the APP Recorder appears. 

➢ To Get the Trace File for a Driver 

1. In the APP ClearView window, from the APP Recorder list, select the APP recorder for which 

you want to get the respective Driver trace file. 

2. From the Maintenance menu, point to Trace Files and then click Get Driver Trace File. 

ClearView contacts the selected APP Recorder, uploads the trace file for its driver, and saves it to 

the master station’s hard drive. 

➢ To View the Trace File for the APP Driver 

1. In the APP ClearView window, from the APP Recorder list, select the APP recorder for which 

you want to view the respective Driver trace file. 

2. From the Maintenance menu, point to Trace Files and click Show Driver Trace File. 

The trace file for the APP Driver appears. 

➢ To Get the All Trace File for a Recorder 

1. In the APP ClearView window, from the APP Recorder list, select the APP recorder for which 

you want to get the respective Driver trace file. 

2. From the Maintenance menu, point to Trace Files and then click Get All Trace File. 

ClearView contacts the selected APP Recorder, uploads the ATrace file for its driver, and saves it 

to the master station’s hard drive. 

➢ To View the All Trace (ATrace) File 

In the APP Clearview window, from the Maintenance menu, point to Trace Files and click Show All 

Trace File. 

The all trace file for the recorder you are on appears. 

  



Maintaining ClearView and the  
   APP Recorders 11-4 

11.4 Managing APP Recorder Diagnostic Tests 

Using ClearView, you can initiate a diagnostic test against a APP Recorder and view the results. 

Note: You can also run a diagnostic test from within the APP Recorder main window and the 
APP Driver window. 

11.4.1 Running a Diagnostic Test and Viewing Results  

➢ To Run a Diagnostic Test and View Results 

In the APP Clearview window, from the Maintenance menu, point to Diagnosis and click one of the 

following: 

Click Show Result to view the results of the last diagnostic test that was completed. 

Click Redo Diagnostic to perform a new diagnostic test and view its results. The Recorder 

Diagnostic Results window appears. 

 

Figure 138: Recorder Diagnostic Results Window 

Note: Be cautious because this information may not be current. Double-click on an entry to reveal 

additional diagnostic details. 

1. To see the details of an entry, double-click its name in the list. 

 

Figure 139 Diagnostics Detail 
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2. To see the latest diagnostic results, from the menu bar, click Refresh. 

3. To see which alarms are currently ON, from the menu bar, click Alarms. 

The Alarms dialog box displays the alarms. 

4. To close the Recorder Diagnostic Results window, click the X in the upper right-hand corner. 

11.4.2 Getting Results from a Diagnostic Test for an APP Recorder 

You can use ClearView to contact an APP Recorder and upload the most recent diagnostic file stored at the 

recorder.  

Note: Be cautious because this information may not be current. Each APP Recorder does an 
automatic diagnostic test every 5 minutes. 

➢ To Get the Results of a Diagnostic Test for an APP Recorder 

1. In the APP ClearView window, from the APP Recorder list, select the APP recorder. 

2. From the Maintenance menu, point to Recorder Diagnosis and click Get Result. 

11.4.3 Redoing an APP Recorder Diagnostics Test 

You can use ClearView to contact an APP Recorder, command it to perform a fresh diagnostic test, and 

retrieve the results.  

➢ To Redo a Diagnostics Test for an APP Recorder 

1. In the APP ClearView window, from the APP Recorder list, select the APP recorder. 

2. From the Maintenance menu, point to Recorder Diagnosis and click Redo Diagnosis. 

11.4.4 Show All Recorder Diagnostic Results 

You can review the diagnostic results for all your APP Recorders. 

➢ To Review All Diagnostic Results for your APP Recorders 

From the Maintenance menu, point to Recorder Diagnosis and click Get Result. 
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11.5 Managing SER Abnormal or Stopped Channels 

Note: The Point Assignment Record contains a setting, under the General Settings tab that 
allows you to automatically shut down an SER channel if it changes state too many times 
in a fixed period. The SER channel will automatically restart after a user-defined 
shutdown period. Additionally, SER Channels can be manually removed from scan or 
stopped. 

You can view previously received SER abnormal or stopped channels file, or you can retrieve a new file. 

➢ To View All SER Abnormal or Stopped Channels 

In the APP ClearView window, from the Maintenance menu, point to All SER Abnormal Or 

Stopped Channels and then do one of the following: 

To view the channels, click Show the Channels. 

To retrieve the channels and save them onto the master station hard drive, click Get the 

Channels. 

The following window appears. 

Figure 140: Stopped/Abnormal SER Channels Window 

In the State column, an O represents an open contact and a C represents a closed contact.  

In the Normal column, an A indicates the channel is currently in an abnormal state and an N 

indicates the channel is currently in a normal state.  

In the Sync column, a U indicates an unsynchronized time and an S represents a synchronized 

time. 

If an SER channel is stopped, the word Stop will appear at the beginning of the channel 

description, along with either an M or an A: 

M indicates that the channel has been stopped manually via the Point Assignment Record. A 

indicates that the channel stopped automatically.  

11.5.1 Polling an APP Recorder 

You can poll an APP recorder to retrieve the information set up in the ClearView configuration file. For 

more information, see 4.17.5 Configuring Auto-Polling. 

You can also manually override the auto-polling process by stopping auto-polling.  

➢ To Poll an APP Recorder 

1. In the APP ClearView window, from the APP Recorder list, select the APP recorder that you 

want to poll. 
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2. From the Maintenance menu, point to Poll Recorder and then select one of the following: 

Poll This Recorder 

This selection causes the software to immediately call the APP Recorder and retrieve 

information (fault summary or fault summary plus data) as set up in the ClearView 

configuration file. 

Start Auto-Polling 

This selection ignores the auto start-polling time setting and begins immediate polling of all 

the fault records specified in the ClearView configuration file. 

➢ To Stop Auto-Polling 

1. In the APP ClearView window, from the APP Recorder list, select the APP recorder for which 

you want to stop auto-polling.  

2. From the Maintenance menu, point to Poll Recorder and then select Stop Auto-Polling. 

11.5.2 Performing a Test Run 

You can perform a test run to test if the APP Recorder is really recording and to check all the channel data.  

When you perform a test run, the APP Recorder trips, creating a transient COMTRADE record. The 

COMTRADE records contain a snapshot of all the analog channel signals, and the state of all DFR 

channels, plus the present status of the event inputs.  

In addition, if the extended recording feature is enabled in the Point Assignment Record (General Settings 

tab: Sampling tab), an extended RMS COMTRADE record and an extended oscillography COMTRADE 

record will also be created. You can view the transient, extended-RMS, and extended oscillograph records  

with the APP ClearView program. 

The record length will be prefault + post fault. The trigger alarm will not energize during a test run. 

However, the trigger front panel LED will illuminate.  

If the Auto-Call feature is enabled (Recorder Configuration window: Automatic Tasks tab), the APP 

Recorder will call the master station(s) and upload the records. If not, you will need to request a new File 

Summary (FSum) and retrieve the new Fault Record(s) created as a result of the Test Run. 

➢ To Perform a Test Run 

In the APP ClearView window, from the Maintenance menu, click Test Run. 

The system immediately responds. 

Tip: If the Recorder had auto-call in enabled, disconnect from the recorder quickly so it can 
call in. 
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11.5.3 Viewing the ON Alarms  

You can view a list of the alarms that are currently on for all the Recorders in the pull down list. 

➢ To View the ON Alarms 

In the APP ClearView window, from the Maintenance menu, click Show Alarm ON List. 

The Alarms Currently On window appears.  

 

Figure 141: Alarms Currently ON Window 

11.6 Syncing an APP Recorder’s Time With ClearView 

You can use ClearView to synchronize an APP Recorder’s time with the master station. 

If this menu item is selected, the date and time from the master station is downloaded to the recorder. This 

feature is mainly used by companies that time-sync the master instead of the recorders. 

➢ To Sync an APP Recorder’s Time with ClearView 

1. In the APP ClearView window, from the APP Recorder list, select the APP recorder that you 

want to synchronize. 

2. From the Maintenance menu, click Sync Recorder Time with ClearView. 

11.7 Getting the Time on an APP Recorder 

If you need to verify the time set on an APP Recorder, you can do that from within ClearView. 

➢ To Get the Time Set on an APP Recorder 

1. In the APP ClearView window, from the APP Recorder list, select the APP recorder that you 

want to check. 

2. From the Maintenance menu, click Get Recorder Time. A window displays the current time set 

for the selected APP Recorder. 
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11.8 Reinitializing an APP Recorder 

You can use ClearView to re-initialize an APP Recorder program to help with troubleshooting. 

Note: Re-initializing only restarts the APP Recorder software. Rebooting turns off the entire 
APP Recorder machine. You will not lose communication during a reinitialization. 

*CAUTION*  The re-initialize command will take the APP Recorder offline for a few 
moments. 

➢ To Re-Initialize the APP Recorder Program 

• In the APP ClearView window, from the APP Recorder list, select the APP recorder that you 

want to reinitialize.  

• From the Maintenance menu, click Reboot Recorder, then select Re-initialize Recorder. 

11.9 Restart APP Recorder (program only) 

Restart Recorder will immediately EXIT APP Recorder program and then re-start it. 

• In the APP ClearView window, from the APP Recorder list, select the APP recorder that you 

want to reinitialize.  

• From the Maintenance menu, click Reboot Recorder then select Restart APPRecorder. 

• Click OK to clear the acknowledgement window. 

Note: Communication with the Recorder will be lost and you will need to reconnect. The restart 
process will take about one minute 

11.10 Rebooting the APP Recorder Program 

You can use ClearView to reboot the APP Recorder program to help with troubleshooting. 

When you reboot, power is momentarily cut to the APP Recorder. The computer and all circuit boards will 

see a hard power shutdown. Power is cut via a normally closed relay on the data chassis power supply 

circuit board. After 9-10 seconds power will return, and the system will restart. It takes approximately 1 

minute and 30 seconds for the system to return to an online state.  

Note: Rebooting turns off the entire APP Recorder machine. 

*CAUTION*  The APP Recorder will be offline during the reboot period. 

➢ To Re-Boot the APP Recorder Program 

1. In the APP ClearView window, from the APP Recorder list, select the APP recorder that you 

want to reboot.  

2. From the Maintenance menu, click Reboot Recorder then select Reboot Recorder. 
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11.10.1 Reserving Memory and Defragging the Data Drive 

Occasionally, you may need to reserve memory and/or defragment the data hard drive of an APP Recorder. 

Using ClearView, you can complete both of these tasks remotely. Reserving memory or defragmenting the 

hard drive will take up considerable CPU time (hours) and once started, you will be unable to stop these 

processes remotely.  

*CAUTION*  Perform these functions only if there is little or no likelihood of a fault 
for 2 to 24 hours. We recommend you consult with APP Engineering 
before reserving memory. 

➢ To Reserve Memory 

1. Make sure Sampling tab is set as desired. 

2. Go to Chassis tab. Create a temporary Chassis Configuration that contains the number of analog 

channels you want to reserve memory for plus add 10% more channels than actual channels 

present. 

*CAUTION*  We recommend keeping 30% or more hard drive space available for 
other computer operations  

3. In the APP ClearView window, from the APP Recorder list, select the APP recorder for which 

you want to reserve memory.  

4. From the Maintenance menu, point to Defrag Recorder and then click Reserve Memory. 

A Warning message appears. 

5. Click Yes. 

6. To check if the reserve memory process is finished, look at the APP Recorder trace file. In this 

file, the message, “Begin Reserve Memory” appears when the reserve memory process starts. The 

message, “End Reserve Memory” appears when the process finishes.  For more information see 

11.3Viewing and Getting Trace Files. 

➢ To Perform a Defrag Analysis, Defrag the Data Drive, and View the Results 

Note: If the Recorder is using a solid-state drive, defragmentation does not need to be done. 

1. In the APP ClearView window, from the APP Recorder list, select the APP recorder for which 

you want to perform a defrag analysis. 

2. From the Maintenance menu, point to Defrag Recorder and then click Run Defrag Analysis on 

Recorder Data Drive.  

3. After viewing the results, do you want to defrag the data drive? 

If yes, continue with step 3. 

If no, you are finished with this procedure. 

4. From the Maintenance menu, point to Defrag Recorder and then click Defragment Recorder 

Data Drive. A confirmation window appears.  

5. Click Yes. 

6. Wait a minute or two. 

7. From the Maintenance menu, click Show Defragment Status. 
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11.10.2 Updating the APP Recorder Software 

Using ClearView, you can download the latest release of the APP Recorder Software and install it on an 

APP Recorder. The APP Recorder Software is embedded in the APP ClearView software.  

To ensure that you download the most recent version of the APP Recorder Software, verify that you have 

the most recent version of APP ClearView software. The most recent version of the APP ClearView 

software is available on the APP website at www.appengineering.com.  

*CAUTION* The APP Recorder will be offline for approximately 3 minutes while 
the software is being updated. Communication with the APP Recorder 
will be lost during this period of time. 

➢ To Update the APP Recorder Software 

1. Verify that you have the most recent version of APP ClearView software installed on the master 

station. Check www.appengineering.com for current version information.  

2. In the APP ClearView window, from the Maintenance menu, point to Update Recorder 

Software and then click Start Update. The Update Recorder Software window appears. 

3. Select the APP Recorder(s) to update and then click the OK button. A Status window appears. 

Note: When you update the Recorder software, Clearview, Helper, Translator, and GOOSECap 
software will also be updated on the DFR. 

Note: If you need to stop the update process, click the Stop button in this window. 

➢ To Stop the Process of Updating the APP Recorder Software 

From the Maintenance menu, point to Update Recorder Software and then click Stop Update. 

The process is stopped immediately. 

 

 

http://www.appengineering.com/
http://www.appengineering.com/
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12.1 Configuring Continuous Recording 

You can enable or disable continuous recording in the Point Assignment Record for an APP Recorder. Two 

types of continuous recording can be enabled: 

1. A combination of continuous RMS, Frequency, and Phase. You enable or disable these three 

choices together. They have a 999-day maximum circular buffer (14 days typically). You can view 

these types of continuous recording in near real-time in the APP Recorder window. 

Note: Phase angle is shown relative to a selected channel.  

2. Continuous oscillography recording. This has a 999-day maximum circular buffer.  

12.2 Getting Continuous Recording Data  

 From ClearView, you can get time slices of continuous recording data in a COMTRADE format. The 

following figure shows the Continuous Recording menu in ClearView. First, in the Recorder list, Select 

the Recorder you want to get Continuous Recording data from. Then under the Connect menu, select 

Connect to Recorder. Once connected, the Continuous Recording menu will become available.  

Figure 142: Continuous Recording Menu 

12.3 Getting a Time Slice of Oscillograph Data 

➢ To Get a Time Slice of Oscillograph Data 

1. In the APP ClearView window, from the APP Recorder list, select the APP Recorder for which 

you want to get data. 

2. In the APP ClearView window, from the Continuous Recording menu, click Get Oscillograph 

File. 

The following window appears. 

 

Figure 143: Create Comtrade Osclgr Data File Window 
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3. In the Begin and End boxes, enter time slice values. 

4. Click the Select Channels button to select the channels you want.  If you do not select specific 

channels, then all analog channels will be retrieved. 

5. In the Max File Size box, set the maximum file size of any continuous record/time slice. For 

example, if a master station user requests an RMS plus Phase time slice of 4 days, the file could be 

very large. If the requested file size is larger than the user-defined maximum limit, ClearView 

reduces the resolution of the file by evenly dropping data points throughout the record. Data points 

will be dropped until the file size is under the user-defined maximum limit. 

6. Click the OK button. 

The APP Recorder packs the data from the specified time slice and uploads it to the OsclgrData 

directory with a file name equal to the range of the time slice  

(e.g. 20080213T102300_20080213T102400.dat). 

Note: If this directory is not there, it will be automatically created. 

Once the data is retrieved, the Graphic and Data Analysis window automatically opens, and the 

data is displayed.  

12.4 Getting a Time Slice of Transient Rate Oscillography Data 

➢ To Get a Time Slice of Transient Rate Oscillograph Data 

1. In the APP ClearView window, from the APP Recorder list, select the APP Recorder for which 

you want to get data. 

2. In the APP ClearView window, from the Continuous Recording menu, click Get Transient 

Rate Oscillograph File. 

The following window appears.  

3. In the Begin: and End: fields, enter time slice values. 

4. Enter the interval desired in minutes 

5. Click OK 

Note: Transient Rate Oscillography must be enabled in the Point Assignment Record for 
data to be collected. 

12.5 Getting a Time Slice of Frequency Data 

➢ To Get a Time Slice of Frequency Data 

1. In the APP ClearView window, from the APP Recorder list, select the APP Recorder for which 

you want to get data. 

Figure 144 Create Comtrade Transient Rate Oscillograph File Window 
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2. In the APP ClearView window, from the Continuous Recording menu, click Get Freq. File.. 

The following window appears.  

 

Figure 145: Create Comtrade Freq Data File Window 

3. In the Begin: and End: fields, enter time slice values. 

4. Click the Select Channels button to select the channels you want.  If you do not select specific 

channels, then all analog channels will be retrieved. 

5. Trend Check Box, checking the Trend Box will create a Frequency Comtrade file for all channels 

or specified channels, including a Maximum, Minimum, and Average Voltage value for each 

interval over the period indicated. 

Do you want to capture Frequency data over a period of time, contingent on the number of days 

set in the PAR General Settings Tab, Continuous Recording Freq + RMS + Phase, # of Days, and 

maintain a manageable file size? 

• If yes, click the Trend check box and enter an interval in minutes typically 1 minute is 

used.  At the bottom of the window, you can see the expected file size and the effect of 

interval minutes selected. 

• If no, then skip to the next step 

 

6. In the Max File Size box, set the maximum file size of any continuous record/time slice. For 

example, if a master station user requests an RMS plus Phase time slice of 4 days, the file could be 

very large. If the requested file size is larger than the user-defined maximum limit, ClearView 

reduces the resolution of the file by evenly dropping data points throughout the record. Data points 

will be dropped until the file size is under the user-defined maximum limit. 

7. Click the OK button. 

The APP Recorder packs the data from the specified time slice and uploads it to the FreqData 

directory with a file name equal to the range of the time slice  

(e.g. 20080213T102300_20080213T102400.dat).  

Note: If this directory is not there, it will be automatically created. Also, a trend data file 
is much smaller. Therefore, it has no file size limit.  

Once the data is retrieved, the Graphic and Data Analysis window automatically opens, and the 

data is displayed.  

12.6 Getting a Time Slice of RMS Data 

➢ To Get a Time Slice of RMS Data 

1. In the APP ClearView window, from the APP Recorder list, select the APP Recorder for which 

you want to get data. 
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2. In the APP ClearView window, from the Continuous Recording menu, click Get RMS File. 

The following window appears. 

 

Figure 146: Create Comtrade RMS Data File Window 

3. In the Begin and End fields, enter time slice values. 

4. Click the Select Channels button to select the channels you want.  If you do not select specific 

channels, then all analog channels will be retrieved. 

5. Trend Check Box, checking the Trend Box will create an RMS Comtrade file for all channels or 

specified channels, including a Maximum, Minimum, and Average Voltage value for each interval 

over the period indicated. 

 

Do you want to capture RMS data over a period of time, contingent on the number of days set in 

the PAR General Settings Tab, Continuous Recording Freq + RMS + Phase, # of Days, , and 

maintain a manageable file size? 

• If yes, click the Trend check box and enter an interval in minutes typically 1 minute is used.  

At the bottom of the window, you can see the expected file size and the effect of interval 

minutes selected. 

• If no, then skip to the next step 

6. In the Max File Size box, set the maximum file size of any continuous record/time slice. For 

example, if a master station user requests an RMS plus Phase time slice of 4 days, the file could be 

very large. If the requested file size is larger than the user-defined maximum limit, ClearView 

reduces the resolution of the file by evenly dropping data points throughout the record. Data points 

will be dropped until the file size is under the user-defined maximum limit. 

7. Click the OK button. 

The APP Recorder packs the data from the specified time slice and uploads it to the RMSData 

directory with a file name equal to the range of the time slice  

(e.g. 20080213T102300_20080213T102400.dat).  

Note: If this directory is not there, it will be automatically created. Also, a trend data file 
is much smaller. Therefore, it has no file size limit.  

Once the data is retrieved, the Graphic and Data Analysis window automatically opens and the 

data is displayed.  

12.7 Getting a Time Slice of Phase Data 

➢ To Get a Time Slice of Phase Data 

1. In the APP ClearView window, from the APP Recorder list, select the APP Recorder for which 

you want to get data. 
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2. In the APP ClearView window, from the Continuous Recording menu, click Get Phase File. 

The following window appears.  

 

Figure 147: Create Comtrade Phase Data File Window 

3. In the Begin and End fields, enter time slice values. 

4. Click the Select Channels button to select the channels you want.  If you do not select specific 

channels, then all analog channels will be retrieved. 

5. In the Max File Size box, set the maximum file size of any continuous record/time slice. For 

example, if a master station user requests an RMS plus Phase time slice of 4 days, the file could be 

very large. If the requested file size is larger than the user-defined maximum limit, ClearView 

reduces the resolution of the file by evenly dropping data points throughout the record. Data points 

will be dropped until the file size is under the user-defined maximum limit. 

6. Click the OK button. 

The APP Recorder packs the data from the specified time slice and uploads it to the PhaseData 

directory with a file name equal to the range of the time slice  

(e.g. 20080213T102300_20080213T102400.dat). 

Note: If this directory is not there, it will be automatically created. 

The absolute phase for each channel is retrieved. Each data point is a phase angle reading at a 

certain moment in time. The software looks at an entire cycle to decide what position or angle it is 

at. A cosine wave is used as a reference where zero degrees is the start of the cosine.  

Once the data is retrieved, the Graphic and Data Analysis window automatically opens and the 

data is displayed.  

12.8 Getting a Time Slice of RMS plus Phase Data 

RMS plus Phase data allows you to calculate power or impedance in a longer time range with less data 

compared to using oscillography data. 

➢ To Get a Time Slice of RMS Plus Phase Data 

1. In the APP ClearView window, from the APP Recorder list, select the APP Recorder for which 

you want to get data. 

2. In the APP ClearView window, from the Continuous Recording menu, click Get RMS Plus 

Phase File. 

The following window appears.  
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Figure 148: Create Comtrade RmsPhs Data File 

3. In the Begin and End fields, enter time slice values. 

4. Click the Select Channels button to select the channels you want.  If you do not select specific 

channels, then all analog channels will be retrieved. 

5. In the Max File Size box, set the maximum file size of any continuous record/time slice. For 

example, if a master station user requests an RMS plus Phase time slice of 4 days, the file could be 

very large. If the requested file size is larger than the user-defined maximum limit, ClearView 

reduces the resolution of the file by evenly dropping data points throughout the record. Data points 

will be dropped until the file size is under the user-defined maximum limit. 

6. Click the OK button. 

The APP Recorder packs the data from the specified time slice and uploads it to the RmsPhsData 

directory with a file name equal to the range of the time slice  

(e.g. 20080213T102300_20080213T102400.dat).  

Note: If this directory is not there, it will be automatically created.   

Once the data is retrieved, the Graphic and Data Analysis window automatically opens and the 

data is displayed.  

Note: Use preconfigured Line Groups to look at power graphs. 
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13.1 New Graph 

New Graph can be used to open up an empty graphics screen and then open ANY COMTRADE Record. 

This capability is covered in the next Section. See Section 14.2 Opening the Graphic and Data Analysis 

Window 

13.2 Emailing a Fault Summary File 

You can email a Fault Summary File to the addresses listed in the Email Settings window. For more 

information on setting up email addresses, see 4.17.6 To Configure the Email Settings. 

➢ To Email a Fault Summary File 

In the APP ClearView window, from the Tools menu, click Email FSum. 

13.3 Show Email Window 

Email configuration settings, including the list of recipients who receive Fault Summary Reports, are 

centrally managed in the Email Settings window. You can access this window when you configure the 

ClearView (Edit menu, Configuration menu option). A more direct route is to access the Email Settings 

window directly from the Tools menu.  

➢ To Show the Email Settings Window 

In the APP ClearView window, from the Tools menu, click Show Email Window. 

The Email Settings window appears. For information, see 4.17.6 To Configure the Email Settings. 

13.4 Vaisala Lightning Configuration 

On the Tools menu, the Vaisala Lightning Config option is used to setup the APP recorder to 

automatically correlate lightning location information provided by Vaisala, Inc. with fault records.  

You must have checked the Viasala Lightning Information option in Clearview Configuration Options Tab. 

See Section 4.17.8 Configuring Options 

Note: The URL, username, and password are all provided by Vaisala. Inc.   
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Figure 149: Viasala Configuration Screen 

13.4.1 Quick Start 

1. Fill in all the necessary information for the fields in BOLD then click Save. 

2. Make a quick test by clicking the “Submit” button. A message will appear on the bottom of the 

window. 

3. If successful, A messages similar to “OnConnectionStatus: OK” will appear. 

4. Enter LineID on each line group, they should be the same as in the folder “Line Struct Files.” For 

example, if the Line id is 100, the file is 100.txt. 

5. Click on one of the fault records in ClearView and right mouse click to show the Fault Record 

menu. Click “Do Lightning Info”. It will run and a message will appear on the message window 

described in step #2.  

Figure 150: Do Lightning Info 
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6. Lightning correlation is now ready. Whenever auto-poll/manual poll or the recorder calls in, 

Clearview will do the lightning info, and if auto email was set, the lightning info will be sent with 

it. 

13.4.2 Line Structure Files 

Each file is a line and the file name is the line ID. For example, 100.txt and 101.txt for line 100 and line 

101 

Inside each file, the line is formatted as below: 

Longitude Latitude Structure ID Line ID Description 

For example 

-84.72569 31.45738 847 100 Arlington Height line 

 

Contact APP Engineering for complete information on how to configure this feature. 
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13.5 Completing a File Transfer 

You can use FTP to transfer a file from the master station to an APP Recorder, or vice versa. 

➢ To Complete a File Transfer 

In the APP ClearView window, from the Tools menu, click File Transfer.  

The File Transfer window appears, as shown in the following figure.  

 

Figure 151: File Transfer Window 

Note: Within this window, you can create folders and rename or delete files as needed.  
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13.6 Merging Fault Records or Saving Fault Records to a New File 

*WARNING* 
 
 

ClearView does not restrict the size of the merged file. Merged files 
can get very large if the records being merged are far apart in time. 
ClearView automatically populates empty rows with “0.” 

➢ To Merge Fault Records or Save Fault Records to a New File 

1. In the APP ClearView window, from the Tools menu, click Merge or Save Data Files As.  

The Merge or Save Data Files As window appears. 

2. Select the destination folder and specify a new name for the merged/saved file and then click the 

Save button. 

3. An explorer window appears, browse to the folder where the faults records to be merged reside. 

Select the fault records to be merged by clicking the first file and then holding <Ctrl> , clicking 

one or more fault records. Then click Open. The merge file (.dat) is saved. 

13.7 Extracting Continuous Record Data 

Continuous record data consumes a huge amount of space, usually many Giga bytes. For this reason, it is 

stored in a cyclic buffer in a compact data format. It requires special software to convert a portion of the 

data to the COMTRADE format so you can view it. In general, you can use ClearView to retrieve a portion 

of the continuous record data from an APP Recorder when you need it. However, in some situations, you 

might want to preserve the continuous record data permanently (e.g. in case of a blackout) in a separate 

hard drive. You can then examine the data whenever necessary.  

➢ To Extract Continuous Record Data 

1. In the APP ClearView window, from the APP Recorder list, select the APP Recorder for which 

you want to extract continuous record data. 

2. From the Tools menu, click Extract Continuous Record Data. 

The Extract Continuous Record Data window appears, as shown in the following figure.  

 

Figure 152: Extract Continuous Record Data Window 

3. In the Data Path box, specify the path where the data is stored  

*CAUTION* When storing continuous record data files, be sure to store them in 
the appropriate folder. For example, frequency data files should be 
stored in the FreqData folder and RMS data files should be stored in 
the RmsData folder; these are the folders where the data was 
originally stored. This will ensure that the software can understand 
the files. 
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4. In the Setup Path box, specify the path where the associated Point Assignment Record is stored. 

5. In the list at the bottom of the window, select the appropriate type of data (Osclgr, Freq, Rms, Phs 

or RmsPhs). Above this list, the window displays the Data in folder where the specified type of 

data (e.g. OsclgrData) is stored.  The Save to folder is where the retrieved data will be saved.  

6. Is the software running on the APP Recorder version 1.4.8 or older?  

If yes, then select the Pre V1.4.8 check box. The continuous frequency data has been changed 

from 0-65Hz to 0-130Hz after Version 1.4.8.  

If no, skip to the next step. 

7. Click the Extract button. ClearView extracts the data and saves it to the location you specified.  

13.8 Showing (or Hiding) the ClearView Icons 

You can show or hide the icon bar in the APP ClearView window. 

➢ To Show (or Hide) the ClearView Icons 

In the APP ClearView window, from the Tools menu, click Show Icons.  

If the icons were showing, then clicking this option hides them. If the icons were hidden, then clicking 

this option shows them.  

13.9 Configuring a DSP Board’s Ethernet and IP Address Settings 

Note: You can configure the DSP board’s Ethernet settings using the APP Recorder software. 
This feature has been implemented in ClearView in order to give you the option to make 
changes via your laptop instead of using the APP Recorder computer. 

Before an APP Recorder leaves the factory, each of its DSP/IRIG boards is programmed with an Ethernet 

Address, IP Address, Subnet Mask, and Default Gateway. In a centralized or turn-key system, it is highly 

unlikely that the Ethernet or IP Addresses will ever need to be changed. However, if the factory ships an 

add on data chassis for a distributed architecture system and does not know the location of the installation, 

you will need to program the appropriate DSP Ethernet Address and IP Address upon receipt. 

For more information on Configuring the DSP settings see the APP Recorder Operating Manual Section 

7.14.9 
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13.10 Configuring a DNP3/Modbus Outstation 

If you enable DNP3/Modbus in the Point Assignment Record on the General Settings tab: Recorder 

Setup tab. This will cause the DNP3/Modbus configuration option to appear in the Clearview Tools menu. 

For more information on configuring DNP3/Modbus, please see the APP Recorder Operating Manual 

Section 6.13. 

13.11 Configuring a Phasor Measurement Unit (PMU) 

If you enable PMU in the Point Assignment Record on the General Settings tab: Recorder Setup tab. 

This will cause the PMU configuration option to appear in the Clearview Tools menu. 

For more information on configuring PMU, please see the APP Recorder Operating Manual Section 

6.13. 

13.12 File Compare 

File Compare enables viewing two text files to find differences. A primary use could be to find the 

differences in versions of a Point Assignment Record (PAR) 

Click file Compare in the Tools Menu 

Figure 153 File Compare Window 

Select two files by clicking the explorer button to the right of each file field and navigate to the files you 

would like to compare.  

Once both files are listed, click the Compare button. Once the compare is complete, the differences will 

appear in Red.  

If you click the Animate box, the compare process will show the changes as comparison progresses down 

the files. 

The Status line at the bottom displays compare status and difference in character count. 
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Figure 154 File Compare Results 

 

13.13 Viewing Help and About Information 

You can view the help for APP ClearView. The About information includes the software version and 

factory contact information. 

Note:  If the help files do not answer your question(s), please do not hesitate to contact APP 
Engineering, Inc. at (317) 536-5300. 

➢ To View the Help  

In the APP ClearView window, from the Help menu, click Help. 

➢ To View the About Information  

In the APP ClearView window, from the Help menu, click About. 
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14. Graphic and Data Analysis Window 
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14.1 Introduction 

The Graphic and Data Analysis window, shown below, provides tools for viewing COMTRADE records. 

You can use this COMTRADE viewer to display and analyze transient, extended, and continuous records 

from the APP Recorder as well as COMTRADE records from other recording devices.  

The software has a wide variety of graphics, math functions, reports, and file manipulation features that 

allow you to easily navigate your data. It supports importing of industry-standard formats such as 

COMTRADE (Common Data Transient Data Exchange) version 1991, 1999, and 2013. It also allows you 

to save data to PQDIF data formats or export the data in comma delimited (*.csv) format.  

Note: Any functions that you carry out in the Graphic and Data Analysis window will not 
modify the actual COMTRADE record. 

Tip: You can drag and drop oscillograms, tag a channel, grab the channel descriptor, drag it 
to the desired location, and drop it. 

14.2 Opening the Graphic and Data Analysis Window 

You can use ClearView to view COMTRADE records. The window in which you view these records is the 

Graphic and Data Analysis window. 

➢ To Open the Graphic and Data Analysis Window 

Go to Fault Summary Table and double click or right click on any record listed with a check mark in 

the “Retrieved” column.  

➢ To open a COMTRADE Record not shown in the Fault Summary Table. 

Go to the APP ClearView window, from the Tools menu, click New Graph. 

The Graphics and Data Analysis window appears.  

 

Figure 155: Graphic and Data Analysis Window 
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14.3 Opening COMTRADE Data Files, Not in the Fault Summary Tab 

In the Graphics and Data Analysis window, you can view up to two COMTRADE data files 

simultaneously. 

Typically, you use this tool to view records that are not listed in the Fault Summary tab of the APP 

ClearView window.  

If two records are opened at the same time and their timestamps do not overlap, the two records are placed 

in the graph area with the T0 times aligned. 

The time (X-Axis) of each oscillogram can be shifted by clicking the MORE button and specifying a time 

offset. The MORE button is located in the upper right hand corner of the Graphics and Data Analysis 

window. Selecting MORE also displays a toolbar which lists the Fault Time, Duration, Sampling Rate, and 

Total Data Points. 

Note: Records that have different sampling rates can be merged together.   

➢ To Open a COMTRADE Data File 

1. Open the Graphics and Data Analysis window.  

2. From the File menu, point to Open Data and then click one of the following:  

Open Data 1 to select the first COMTRADE record to open. 

Open Data 2 to select the second COMTRADE record to open. 

Note: To open a record from a Directory, it must have the (.dat) file and (.cfg) file unless it is a 
combined (.cff) file type which combines both data and configuration information. 

Note: A message will appear saying “End-1 and End-2 time periods do not overlap.” This is 
normal, click OK to continue. 

14.4 Saving a COMTRADE Data File with a Different Name and/or 
Format 

You can save a COMTRADE file with a different name. You can save the data in any of the following 

formats:  

• Comtrade in Binary (.dat) 

• Comtrade in ASCII (.dat) 

• Comtrade in Binary (.cff) 

• Comtrade in ASCII (.cff)) 

• IEEE-1159 <PQDIF> (.pqd)  

 

➢ To Save a COMTRADE Data File with a Different Name and/or Format 

1. In the Graphics and Data Analysis window, open the COMTRADE file that you want. 

2. From the File menu, point to Save Data As and then click one of the following:  

Save Data 1 As to select the new file name and format information for the first COMTRADE 

data file. 

Save Data 2 As to select the new file name and format information for the second 

COMTRADE data file. 
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14.5 Opening a Line Group 

You can view oscillograms that are organized in line groups to improve your data analysis. See Power 

Quality Recording for Inverter Based Resources 
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14.6 Introduction 

The increase in penetration levels of inverter-based resources (IBRs) will significantly change the dynamic 

performance of the bulk electric system. As the penetration levels of inverter-based resources increase and 

the technology of inverter-based resources evolves, recording equipment with PQ-DDR capabilities are 

needed to address the performance requirements of inverter-based resources. APP Recorders can provide a 

one solution system to meet the recording requirements of PRC-002-05, PRC-028, IEEE 2800 Table 19, 

and allow for model validation per MOD 25, 26, and 27. Points of measure can include the HS of the MPT, 

low side of the MPT, solar feeder circuits, BESS feeder circuits, cap banks, and other supplemental 

locations within an IBR plant. 

Regarding IEEE-2800, APP recorders can comply with the requirements of IEEE-2800 Table 19 if the 

proper elements are connected and setup for the APP Data Chassis recording at the point of interconnect 

with the transmission or sub-transmission system (the plant level). The recorder can perform PQ-DDR on 

elements with harmonics being recorded or derived out to the 50th harmonic. PQ-DDR and triggering can 

include Pst, Plt, RVC, very short-term harmonics, short-term harmonics, long-term harmonics, apparent 

power, active power, reactive power, power factor, frequency, and change of frequency. These quantities 

can be continuously recorder and trended with the files being in COMTRADE format and can be 

automatically converted to PQDIFF format. 

14.7 IEEE-2800 Table 19 Measurement Data  

The following table is based on IEEE 2800 Table 19 and describes the data type, points, sampling rate, 

retention and duration for Power Quality continuous recording APP Recorder includes. Retention values 

listed are typical and can be set in the Point Assignment Record. See Section 6.19 Configuring General 

Settings 
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14.8 PQ Hardware 

There are some PQ hardware component required in order for the APP Recorder to receive signals from 

IBRs for PQ. There are three Analog boards involved when recording for PQ. Analog channels are wired to 

both Standard Analog boards and to Voltage or Current specific PQ Analog boards. The IBR needs to send 

voltage signals through a PQ sensor to a PQ Analog Voltage Board. Voltage channels are also wired to a 

standard analog board for recording and triggering on other conditions. PQ Analog Current boards are 

wired in series to a standard analog board wired for current channels. 

PQ Sensor connected to a PQ Voltage analog channel with 1Meg Input Impedance 

PQ Board connected to a PQ Current analog channel with a fixed full scale of about 5A 

The following diagrams illustrate the wiring from a PQ sensor to a PQ Voltage board and an Analog 

Current board. You will notice these boards have only Current connections or Voltage connections, not 

both like the standard Analog board. 

The Voltage board is connected directly to a PQ Sensor. 

 

Figure 105 PQ Voltage board wiring 
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PQ Current boards are wired in series to a standard Analog board wired for the same Current channels 

being recorded. 

 

Figure 106 PQ Current Board wiring 

14.9 Point Assignment Analog TAB settings 

There are PAR settings required or recommended when setting up PQ analog channels. Please see Section 

6-1 Managing Point Assignment (PA) Records for more information on the full PAR set up. 

To measure out to the 50th Harmonic you must use a Transient Sampling rate of 9600 or higher. 

The Transient Sampling rate is recommended to be no higher than 15360. 

When setting up PQ current channels, use Full Scale Setting of 5 and ABS to 20.  This will change 

slightly when calibration is done. 

When setting up PQ voltage channels, Full Scale must be set to 115. 

 

14.10 Power Quality Data Recorder sample Trigger settings 

The plant level Data Chassis PQ settings enable you to trigger for Transient Recording as well as 
Triggers for PQ Continuous Recording. Ideally these triggers will be set up for channels 
in Data Chassis 1. The Figure below shows the typical Trigger settings for recording PQ 
based on IEEE 2800 Table 19. 

Note: When using DSP 7 or higher there is no restriction on how many RVC triggers, or 
which triggers they are assigned to. With DSP 6 or lower, RVC triggers are limited 
to six per data chassis and must be assigned to 1 or more of the first 6 triggers 
only. 
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14.10.1 Power Quality Data Recorder (PQ DDR) 

When utilizing DSP7 or higher in the Data Chassis and running APP Recorder software 3.3.6 or higher the 

following data shown in the table below is recorded when you have checked the Include PQ Data option 

in the Point assignment Record General Settings TAB and have enabled HD, THD, or TRD Triggers in the 

Triggers TAB.  

Note If you have DSP6 or below and have Include PQ Data checked, you will receive the 
five files in Table 8 but not the Harmonics files discussed in this section. 

Note: If you have both HD and THD triggers set on a channel, only one continuous 
recording file will be created for the channel (i.e. it won’t be duplicated). If you have 
either HD or THD and TRD Triggers on the same channel, 2 PQ continuous 
recording files will be recorded for the channel. 
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Table 8 PQ Data Recorded 

Description File Name Interval 
Typical for IEEE-2800 Triggering & 

Continuous Recording for Each 

Mapped Analog Channel 

Typical 

Circular 

Buffer 

3-sec Trigger 

Value  yyyymmddTrR##_3sec 3 seconds, 

daily 
 3p-Vrms, 3p-Irms, 3p-W, 3p-Vr, V-Hz, 

V-Hz Sign, 3p-RVC,  3p-V HD,  3p-I 

HD,  3p-V THD,  3p-I THD, TRD 
10 Days 

10-minTrend 

Trigger Value yyyymmddTrR## 10 minutes, 

daily  Same as above 90 Days 

2-hr Trend 

weekly Trigger 

Value 
yyyymmddTrR##_Weekly 2 hours, 

weekly  Same as above 365 Days 

Trend Flicker Pst yyyymmddFkrR## 10 minutes, 

daily  Selected Volt Channels  90 Days 

Trend Flicker Plt yyyymmddFkrR##_Weekly 2 hours, 

weekly  Selected Volt Channels 90 Days 

14.10.2 Individual Harmonics files  

If you check the Include Individual Harmonic Data check box in the PAR General Settings TAB/Power 

Quality box, Individual Harmonic files are created to enable easier identification of which Harmonic Order 

is the largest and above the Standard. The files will be created for any HD, THD, or TRD triggers set. See 

table below with more details. The following is a summary of the files created and more detail about each 

file name and sampling intervals. 
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Table 9 Harmonics File names and descriptions 

Note: The HD and THD measurements are based on IEC 61000-4-7, -30 and IEEE Std 519 up 
to the harmonic, see table below. Any harmonics beyond the 50th harmonic is not 
measured or recorded by the DFR.  

Transient Sampling Up to Harmonic 

2400 Hz 19th 

4800 Hz 39th 

9600 Hz and above 50th 

3 Second Daily Harmonics - one file per Analog Channel with HD, THD or TRD trigger 3 

second samplings daily starting at 5:00 AM for a year. The filename is 

[YYYYMMDD]IHR[RecID]T[Trigger#]A[Channel#]_VShort_3sec_Daily. Each file contains 50 

X-axes to extract the harmonic order values for each analog channel. Typical Retention is 30 days. 

10 Minute Weekly Harmonics - one file per analog channel with HD, THD or TRD Trigger 

sampled every 10 minutes starting 5am Sunday for a week. The filename is 

[YYYYMMDD]IHR[RecID]T[Trigger#]A[Channel#]_Short_10min_Weekly. Each file contains 

50 X-axes to find the 95th percentile. Typical Retention is 90 days. 

  

Description File Name Interval 

Typical 

Circular 

Buffer 

3-sec Very Short Time 
Individual Harmonic and THD 

yyyymmddIHR##T##A##_VShort_3sec_Daily 

3 seconds, daily (1 file a day per Analog 
Channel with HD as trigger) 
Each file contains 50 X-axes analyzed to 
extract the harmonic order values for each 
analog channel. 

30 Days 

10-min Short Time Individual 
Harmonic and THD 

yyyymmddIHR##T##A##_Short_10min_Weekly 

10 min., weekly (5am daily) (1 file a week per 
Analog Channel with HD as trigger) 
50 X-Axes in the file, to find what is the largest  
harmonic for each analog channel 

90 Days 

10-min weekly 95th percentile  yyyyIHR##T##A#_Short_10min_Weekly_95 

7 days, yearly (5am Sunday) (1 file a year per 
Analog Channel with HD as trigger) 
50 X-Axes in a file, 1 point per week to find the 

95
th

 percentile 

365 Days 

10-min weekly 99th percentile  yyyyIHR##T##A#_Short_10min_Weekly_99 

7 days, yearly (5am Sunday) (1 file a year per 
Analog Channel with HD as trigger) 
50 X-Axes in a file, 1 point per week to find the 

99
th

 percentile (values that exceed 1% for the 
week) 

365 Days 

3-sec weekly 95th percentile  yyyymmddIHR##T##A#_VShort_3sec_Daily_95 

1 day, yearly (5am daily) (1 file a year per 
Analog Channel with HD as trigger) 
50 X-Axes in a file, 1 point per week to find the 

95
th

 percentile 

365 Days 

3-sec weekly 99th percentile  yyyymmddIHR##T##A#_VShort_3sec_Daily_99 

1 day, yearly (5am daily) (1 file a year per 
Analog Channel with HD as trigger) 
50 X-Axes in a file, 1 point per week to find the 

99
th

 percentile (values that exceed 1% for the 
week) 

365 Days 



Graphic and Data Analysis Window 14-11 

Yearly Harmonic Percentile - The following Harmonics recording files are contained in 

APPRecorder\Data\PqData\PQHar folder. You set the retention for all three types of files 

described below in this field (see Section 6.19 Configuring General Settings). Typical Retention 

is 365 days. 

3 Second 95th Percentile Harmonic files - one file per Analog Channel with HD, THD or 

TRD trigger sampled daily at 5am for a year. The filename is 

[YYYYMMDD]IHR[RecID]T[Trigger#]A[Channel#]_VShort_3sec_Daily_95. Each file 

contains 50 X-axes 1 sample per week to find the 95th percentile. 

3 Second 99th Percentile Harmonic files - one file per Analog Channel with an HD trigger 

sampled daily at 5am for a year. The filename is 

[YYYYMMDD]IHR[RecID]T[Trigger#]A[Channel#]_VShort_3sec_Daily_99. Each file 

contains 50 X-axes 1 sample per week to find the 99th percentile. 

10 Minute weekly 95th Percentile Harmonic files - one file per analog channel with an HD 

Trigger sampled weekly (5am Sunday) for a year. The filename is 

[YYYY]IHR[RecID]T[Trigger#]A[Channel#]_Short_10min_Weekly_95. Each file contains 

50 X-axes 1 sample per week to find the 95th percentile. 

10 Minute weekly 99th Percentile Harmonic files - one file per analog channel with an HD 

Trigger sampled weekly (5am Sunday) for a year. The filename is 

[YYYY]IHR[RecID]T[Trigger#]A[Channel#]_Short_10min_Weekly_99. Each file contains 

50 X-axes 1 sample per week to find the 99th percentile. 

14.10.3 Convert COMTRADE to PQDIF 

If you have checked the Convert COMTRADE to PQDIF Every Day in the Power Quality area of the 

PAR General settings TAB, Recorder will create PQDIF files in the APP 

Recorder\Data\PQDATA\PQDIFData folder. The following table lists the PQDif files created 

automatically every day. 

Table 10 Convert to PQDIF files 

Location: Description File Name Interval 

APPRecorder\Data\PQData\ 
PQDIFData 

3-sec Trigger Value  yyyymmddTrR##_3sec 3 seconds, daily 
10-minTrend Trigger 
Value 

yyyymmddTrR## 10 minutes, 
daily 

2-hr Trend weekly 
Trigger Value 

yyyymmddTrR##_Weekly 2 hours, weekly 

Trend Flicker Pst yyyymmddFkrR## 
10 minutes, 
daily 

Trend Flicker Plt yyyymmddFkrR##_Weekly 2 hours, weekly 
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14.10.4 Viewing PQ Continuous recording files 

View the PQ continuous recording files in Clearview by opening a new Graph then navigating to the APP 

Recorder/Data/PQData folder and opening the desired file. The following figures show examples of 

viewing PQ files. See Section 14.2 Opening the Graphic and Data Analysis Window. Look at the Figure 

captions below each image and the filenames at the top to identify which file examples each figure shows. 
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14.10.5 Harmonics Reports 

In addition to viewing Harmonics files in Clearview, five reports to enhance analysis of Harmonics to 

pinpoint more easily if and where the Standard is not being met based on IEEE-2800 Table 19. These 

reports are saved in  APP Recorder\Data\PQData\PQReport folder and written in HTML format. When you 

open a report file it will open in your browser application. You can use your browser functions to save to a 

PDF and Print etc.. 

Following are the report descriptions. 

YYYYMMDD[RecID]VshortHarDailyReport.html  

Daily report of individual Harmonics Order by Trigger and Analog Channel. Vshort indicates 3 second 

sampling. It Identifies the Largest Order and Largest Range. Includes Min (%), Avg(%), Max(%), and 

99th(%). 

You can Filter on a Harmonic Order by selecting one or more from the Filter Rows box. Refresh the 

browser to reset the view back to all rows. 

 

 

Figure 115 Sample Daily Harmonics Report 

 

YYYYMMDD[RecID]VshortHarWeeklyReport.html  

Weely report of each Daily individual Harmonics Order by Trigger and Analog Channel. Vshort indicates 3 

second sampling. It Identifies Largest Order each day for the week. Includes Largest MAX Order, Largest 

MAX, Largest Range(%), MAX THD(%), THD 99th(%). 

YYYYMMDD[RecID]shortHarWeeklyReport.html  

Weely report of each Daily individual Harmonics Order by Trigger and Analog Channel. short indicates 10 

minute sampling. It Identifies Largest Order each day for the week. Includes Largest MAX Order, Largest 

MAX, Largest Range(%), MAX THD(%), THD 99th(%) and 95th(%). 

You can Filter on Date by selecting one or more from the Filter Rows box. Refresh the browser to reset the 

view back to all rows. 

 



Graphic and Data Analysis Window 14-14 

 

Figure 116 Sample Weekly Harmonics Report 
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YYYY[RecID]VshortHarYearlyReport.html  

Yearly report of each Weekly individual Harmonics Order by Trigger and Analog Channel. Vshort 

indicates 3 second sampling. It Identifies Largest MAX Range, MAX THD, MAX THD 99th(%)for each 

week yearly. Includes Largest MAX(%), Largest Range(%), MAX THD(%), THD 99th(%). 

YYYY[RecID]shortHarYearlyReport.html  

Yearly report of each Weekly individual Harmonics Order by Trigger and Analog Channel. short indicates 

10 minute sampling. It Identifies Largest MAX Range, MAX THD, MAX THD 99th(%)for each week 

yearly. Includes Largest MAX(%), Largest Range(%), MAX THD(%), THD 99th(%) and 95th(%).  

You can Filter on “Week of” Date by selecting one or more from the Filter Rows box. Refresh the browser 

to reset the view back to all rows. 

 

 

Figure 117 Sample Yearly Report 
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Managing Line Group Records on page 7-1 for more information on setting up line groups. 

You can open up to two line groups simultaneously. 

➢ To Open a Line Group 

1. Click the Tools Menu – New Graph  

2. From the File menu, point to Open Line Group and then click one of the following:  

Open Line-Group 1 to select the first line-group record to open 

Open Line-Group 2 to select the second line-group record to open 

Note: If you open a record from the Fault Summary Tab/Screen and a Line Group Record is 
already configured, you do not need to open a Line Group from the Graphics Screen - 
File Menu. 

14.11 Editing a Line Group 

In the Graphics and Data Analysis window, you can open and edit an existing line group.  

➢ To Edit a Line Group 

1. Open the Graphics and Data Analysis window.  

2. From the File menu, point to Edit Line Group and then click one of the following:  

Edit Line-Group 1 to select the first line-group record to edit. 

Open Line-Group 2 to select the second line-group record to edit. 

The Edit Line-Group Record window appears. For information on completing the fields in 

this window, see Editing a Line Group Record on page 8-16 

14.12 Configuring a Printer  

You can configure how your printer will print information from the Graphics and Data Analysis window. 

➢ To Configure a Printer 

Go to the Graphics and Data Analysis window, from the File menu, click Printer Setup. 

The standard Windows Print Setup window appears. 

14.13 Printing an Oscillograph 

From the Graphics and Data Analysis window, you can print an oscillograph. The print feature is similar 

to the Window Print Screen feature, except that ClearView prints only the shown oscillograms, event data, 

channel descriptions, and an oscillogram value (such as RMS) for each analog channel. The printed analog 

channel value reflects the current cursor position in the Graphics and Data Analysis window.  

You can view a print preview, print the oscillograph, or export the printout of an oscillograph. 

➢ To View a Print Preview of an Oscillograph 

Go to the Graphics and Data Analysis window, from the File menu, point to Printer Graph and then 

click Preview. A print preview window appears. 
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➢ To Print an Oscillograph 

Go to the Graphics and Data Analysis window, from the File menu, point to Printer Graph and then 

click Print. The standard Windows Print window appears.  

➢ To Export the Printout of an Oscillograph 

Go to the Graphics and Data Analysis window, from the File menu, point to Printer Graph and then 

click Export. 

The Exporting window appears, as shown in the following figure.  

Figure 156: Exporting Window 

 

1. Under Export, select the file type. 

2. Under Export Destination, select to where you want to export the file. 

3. Under Object Size, select any changes to the oscillograph dimensions. 

4. Click the Export button. 

14.14 Printing All Waveforms 

You can configure the print parameters of the analog and digital channels.  

➢ To Print All Waveforms 

1. Go to the Graphics and Data Analysis window, from the File menu, point to Print All 

Waveforms and then click one of the following: 

Click Preview 1 or Preview 2 to format the printed report of the first oscillograph that is open 

in the Graphic and Data Analysis window.   

Click Print 1 or Print 2 to send the formatted oscillograph to the printer. 

The Format All Wave Printing window appears, as shown in the following figure. 
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Figure 157: Format All Wave Printing Window 

2. From the Analog Channel Format list, select the appropriate format: 

YScale Optimized (peak) 

Prints the highest peak value measured to the right-hand side of each oscillogram printed. 

YScale Optimized (unit/cm) 

Prints a volts/cm or amps/cm scale to the right-hand side of each oscillogram printed. 

YScale = Channel Full Scale Optimized (unit/cm) 

Prints a volts/cm or amps/cm scale to the right-hand side of each oscillogram printed. The 

value is based on the full scale setting in the Point Assignment Record and the number of 

oscillograms printed on the page. 

Yscale = User Select Scale (unit/cm) 

If selected, a user programmable Yscale field appears. The user can enter their desired 

volts/cm or amps/cm scale. Prints a volts/cm or amps/cm scale to the right-hand side of each 

oscillogram printed. The value is based on a user entered  Yscale (unit/cm). If the scale is too 

small waveform clipping will occur. 

Yscale Optimized (RMS) 

This selection prints the RMS value to the right side of each oscillogram printed. 

Note: Print fewer channels on a page to increase the resolution on the Yscale. 

3. From the Channels list,  select one of the following choices: 

All 

Prints an oscillogram for each analog channel listed in the Point Assignment Record. 

Selected 

After you select this, click the Select Channels button to select the specific channels to print. 

Lines 

Specific preset line groups can be printed. 
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4. From the Data Range list, select the range of records to print: 

All 

Prints the entire length (X-axis) of all the oscillograms selected for printing. 

Selected 

Each data point in an oscillogram has a number. The starting number is “0”  which is usually 

the prefault portion of the waveform. The ending number depends on how long the fault or 

recording lasted.  To print a partial record, (X- axis length), enter the data range. 

5. In the #Channels/Page box, enter the number of oscillograms you want to appear on each page of 

the printout.  

Note: Print fewer oscillograms on a page to increase the resolution on the Yscale. 

6. Limited to 100 Cycles per Page check box causes the report to limit to 100 cycles per page for 

each channel displayed on a page.  

7. There are two types of triggers: analog triggers and event triggers. You can print these triggers 

in conjunction with oscillograms. Triggers are represented by horizontal lines at the bottom of a 

printed or displayed page.  In the Digital Channel Format list, select how the trigger line should 

appear, whether it is normal or abnormal: 

Sequence Of Events /Triggers (Line on Abnormal) 

This selection only prints the event channels or analog triggers that caused the system to 

trigger and record. The state of other event channels is not printed. If a line is shown, it 

represents the period of time the event was abnormal.  

Sequence Of Events /Triggers (Line on Normal) 

This selection only prints the event channels or analog triggers that caused the  system to 

trigger and record. The state of other event channels is not printed. If a line is shown, it 

represents the period of time the event was normal.  

All Events/Triggers (Line on Abnormal) 

This selection prints the analog triggers and event channels that were in an abnormal state 

when the record was created. If a line is shown, it represents the period of time the analog 

trigger or event channel was abnormal. 

All Events/Triggers (Line on Normal) 

This selection prints the analog triggers and event channels that were in an  normal state when 

the record was created. If a line is shown it represents the period of time the analog trigger or 

event channel was normal. 

8. Spread digital among graphs, if Spread Digital check box is not checked, the Analog channels 

are printed then the Event Channels on each page (See Figure 158). With Spread Digital check 

box checked the report shows the digital channels along with the analog lines together. (See 

Figure 159). 
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Figure 158: Default Report Format 

Figure 159: Report with Spread Digital Among Graphs Checked 
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9. No Trigger check box causes the report to exclude Analog Trigger faults from the report. An 

Event Trigger will still display if an Event Channel is set up, and an Event Channel caused the 

Trigger or an Event Channel changed state while the record was being created. 

10. In the Panel Size box, enter the percentage of space the event and analog trigger lines will use at 

the bottom of a printed page.  

11. In the Font Size Global Control box, enter the font size to be used for the title of the waveform 

pages and any annotations that may have been added. You cannot change the font on the Fault 

Summary Report. 

12. In the Font Size Title Control box, enter the font size for the title that appears at the top of each 

waveform or oscillogram page.  

13. In the Annotation Text Size box, enter the font size for any annotations that are added to a 

waveform or oscillogram page. 

14. Click the OK button. 

14.15 Exporting Graph Analog Data 

You can export raw analog data to several formats listed below. 

➢ To Export Graph Analog Data 

1. In the Graphics and Data Analysis window, from the File menu, click Export Graph Data Or 

Export Graph Data (16 bit) to accommodate Doble test set using COMTRADE files older 

than 2013. 

The Export Graph Data window appears. 

2. From the Save in list, select the location for the exported file.  

3. In the File name box, specify the file name. 

4. From the Save as type list, select the preferred format.  

• Comtrade in Binary (.dat) – creates the data and associated config file 

• Comtrade in ASCII (.dat) – creates the data and associated config file 

• Comtrade in Binary (.cff) – creates a single common file format file in Binary 

• Comtrade in ASCII (.cff)) – creates a single common file format file in ASCII 

• Excel (.csv) - creates a single CSV file 

• IEEE-1159 <PQDIF> (.pqd) – Creates a PQDIF file intended for viewing with 

Power Quality Viewers 

5. Click the Save button. 

6. If you use Excel Format (CSV), you will be asked if you want to Save Data with Phase? 

If you would like Phase Data in the Excel file, Click Yes 

If Not, Click No 



Graphic and Data Analysis Window 14-22 

7. Swap Analog and Digital Channel ID with Description window appears, (except when using 

Excel format), Click Yes or No. 

 

Figure 160: Swap Channel IDs with Descriptions 

Below is an example of how analog channel ID and Descriptions are changed depending on the 

YES or No selection.  This example is for three analog channels displayed on the graphics screen 

with each channel on its own X-axis and channels in A2, A3, A1 order.  No matter the choice, a 

sequential analog channel ID is added to the left during the export process. 

Table 15: Channel ID and Description swap examples 

Swap ID’s ID & Description Before Export ID & Description After Export 

No A2:Line XYZ Vb A1:A2;Vb; Line XYZ Vb 

 A3:Line XYZ Vc A2:A3;Vc; Line XYZ Vc 

 A1:Line XYZ Va A3:A1;Va; Line XYZ Va 

Yes A2:Line XYZ Vb A1:Line XYZ Vb;Vb;A2 

 A3:Line XYZ Vc A2:Line XYZ Vc;Vc;A3 

 A1:Line XYZ Va A3:Line XYZ Va;Va;A1 

14.16 Combining End-1 and End-2 into One File 

End-1 and End-2 data can come from the same APP Recorder. Having the same analog channel 

descriptions could mean that they are coming from the same channel.  

The time of the data in the combined file is always referencing the time of End-1 data. For example, before 

the combining, data 203 of End-1 at time 11/1/2008-09:11:57.662499 is aligned with data 234 of End-2 at 

time 11/2/2008-23:01:770283. After combining, the time of these two data will both be 11/1/2008-

09:11:57.662499. If End-2 file was longer in time than End-1 file, the time will simply extended 

referencing to End-1 time for the extra data in End-2 file. In other words, in a combined file, the End-2 time 

is completely eliminated; all times reference the End-1 time.  

Therefore, before combining data, align the End-1 and End-2 data by using the Time Offset (ms) box.  

➢ To Combine End-1 and End-2 into One File 

1. In the Graphics and Data Analysis window, display End-1 and End-2 data on the graph.  

2. From the File menu, click Combine END-1 and END-2 into One File. 

A confirmation window will appear.  
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3. Do one of the following: 

Click Yes. The channels in End-1 and End-2 with the same description will both be saved into 

a different channel in the combined file.   

Click No. The End-2 channels with the same description as End-1 will be discarded in the 

combined file. 

14.17 Exiting the Graphics and Data Analysis Window 

When you exit the Graphics and Data Analysis window, you return to the Fault Summary tab in the 

APP ClearView window. 

➢ To Exit the Graphics and Data Analysis Window 

In the Graphics and Data Analysis window, from the File menu, click Exit. 

The APP ClearView window appears. 

14.18 Using Graph Controls 

The following figure shows the available graph controls.  

 

Figure 161: Graph Menu 

See the following sections for more information on how to use the graph controls. 

14.18.1 Selecting Your Preferred Cursor 

You can select the type of cursor you prefer in the Graphic and Data Analysis window.  

➢ To Select Your Preferred Cursor 

In the Graphics and Data Analysis window, from the Graph menu, point to Cursor and then click 

Vertical Line, Cross Hair, or No Cursor. 

14.18.2 Turning On or Off Standard Cursor Movement  

By default, the onscreen cursor follows the movement of the mouse. This is standard behavior in Windows 

applications. However, this behavior can be turned off.  

If  this behavior is off, then to move the cursor, single-click the position on the graph where you want the 

cursor to go. 
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➢ To Turn On or Off Standard Cursor Movement 

In the Graphics and Data Analysis window, from the Graph menu, click Cursor follows mouse. 

One of the following occurs: 

If a checkmark appears next to the menu option, it means that the cursor does follow the 

mouse.  

Otherwise, the cursor does not follow the mouse. 

14.18.3 Showing a Second Cursor 

By default, only one cursor is visible in the Graphics and Data Analysis window. However, you can enable 

a second cursor in order to see the window in which calculations are performed.  

The results of calculations appear in the right-hand side of the Graphics and Data Analysis window. You 

can change values in the Calculation pane by right clicking in it and then changing number of cycles used 

for a calculation.  

➢ To Show a Second Cursor 

In the Graphics and Data Analysis window, from the Graph menu, click Show 2nd Cursor. 

One of the following occurs: 

If a checkmark appears next to the menu option, it means that the second cursor appears.  

Otherwise, the second cursor does not appear. 

14.18.4 Showing Data Points 

You can display actual data samples on all the oscillograms in the Graphics and Data Analysis window. 

➢ To Show Data Points 

In the Graphics and Data Analysis window, from the Graph menu, click Show Data Points. 

One of the following occurs: 

If a checkmark appears next to the menu option, it means that the data points appear.  

Otherwise, the data points do not appear. 

14.18.5 Showing the X-Axis 

You can choose to display (or hide) the X-Axis (time in milliseconds) at the bottom of the graph area. 

➢ To Show the X-Axis 

In the Graphics and Data Analysis window, from the Graph menu, click Show X-Axis. 

One of the following occurs: 

If a checkmark appears next to the menu option, it means that the X-Axis appears.  

Otherwise, the X-Axis does not appear. 
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14.18.6 Enabling XY Tracking 

You can enable an XY tracking meter in the tray area at the bottom of the graph area. The x-axis displays 

time in milliseconds. Because the cursor snaps from data point to data point, XY tracking allows you to 

read the time between data points.  

➢ To Enable XY Tracking  

In the Graphics and Data Analysis window, from the Graph menu, click XY Tracking. 

One of the following occurs: 

If a checkmark appears next to the menu option, it means that the XY tracking is enabled.  

Otherwise, the XY tracking is not enabled. 

14.18.7 Configuring Y Scales 

You can configure the appearance of the Yscales in the Graphics and Data Analysis window. 

➢ To Configure the Y Scales  

In the Graphics and Data Analysis window, from the Graph menu, point to Y Scales and then click 

one of the following: 

Constant among panels: The Y Scale is determined by the largest signal that is being 

displayed. The Y Scale of every panel is the same. The Y Scale is displayed in the upper right 

hand corner of the graphics area. 

Optimize each panel: The Y Scale of each individual panel is determined by the largest signal 

within that panel. The Y Scale of each panel can be different. 

Optimize each graph: The Y Scale of each oscillogram is expanded to its maximum extent 

that will still allow it to fit within its graph panel. The more panels displayed, the smaller the 

Y Scale. 

Tip: Use the X and Ix magnifiers located on the right-hand side of the Graphics and 
Data Analysis window to magnify a tagged channel or to simultaneously magnify 
all current channels. 

14.18.8 Configuring Your Zoom Preference 

You can configure whether you want to be able to zoom in horizontally or both horizontally and vertically. 

➢ To Configure Your Zoom Preference  

In the Graphics and Data Analysis window, from the Graph menu, point to Zoom Preference and 

then click one of the following: 

Horz Zoom: If you select this option, then you can zoom only from left to right. 

Horz plus Vert Zoom: If you select this option, then you can simultaneously zoom from left to 

right and from top to bottom.  

Note: To zoom previous or undo zoom, right click in the graph area and select either 
choice.  
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14.18.9 Enabling Free Form Graph Movement 

You can enable the ability to freely move graphs up and down by dragging the analog channel description.  

In the Graphics and Data Analysis window, from the Graph menu, click Free Form. 

One of the following occurs: 

If a checkmark appears next to the menu option, it means that the free form graph movement is 

enabled.  

Otherwise, the free form graph movement is not enabled, and dragging channel descriptions and 

graph snap from x-axis to x-axis. 

14.19 Displaying Data Plots 

Before ClearView can display an impedance plot, you must identify the phases of data by doing any of the 

following: 

14.19.1 Displaying an Impedance Plot 

1. Do any one of the following things to identify the phases: 

Define a line group  

Set the phases for the channels in Point Assignment Record 

Show a “Three Phase” graph 

2. After you have identified the phases, from the Plot menu, click Impedance.  

The Impedance Plot window appears, as shown in the following figure. 

 

Figure 162: Impedance Plot Window 

In an impedance plot, ClearView automatically matches the voltage and the current with the same 

phase. For example, selecting Va will prompt ClearView to find the first occurrence of Ia on the 

display to do the impedance plot. 

You can define up to 9 zones in impedance plot. Each zone has two parameters: impedance and 

angle. If both user-entered parameters are zero, the zone is clear. If one or both user entered 

parameters are something other than zero, ClearView will draw a circle. The diameter of the 

plotted circle is equal to the impedance parameter. The larger the user-entered impedance, the 

larger the circle.  
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The user-entered angle, referencing to x-axis, is automatically created. A diameter line runs from 

the graph (0,0) point thru the circle. Where the diameter line intersects the circle a zone label is 

automatically placed. 

If any impedance value gets into the zone, it usually means a fault is occurring at that point in 

time. To analyze the movement of the impedance over time, zoom in and out on the oscillographs 

and the impedance plot will update to the display. After zooming in, a scroll bar will appear at the 

bottom. Scrolling will show movement of the impedance.  

By right mouse clicking on the impedance plot, you can select the menu entitled “Point + Line”. 

This connects the impedance values on the plot indicating what order the impedance values come. 

14.19.2 Displaying a DFT Plot 

See Section 14.25 Tool Bar for more information. 

14.19.3 Displaying an FFT Plot 

See Section 14.25 Tool Bar for more information. 

14.19.4 Displaying a Vector Plot 

See Section 14.25 Tool Bar for more information. 

14.19.5 Using the Options Menu 

The Options menu consists of Graph Options and Fix One Phase. 

 

Figure 163: Options Menu 

14.19.6  Graph Options 

You can select the following graph options: 

▪ How many graphs to display when the Graphic and Data Analysis window first opens 

▪ The colors for each voltage and current phase  

▪ Which event channels are displayed, based on the filter you define 

Note: Analog phases are defined in the Point Assignment Record. 



Graphic and Data Analysis Window 14-28 

➢ To Select Graph Options 

1. In the Graphics and Data Analysis window, from the Options menu, click Graph Options. 

The Graph Options window appears, as shown in the following figure.  

Figure 164: Graph Options Window 

2. In the #Graphs at Start list, select the number of graphs to display when the Graphics and Data 

Analysis window is opened. 

3. Do you want to use Calibrated Phase that would have been set in the Oscope Calibrate Phase 

function? 

If yes, then click Calibrated Phase check box. 

If no, skip to the next step. 

4. Do you want to display distance in Kilometers? 

If yes, then click the Km check box. 

If no, skip to the next step. 

5. Do you want to define the color to use for each phase? 

If yes, then click the Define Color check box. Then, for each phase, select a color from its 

color list. 

If no, skip to the next step. 

6. Display This Event(s) Only to define an Event Filter? 

1. In the Graph Options window, click the End-1 or End-2 tab, depending on which you 

want to filter.  

2. Click the Display This Event(s) Only check box.  

3. Do you want to select from a list of events?  

If yes, then click the Select button. From the Select Event Channels window, select 

the event(s) and then click the OK button.  

If no, skip to the next step. 
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4. Do you want to open a User-Selected Channel File (*.inf) to select events?  

If yes, then click the Open button.  

In the Open Display This Events Only window, navigate to and select the file. Then click 

the Open button.  

5. Repeat this step for the other End-# tab, as necessary. 

6. Include Normal – Click the check box to include Trigger and Event Channels in Normal 

condition. These will be displayed at the bottom of the screen. 

7. Include SER Check Box: To graphically add events contained in the SER report to the 

transient fault record, extended oscillography record, and extend RMS record, check mark 

“Include SER”.  Only SER events that have a time stamp within the time range of the record 

will be graphically displayed at the bottom of the graphics screen (no line means normal, and 

line shown is abnormal.)   Concerning the transient fault record which displays asserted 

analog triggers and event (digital) channels as part of the record, a particular event channel 

logged to the SER report will not be displayed a second time.  If alarms are set to log to the 

SER report, they will also be graphically displayed in the same manner as an event channel. 

8. Do you want to define the filter for determining which Event Channels appear? 

If yes, follow the procedure Display This Event(s) Only to define an Event Filter? 

on page 14-16 

If no, skip to the next step. 

9. Click the OK button. 
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14.19.7 Fixing One Phase 

By default, a selected analog channel is fixed as a reference phase for other channels for phase calculation 

and vector display. If the Fix One Phase menu option is not selected, then all phase calculations will be 

referenced to a cosine function. 

➢ To Fix One Phase  

In the Graphics and Data Analysis window, from the Options menu, click Fix One Phase. 

One of the following occurs: 

If a checkmark appears next to the menu option, it means that a selected analog channel is 

fixed as a reference phase.  

Otherwise, all phase calculations will be referenced to a cosine function. 

14.20 Managing the Graphic and Analysis Window 

 

Figure 165: Window Menu 

14.20.1 Refreshing the Window 

➢ To Refresh the Window 

In the Graphics and Data Analysis window, from the Window menu, click Refresh. 
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14.20.2 Clearing All User Markers 

You can delete any annotation marks that you have added to the graph. 

➢ To Clear All User Markers 

In the Graphics and Data Analysis window, from the Window menu, click Clear All User Markers.  

14.20.3 Closing All Graphs 

You can have five graph windows open at once. You can close all open graphs simultaneously. 

➢ To Close All Graphs 

In the Graphics and Data Analysis window, from the Window menu, click Close All Graphs. 

You can also close all graphs by clicking the Close All tab at the bottom of the window. 

14.20.4 Showing All Graphs 

You can have five graph windows open at once. You can show all the open graphs. 

➢ To Show All Graphs 

In the Graphics and Data Analysis window, from the Window menu, click Show All Graphs.  

You can also open all graphs by selecting the Show All tab at the bottom of the window. 

14.20.5 Showing a Specific Graph 

You can have four graph windows open at once. You can show a specific graph. 

➢ To Show a Specific Graph 

In the Graphics and Data Analysis window, from the Window menu, click Show Graph#[1-4].  

You can also select open graphs by selecting the Graph tab at the bottom of the window. 

14.20.6 Viewing Help 

You can view the help for the Graphic and Data Analysis window. The About information includes the 

software version and factory contact information. 

Note:  If the help files do not answer your question(s), please do not hesitate to contact APP 
Engineering, Inc. at (317) 536-5300. 

➢ To View the Help  

In the Graphic and Data Analysis window, from the Help menu, click Help. 

➢ To View the About Information  

In the Graphic and Data Analysis window, from the Help menu, click About. 
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14.21 Using the Pop-Up Menu in the Graph Area 

In the Graphic and Data Analysis window, you can right click anywhere in the graph area to display the 

menu shown in the following figure.  

Figure 166: Graph Area Pop-up Menu 

Many of the choices shown in this pop-up menu are the same as those under the Graph menu, located at 

the top of the window. See Section 14.18 Using Graph Controls for information not covered in the 

following sections. 

14.21.1 Setting a Reference Line 

You can set two references lines: red and blue. The red line is the first line you can set. You can move it by 

double-clicking anywhere in the graph area. 

When you display a red reference line, a delta time and a delta cycles meter is displayed in the tray area at 

the bottom of the window. The delta time and delta cycles meter changes as the user moves the vertical 

cursor left or right. 

The blue reference line enables you to zoom between reference lines.  

➢ To Set a Red Reference Line 

1. In the Graph area, right-click to display the pop-up menu.  

2. Click Set Reference Line (red) to set a red reference line.  

3. In the Graph area, double-click on the spot where you want the red reference line to be. 

Note:  Double-clicking on the graph will move only the Red Time Reference Line. 

➢ To Set a Blue Reference Line 

1. After you have set a red reference line, click in the graph where you want the blue reference line to 

be. 

2. In the Graph area, right-click to display the pop-up menu.  

3. Click Set Reference Line 2 (blue).  

Your blue reference line immediately appears where you clicked before displaying the pop-up 

menu. 
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14.21.2 Zooming Between Time Reference Lines 

If you need a consistent zoom location, place two time reference lines (red and blue) in the graph. the x-

axis will be set as having the time reference lines as endpoints. 

➢ To Zoom In between Time Reference Lines 

1. In the Graph area, set the red and blue reference lines. 

2. Right-click to display the pop-up menu.  

3. Click Zoom In between Time Ref Lines. 

The graph immediately zooms in.  

14.21.3 Returning the Graph to the Previous Zoom Factor 

You can return the graph to its previous zoom factor. 

➢ To Return the Graph to the Previous Zoom Factor  

1. In the Graph area, right-click to display the pop-up menu. 

2. Click Zoom Previous. 

14.21.4 Undoing the Zoom 

You can reverse all zooming actions and return the graph area back to its original state. 

➢ To Undo the Zoom 

1. In the Graph area, right-click to display the pop-up menu. 

2. Click Undo Zoom. 

14.21.5 Inserting a Marker  

➢ To Insert a Marker 

1. In the Graph area, move the cursor to the desired position. 

2. Right-click to display the pop-up menu. 

3. Point to Insert Marker and then click one of the following: 

With Meter Value: inserts a meter value stamp. 

With User Text: inserts a meter value stamp and allows you to add comments. 

With Date and Time: inserts a date and time stamp; you can add to all at once or one at a 

time. 

Note: Once a marker or annotation is added to a graph, you can move it and its leader line by 
clicking on it and dragging. 

14.21.6 Undo Marker 

➢ To Undo the last Marker 

1. Right click in the Graph Area to display the pop up menu. 

2. Click on Undo Marker. 

Note: You can repeat the process to undo previous markers in reverse order of markers added. 
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14.21.7 Calculating the Location of a Fault  

In the Graphic and Data Analysis window, you can perform a manual fault calculation. A manual fault 

location may be required if: 

▪ Data is being opened from a recorder other than an APP Recorder. 

▪ The APP Recorder did not contain a Line Group Record when the fault occurred. 

▪ The auto-calculate fault location feature was not enabled at the APP Recorder. 

▪ The Boolean logic filter associated with automatically calculated fault location was not passed. 

The APP Recorders use an impedance-based method for calculating the distance to fault. The APP 

Recorder uses a single-ended calculation. However, you can perform a double-ended calculation by pulling 

data from each end of a faulted line back to the APP ClearView master station software and manually 

initiating a double-ended calculation command.  

For the APP Recorder to automatically perform a single-ended fault location calculation, the line length, 

positive resistance (R1), positive reactance (X1), zero resistance (R0), and zero reactance (X0) must be 

entered into the line group(s). Also, the analog channel physical connection must provide phase-to-ground 

voltages and currents.  

A line group consists of Va, Vb, Vc, Ia, Ib, Ic, and In. The line group table must be completed in order to 

view line group oscillograms and perform distance-to-fault calculations. For more information, see Power 

Quality Recording for Inverter Based Resources 
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14.22 Introduction 

The increase in penetration levels of inverter-based resources (IBRs) will significantly change the dynamic 

performance of the bulk electric system. As the penetration levels of inverter-based resources increase and 

the technology of inverter-based resources evolves, recording equipment with PQ-DDR capabilities are 

needed to address the performance requirements of inverter-based resources. APP Recorders can provide a 

one solution system to meet the recording requirements of PRC-002-05, PRC-028, IEEE 2800 Table 19, 

and allow for model validation per MOD 25, 26, and 27. Points of measure can include the HS of the MPT, 

low side of the MPT, solar feeder circuits, BESS feeder circuits, cap banks, and other supplemental 

locations within an IBR plant. 

Regarding IEEE-2800, APP recorders can comply with the requirements of IEEE-2800 Table 19 if the 

proper elements are connected and setup for the APP Data Chassis recording at the point of interconnect 

with the transmission or sub-transmission system (the plant level). The recorder can perform PQ-DDR on 

elements with harmonics being recorded or derived out to the 50th harmonic. PQ-DDR and triggering can 

include Pst, Plt, RVC, very short-term harmonics, short-term harmonics, long-term harmonics, apparent 

power, active power, reactive power, power factor, frequency, and change of frequency. These quantities 

can be continuously recorder and trended with the files being in COMTRADE format and can be 

automatically converted to PQDIFF format. 

14.23 IEEE-2800 Table 19 Measurement Data  

The following table is based on IEEE 2800 Table 19 and describes the data type, points, sampling rate, 

retention and duration for Power Quality continuous recording APP Recorder includes. Retention values 

listed are typical and can be set in the Point Assignment Record. See Section 6.19 Configuring General 

Settings 
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14.24 PQ Hardware 

There are some PQ hardware component required in order for the APP Recorder to receive signals from 

IBRs for PQ. There are three Analog boards involved when recording for PQ. Analog channels are wired to 

both Standard Analog boards and to Voltage or Current specific PQ Analog boards. The IBR needs to send 

voltage signals through a PQ sensor to a PQ Analog Voltage Board. Voltage channels are also wired to a 

standard analog board for recording and triggering on other conditions. PQ Analog Current boards are 

wired in series to a standard analog board wired for current channels. 

PQ Sensor connected to a PQ Voltage analog channel with 1Meg Input Impedance 

PQ Board connected to a PQ Current analog channel with a fixed full scale of about 5A 

The following diagrams illustrate the wiring from a PQ sensor to a PQ Voltage board and an Analog 

Current board. You will notice these boards have only Current connections or Voltage connections, not 

both like the standard Analog board. 

The Voltage board is connected directly to a PQ Sensor. 

 

Figure 105 PQ Voltage board wiring 
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PQ Current boards are wired in series to a standard Analog board wired for the same Current channels 

being recorded. 

 

Figure 106 PQ Current Board wiring 

14.25 Point Assignment Analog TAB settings 

There are PAR settings required or recommended when setting up PQ analog channels. Please see Section 

6-1 Managing Point Assignment (PA) Records for more information on the full PAR set up. 

To measure out to the 50th Harmonic you must use a Transient Sampling rate of 9600 or higher. 

The Transient Sampling rate is recommended to be no higher than 15360. 

When setting up PQ current channels, use Full Scale Setting of 5 and ABS to 20.  This will change 

slightly when calibration is done. 

When setting up PQ voltage channels, Full Scale must be set to 115. 

 

14.26 Power Quality Data Recorder sample Trigger settings 

The plant level Data Chassis PQ settings enable you to trigger for Transient Recording as well as 
Triggers for PQ Continuous Recording. Ideally these triggers will be set up for channels 
in Data Chassis 1. The Figure below shows the typical Trigger settings for recording PQ 
based on IEEE 2800 Table 19. 

Note: When using DSP 7 or higher there is no restriction on how many RVC triggers, or 
which triggers they are assigned to. With DSP 6 or lower, RVC triggers are limited 
to six per data chassis and must be assigned to 1 or more of the first 6 triggers 
only. 



Graphic and Data Analysis Window 14-38 

 

14.26.1 Power Quality Data Recorder (PQ DDR) 

When utilizing DSP7 or higher in the Data Chassis and running APP Recorder software 3.3.6 or higher the 

following data shown in the table below is recorded when you have checked the Include PQ Data option 

in the Point assignment Record General Settings TAB and have enabled HD, THD, or TRD Triggers in the 

Triggers TAB.  

Note If you have DSP6 or below and have Include PQ Data checked, you will receive the 
five files in Table 8 but not the Harmonics files discussed in this section. 

Note: If you have both HD and THD triggers set on a channel, only one continuous 
recording file will be created for the channel (i.e. it won’t be duplicated). If you have 
either HD or THD and TRD Triggers on the same channel, 2 PQ continuous 
recording files will be recorded for the channel. 
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Table 8 PQ Data Recorded 

Description File Name Interval 
Typical for IEEE-2800 Triggering & 

Continuous Recording for Each 

Mapped Analog Channel 

Typical 

Circular 

Buffer 

3-sec Trigger 

Value  yyyymmddTrR##_3sec 3 seconds, 

daily 
 3p-Vrms, 3p-Irms, 3p-W, 3p-Vr, V-Hz, 

V-Hz Sign, 3p-RVC,  3p-V HD,  3p-I 

HD,  3p-V THD,  3p-I THD, TRD 
10 Days 

10-minTrend 

Trigger Value yyyymmddTrR## 10 minutes, 

daily  Same as above 90 Days 

2-hr Trend 

weekly Trigger 

Value 
yyyymmddTrR##_Weekly 2 hours, 

weekly  Same as above 365 Days 

Trend Flicker Pst yyyymmddFkrR## 10 minutes, 

daily  Selected Volt Channels  90 Days 

Trend Flicker Plt yyyymmddFkrR##_Weekly 2 hours, 

weekly  Selected Volt Channels 90 Days 

14.26.2 Individual Harmonics files  

If you check the Include Individual Harmonic Data check box in the PAR General Settings TAB/Power 

Quality box, Individual Harmonic files are created to enable easier identification of which Harmonic Order 

is the largest and above the Standard. The files will be created for any HD, THD, or TRD triggers set. See 

table below with more details. The following is a summary of the files created and more detail about each 

file name and sampling intervals. 
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Table 9 Harmonics File names and descriptions 

Note: The HD and THD measurements are based on IEC 61000-4-7, -30 and IEEE Std 519 up 
to the harmonic, see table below. Any harmonics beyond the 50th harmonic is not 
measured or recorded by the DFR.  

Transient Sampling Up to Harmonic 

2400 Hz 19th 

4800 Hz 39th 

9600 Hz and above 50th 

3 Second Daily Harmonics - one file per Analog Channel with HD, THD or TRD trigger 3 

second samplings daily starting at 5:00 AM for a year. The filename is 

[YYYYMMDD]IHR[RecID]T[Trigger#]A[Channel#]_VShort_3sec_Daily. Each file contains 50 

X-axes to extract the harmonic order values for each analog channel. Typical Retention is 30 days. 

10 Minute Weekly Harmonics - one file per analog channel with HD, THD or TRD Trigger 

sampled every 10 minutes starting 5am Sunday for a week. The filename is 

[YYYYMMDD]IHR[RecID]T[Trigger#]A[Channel#]_Short_10min_Weekly. Each file contains 

50 X-axes to find the 95th percentile. Typical Retention is 90 days. 

  

Description File Name Interval 

Typical 

Circular 

Buffer 

3-sec Very Short Time 
Individual Harmonic and THD 

yyyymmddIHR##T##A##_VShort_3sec_Daily 

3 seconds, daily (1 file a day per Analog 
Channel with HD as trigger) 
Each file contains 50 X-axes analyzed to 
extract the harmonic order values for each 
analog channel. 

30 Days 

10-min Short Time Individual 
Harmonic and THD 

yyyymmddIHR##T##A##_Short_10min_Weekly 

10 min., weekly (5am daily) (1 file a week per 
Analog Channel with HD as trigger) 
50 X-Axes in the file, to find what is the largest  
harmonic for each analog channel 

90 Days 

10-min weekly 95th percentile  yyyyIHR##T##A#_Short_10min_Weekly_95 

7 days, yearly (5am Sunday) (1 file a year per 
Analog Channel with HD as trigger) 
50 X-Axes in a file, 1 point per week to find the 

95
th

 percentile 

365 Days 

10-min weekly 99th percentile  yyyyIHR##T##A#_Short_10min_Weekly_99 

7 days, yearly (5am Sunday) (1 file a year per 
Analog Channel with HD as trigger) 
50 X-Axes in a file, 1 point per week to find the 

99
th

 percentile (values that exceed 1% for the 
week) 

365 Days 

3-sec weekly 95th percentile  yyyymmddIHR##T##A#_VShort_3sec_Daily_95 

1 day, yearly (5am daily) (1 file a year per 
Analog Channel with HD as trigger) 
50 X-Axes in a file, 1 point per week to find the 

95
th

 percentile 

365 Days 

3-sec weekly 99th percentile  yyyymmddIHR##T##A#_VShort_3sec_Daily_99 

1 day, yearly (5am daily) (1 file a year per 
Analog Channel with HD as trigger) 
50 X-Axes in a file, 1 point per week to find the 

99
th

 percentile (values that exceed 1% for the 
week) 

365 Days 
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Yearly Harmonic Percentile - The following Harmonics recording files are contained in 

APPRecorder\Data\PqData\PQHar folder. You set the retention for all three types of files 

described below in this field (see Section 6.19 Configuring General Settings). Typical Retention 

is 365 days. 

3 Second 95th Percentile Harmonic files - one file per Analog Channel with HD, THD or 

TRD trigger sampled daily at 5am for a year. The filename is 

[YYYYMMDD]IHR[RecID]T[Trigger#]A[Channel#]_VShort_3sec_Daily_95. Each file 

contains 50 X-axes 1 sample per week to find the 95th percentile. 

3 Second 99th Percentile Harmonic files - one file per Analog Channel with an HD trigger 

sampled daily at 5am for a year. The filename is 

[YYYYMMDD]IHR[RecID]T[Trigger#]A[Channel#]_VShort_3sec_Daily_99. Each file 

contains 50 X-axes 1 sample per week to find the 99th percentile. 

10 Minute weekly 95th Percentile Harmonic files - one file per analog channel with an HD 

Trigger sampled weekly (5am Sunday) for a year. The filename is 

[YYYY]IHR[RecID]T[Trigger#]A[Channel#]_Short_10min_Weekly_95. Each file contains 

50 X-axes 1 sample per week to find the 95th percentile. 

10 Minute weekly 99th Percentile Harmonic files - one file per analog channel with an HD 

Trigger sampled weekly (5am Sunday) for a year. The filename is 

[YYYY]IHR[RecID]T[Trigger#]A[Channel#]_Short_10min_Weekly_99. Each file contains 

50 X-axes 1 sample per week to find the 99th percentile. 

14.26.3 Convert COMTRADE to PQDIF 

If you have checked the Convert COMTRADE to PQDIF Every Day in the Power Quality area of the 

PAR General settings TAB, Recorder will create PQDIF files in the APP 

Recorder\Data\PQDATA\PQDIFData folder. The following table lists the PQDif files created 

automatically every day. 

Table 10 Convert to PQDIF files 

Location: Description File Name Interval 

APPRecorder\Data\PQData\ 
PQDIFData 

3-sec Trigger Value  yyyymmddTrR##_3sec 3 seconds, daily 
10-minTrend Trigger 
Value 

yyyymmddTrR## 10 minutes, 
daily 

2-hr Trend weekly 
Trigger Value 

yyyymmddTrR##_Weekly 2 hours, weekly 

Trend Flicker Pst yyyymmddFkrR## 
10 minutes, 
daily 

Trend Flicker Plt yyyymmddFkrR##_Weekly 2 hours, weekly 
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14.26.4 Viewing PQ Continuous recording files 

View the PQ continuous recording files in Clearview by opening a new Graph then navigating to the APP 

Recorder/Data/PQData folder and opening the desired file. The following figures show examples of 

viewing PQ files. See Section 14.2 Opening the Graphic and Data Analysis Window. Look at the Figure 

captions below each image and the filenames at the top to identify which file examples each figure shows. 
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14.26.5 Harmonics Reports 

In addition to viewing Harmonics files in Clearview, five reports to enhance analysis of Harmonics to 

pinpoint more easily if and where the Standard is not being met based on IEEE-2800 Table 19. These 

reports are saved in  APP Recorder\Data\PQData\PQReport folder and written in HTML format. When you 

open a report file it will open in your browser application. You can use your browser functions to save to a 

PDF and Print etc.. 

Following are the report descriptions. 

YYYYMMDD[RecID]VshortHarDailyReport.html  

Daily report of individual Harmonics Order by Trigger and Analog Channel. Vshort indicates 3 second 

sampling. It Identifies the Largest Order and Largest Range. Includes Min (%), Avg(%), Max(%), and 

99th(%). 

You can Filter on a Harmonic Order by selecting one or more from the Filter Rows box. Refresh the 

browser to reset the view back to all rows. 

 

 

Figure 115 Sample Daily Harmonics Report 

 

YYYYMMDD[RecID]VshortHarWeeklyReport.html  

Weely report of each Daily individual Harmonics Order by Trigger and Analog Channel. Vshort indicates 3 

second sampling. It Identifies Largest Order each day for the week. Includes Largest MAX Order, Largest 

MAX, Largest Range(%), MAX THD(%), THD 99th(%). 

YYYYMMDD[RecID]shortHarWeeklyReport.html  

Weely report of each Daily individual Harmonics Order by Trigger and Analog Channel. short indicates 10 

minute sampling. It Identifies Largest Order each day for the week. Includes Largest MAX Order, Largest 

MAX, Largest Range(%), MAX THD(%), THD 99th(%) and 95th(%). 

You can Filter on Date by selecting one or more from the Filter Rows box. Refresh the browser to reset the 

view back to all rows. 
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Figure 116 Sample Weekly Harmonics Report 
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YYYY[RecID]VshortHarYearlyReport.html  

Yearly report of each Weekly individual Harmonics Order by Trigger and Analog Channel. Vshort 

indicates 3 second sampling. It Identifies Largest MAX Range, MAX THD, MAX THD 99th(%)for each 

week yearly. Includes Largest MAX(%), Largest Range(%), MAX THD(%), THD 99th(%). 

YYYY[RecID]shortHarYearlyReport.html  

Yearly report of each Weekly individual Harmonics Order by Trigger and Analog Channel. short indicates 

10 minute sampling. It Identifies Largest MAX Range, MAX THD, MAX THD 99th(%)for each week 

yearly. Includes Largest MAX(%), Largest Range(%), MAX THD(%), THD 99th(%) and 95th(%).  

You can Filter on “Week of” Date by selecting one or more from the Filter Rows box. Refresh the browser 

to reset the view back to all rows. 

 

 

Figure 117 Sample Yearly Report 
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Managing Line Group Records on page 7-1 

➢ To Calculate the Location of a Fault 

1. In the Graphic and Data Analysis window, in the Channel Viewing list, select Line Group.  

Figure 167: Select Line Group in the View List 

2. In the Graph area, right-click to display the pop-up menu. 

3. Point to Calculate Fault Location and then click one of the following: 

Use End-1 Only: This calculates the distance to fault using data 1 and line group 1. 

Use End-2 Only: This calculates the distance to fault using data 2 and line group 2. 

Use Both Ends: This calculates the distance fault using both l data and line group 1 and 2.  

Note: Using both ends is the most accurate method to use, however, you must verify that 
both correct files are loaded and selected. If you are unable to provide both line 
records, you may create one for the missing line record. 

If the manually activated fault calculation was successful, a window will prompt you whether you 

would like to see a detailed report. Select one of the following: 

No: If you select No, information such as line name, phase involvement, fault duration, and 

distance to fault will be displayed.  

Yes: If you select Yes, the report will contain all the information mentioned plus fault 

inception time, RMS prefault values, fault magnitude values, and a breaker re-strike flag. 

➢ Performing a Double Ended Fault Location 



Graphic and Data Analysis Window 14-47 

Figure 168: Double Ended Fault Location shows pertinent pop-up menus to perform a double ended fault 

location. Below is a step-by-step procedure for calculating double ended fault location in a typical fashion. 

Figure 168: Double Ended Fault Location 

1. Open the first retrieved record from the Summary Screen by double clicking on it. The Graph and 

Data Analysis screen will open. 

2. Click on “File,” “Open Data,” “Open Data 2” and browse to the second fault record and select it. 

The second record should have been generated by a Recorder at the opposite end of the 

transmission line at nearly the same time as the first fault record opened. 

3. Click on “File,” “Open Line Group,” “Open Line Group 2,” and browse to the Line Group File 

for the second Recorder and select it (this is needed because it contains names and parameters 

from that end of the line). 

4. At the top left of the graphics screen, click the channel viewing pull down menu and select “Line 

Group,” then check mark the box labeled End-2 Fault. This will display the second fault record 

overlaid on the first fault record. 

5. Right click in the middle of the graphics screen and select “Calculate Fault Location,” “Auto2-

ends,” “-Seq.” This will display a pop-up box containing the Distance to Fault information 

(DTF). You can bypass any DTF line decision logic that may have been entered for this line (in 

the Line Group Record,) by Selecting NO from the question pop-up menu (not shown in Figure). 

6. The “Auto2-Ends” selection will automatically find the regions of End 1 and End 2 to do the 

DTF calculation. 

7. If “At Cursor 2-Ends” is selected the program will do the DTF calculation according to where the 

cursor is (The Black vertical line NOT the Line Ref line). 
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8. The software also gives you the choice to calculate DTF with other sequence methods (Pos, Neg). 

Although it is fault dependent, the DTF calculation using–Seq may be more accurate. 

14.26.6 Exporting Graph Data 

You can export raw analog data to several formats listed below. 

➢ To Export Graph Data 

1. In the Graphics and Data Analysis window, from the File menu, click Export Graph Data. Or 

Export Graph Data (16 bit) to accommodate Doble test set using COMTRADE files older than 

2013 

The Export Graph Data window appears. 

2. From the Save in list, select the location for the exported file.  

3. In the File name box, specify the file name. 

4. From the Save as type list, select the preferred format.  

• Comtrade in Binary (.dat) – creates the data and associated config file 

• Comtrade in ASCII (.dat) – creates the data and associated config file 

• Comtrade in Binary (.cff) – creates a single common file format file in Binary 

• Comtrade in ASCII (.cff)) – creates a single common file format file in ASCII 

• Excel (.csv) - creates a single CSV file 

• IEEE-1159 <PQDIF> (.pqd) – Creates a PQDIF file intended for viewing with Power Quality 

Viewers 

5. Click the Save button. 

6. Swap Analog Channel IDs with Description window appears (except when using Excel format), 

Click Yes or No. 

Figure 169: Swap Channel IDs with Descriptions 

Below is an example of how analog channel ID and Descriptions are changed depending on the 

YES or No selection.  This example is for three analog channels displayed on the graphics screen 

with each channel on its own X-axis and channels in A2, A3, A1 order.  No matter the choice, a 

sequential analog channel ID is added to the left during the export process. 
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Table 16: Channel ID and Description swap examples 

Swap ID’s ID & Description Before 

Export 

ID & Description After Export 

No A2:Line XYZ Vb A1:A2;Vb; Line XYZ Vb 

 A3:Line XYZ Vc A2:A3;Vc; Line XYZ Vc 

 A1:Line XYZ Va A3:A1;Va; Line XYZ Va 

Yes A2:Line XYZ Vb A1:Line XYZ Vb;Vb;A2 

 A3:Line XYZ Vc A2:Line XYZ Vc;Vc;A3 

 A1:Line XYZ Va A3:Line XYZ Va;Va;A1 

14.27 Using The Channel Description Area Menu 

You can right-click anywhere in the Channel Description Area to display the pop-up menu shown in the 

following figure. 

Figure 170: Channel Description Area Pop-up Menu 

14.27.1 Changing the Color of an Analog Channel 

➢ To Change the Color of an Analog Channel 

1. In the Channel Description area, click the option button for the channel you want to change. 

2. Right-click to display the pop-up menu.  

3. Click Change Color. A color pallet will appear.  

4. Select the color you want and then click the OK button.  

5. A color change made here will only be “sticky” when looking at channels in sequential order or 

user preference order.  
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Tip: It is recommended that you define permanent analog channel colors in both the Point 
Assignment Record and in the Graphic and Data Analysis window (Options menu, 
Graph Options selection). After you define phase colors in a Point Assignment 
Record, download the Point Assignment Record to its APP Recorder. Any new 
records from that APP Recorder will automatically follow the phase color parameters. 

14.27.2 Adding Analog Channels to the Window 

You can add analog channels to the Graphic and Data Analysis window.  

➢ To Add Analog Channels to the Graphic and Data Analysis Window 

1. In the Channel Description area, right click to display the pop-up menu.  

2. Click Add1.  

The End-1 Add Graph(s) window appears, as shown in the following figure.   

 

Figure 171: Add Analog Channel Selection Screen 

3. Select the channels to be added.  

*CAUTION* Remember to select the check box; do not just highlight the line. 

If the Graphics and Data Analysis window is currently displaying Sequential Channels, then 

the new channel will be added in the appropriate channel order. If the window is currently 

displaying channels by User Preference or Line Group, then the channel will be added to the 

graph panel that has a Tagged description.  

4. Click the OK button.  

The channels are added to the display. 

14.27.3 Removing a Channel from the Window 

You can remove a channel description from the Graphics and Analysis window. 

➢ To Remove a Channel from the Graphics and Analysis Window 

1. In the Channel Description area, click the option button for the channel to remove. 

2. Right-click to display the pop-up menu.  

3. Click Delete. The channel is removed from the display. 
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14.27.4 Cutting/Copying and Pasting a Channel in the Window 

You can change the positions of channels in the Graphics and Analysis window by cutting and pasting 

them. You can also copy and paste channels if you want to see the same channel multiple times in the 

display.  

➢ To Cut/Copy and Paste a Channel in the Window 

1. In the Channel Description area, click the option button for the channel to cut or copy. 

2. Right-click to display the pop-up menu.  

3. Do one of the following: 

Click Cut to move the channel to a new position in the window. 

Click Copy to show the channel multiple times in the window. 

4. In the Channel Description area, click where the channel should appear. 

5. Right-click to display the pop-up menu and then click Paste. 

14.27.5 Inverting a Channel in the Window 

You can invert a displayed oscillogram 180 degrees.  

Note:  To reverse the inversion, invert the channel a second time. Alternatively, click the Update 
button on the Tool Bar.  

➢ To Invert a Channel in the Window 

1. In the Channel Description area, click the option button for the channel to invert. 

2. Right-click to display the pop-up menu.  

3. Click Invert. The channel is inverted immediately. 
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14.27.6 Converting a Channel in the Window 

You can convert one or more channels in the Graphics and Data Analysis window. 

Note:  To reverse the conversion, click the Update button on the Tool Bar.  

➢ To Convert a Channel in the Window 

1. In the Channel Description area, right-click to display the pop-up menu.  

2. Point to Convert and then click one of the following options: 

• RMS 

• Frequency 

• Average 

• THD 

• Max Harmonic 

• De-steady State: Removes 60 Hz from the signal, or fundamental frequency, and 

leaves a display or the harmonics and signal noise 

• De-Spike 

• Filter Harmonics 

• Extract K Harmonics 

• PMU Phase 

• PMU RMS 

• Peak 

• Crest Factor 

 

A Convert window appears. 

Figure 172: Convert Channel(s) Window 

3. Select the channel(s) to convert.  

4. If the Every #Cycles box appears, type the number of cycles.  

This box does not appear for the De-steady State, De-Spike, and Filter Harmonics options. 

5. Click the OK button.  

ClearView completes the conversion and plots the result in the Graph area. 
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14.27.7 Shifting the Phase of a Channel 

You can shift the phase of a channel.  

Note:  To reverse the shift, click the Update button on the Tool Bar.  

➢ To Shift the Phase a Channel in the Window 

1. In the Channel Description area, click the option button for the channel to shift. 

2. Right-click to display the pop-up menu.  

3. Click Phase Shift. The Shift Phase window appears. 

4. Enter the amount of the shift in degrees and then click the OK button. The phase is shifted 

immediately and the channel description is changed to indicate the phase shift. 

14.27.8 Combining with the Next Curve 

You can mathematically combine two oscillograms in the Channel Description area by doing any of the 

following: 

▪ Adding 

▪ Subtracting 

▪ Inverting and then adding 

▪ Inverting and then subtracting  

Note: To reverse the mathematical operation(s), click the Update button on the Tool Bar. 

➢ To Combine Two Oscillograms 

1. In the Channel Description area, click the option button for the first channel to combine. 

Note:  The oscillogram that you select must be listed above the oscillogram you want to 
combine. 

2. Right-click to display the pop-up menu.  

Figure 173: Combine with Next Curve Options 
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3. Point to Combine with next curve and then click the appropriate option. 

The oscillogram that you selected is combined with the oscillogram that follows it, following the 

mathematical operation you selected. 

The results are shown in an additional graph at the bottom. 

14.27.9 Combining with the Next Two Curves  

➢ Performing Sequence Calculations on Three Oscillograms 

You can perform the following types of sequence calculations on a group of three oscillograms: 

▪ Positive Sequence 

▪ Negative Sequence 

▪ Zero Sequence  

Note: To reverse the calculation(s), click the Update button on the Tool Bar. 

➢ To Perform Sequence Calculations on Three Oscillograms 

1. In the Channel Description area, click the option button for the first channel. 

Note:  The oscillogram that you select must be listed above the two oscillograms you want to 
combine. 

2. Right-click to display the pop-up menu.  

3. Point to Combine with next two curves and then click the appropriate option. 

The sequence calculation that you selected is performed. Results are added at the bottom. 

14.27.10 Creating a Custom Curve 

If the pre-programmed math functions are not adequate, you can perform extensive, custom math functions 

on any combination of analog channels.  

Note: To reverse the mathematical operation, click the Update button on the Tool Bar. 
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➢ To Create a Custom Curve 

1. In the Channel Description area, right-click to display the pop-up menu.  

2. Point to Create a curve and then click Create a Curve 1 and then click the appropriate option.  

The Create a Curve window appears, as shown in the following figure. 

 

Figure 174: Create a Curve Configuration Screen 

3. In the Equation box, build your equation by clicking the selected channels and inserting the 

available operators (shown below the entry field). 

4. Click the Create button. The curve that you designed is created. 

14.27.11 Creating a PMU Cosine Reference 

PMU cosine function always measures 0 degrees at the 1PPS mark and is always equal to line frequency.  

➢ To Create a PMU Cosine Reference 

1. In the Channel Description area, right-click to display the pop-up menu.  

2. Point to Create a PMU Cosine Reference and then click Reference 1 or Reference 2.  

The Enter Line Frequency window appears. 

3. In the entry field, enter the line frequency in Hz. 

4. Click the OK button. The curve is created and displayed. 

14.27.12 Temporarily Editing an Analog Channel Description 

You can temporarily edit an analog channel description, which is the information that appears in the 

Channel Description area. Your edit is not permanent and does not change the COMTRADE record or 

Point Assignment Record. It can, however, improve the usability of the Channel Description area. 

Note:  To reverse the description change, click the Update button on the Tool Bar.  
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➢ To Temporarily Edit an Analog Channel Description 

1. In the Channel Description area, click the option button for the channel to edit.  

2. Right-click to display the pop-up menu.  

3. Click Edit Description. The Analog Channel Description window appears. 

4. In the entry field, enter the new description. 

5. Click the OK button. 

14.28 Meter Area Menu 

Right clicking anywhere in the Metering Area displays the following pop-up menu.  

Figure 175: Metering Area Pop-Up Menu 

14.28.1 Displaying RMS Values 

In the Metering Area, you can display the RMS value of each analog channel. As you move the cursor, the 

RMS values are automatically updated for you.  

The RMS value is calculated on the data that is 1 cycle to the left of the cursor position. You can change 

the number of cycles by selecting the “Cycle” choice at the bottom of the pop up menu. 

➢ To Display RMS Values 

1. In the Metering Area, right-click to display the pop-up menu.  

2. Click RMS.  

14.28.2 Displaying MAG Values 

In the Metering Area, you can display the instantaneous magnitude value of each analog channel. As you 

move the cursor, the Magnitude values are updated.  

➢ To Display MAG Values 

1. In the Metering Area, right-click to display the pop-up menu. 

2. Click MAG. 
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14.28.3 Displaying Average Values 

In the Metering Area, you can display the DC component of the waveforms. DC is calculated by averaging 

of the data values. As you move the cursor, the values are updated.  

➢ To Display Average Values 

1. In the Metering Area, right-click to display the pop-up menu.  

2. Click Average.  

14.28.4 Displaying RMS, Phase Values 

In the Metering Area, you can display the phase angle of each analog channel along with its RMS value.  

If you select the Fix One Phase from the Options menu, the phase angle will be referenced to a tagged 

analog channel. Otherwise, it will be referenced to cosine function. As you move the cursor, the values are 

updated. 

➢ To Display RMS, Phase Values 

1. In the Metering Area, right-click to display the pop-up menu.  

2. Click RMS, Phase.  

14.28.5 Displaying PMU: RMS, Phase Values 

In the Metering Area, you can display the phase angle of each analog channel referenced to a PMU cosine 

function. The angle is always 0 degrees at the 1PPS mark and its frequency is always equal to line 

frequency. As you move the cursor, the values are updated. 

➢ To Display PMU:RMS, Phase Values 

1. In the Metering Area, right-click to display the pop-up menu.  

2. Click PMU:RMS, Phase.  

14.28.6 Frequency 

In the Metering Area, you can display frequency values. As you move the cursor, the values are updated. 

The Frequency value is calculated on the data that is 1 cycle to the left of the cursor position. The number 

of cycles can be changed by selecting Cycle at the bottom of the pop up menu. 

➢ To Display Frequency Values 

1. In the Metering Area, right-click to display the pop-up menu.  

2. Click Frequency.  

Note: It is recommended to calculate frequency on six or more cycles 
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14.28.7 Peak 

In the Metering Area, you can display the peak value of each analog channel. Peak value is calculated on 

the data that is 1 cycle to the left of the cursor position. The number of cycles can be changed by selecting 

Cycle at the bottom of the pop up menu. Peak is shown as an absolute number. 

1. In the Metering Area, right-click to display the pop-up menu.  

2. Click Peak.  

14.28.8 Crest Factor  

In the Metering Area, you can display the crest factor value of each analog channel. Crest Factor 

(Peak/RMS) value is calculated on the data that is 1 cycle to the left of the cursor position. The number of 

cycles can be changed by selecting Cycle at the bottom of the pop up menu. 

1. In the Metering Area, right-click to display the pop-up menu.  

2. Click Crest Factor.  

14.28.9 Distance 

In the Metering Area, you can display the Distance value of each analog channel. Distance value is 

calculated on the data that is 1 cycle to the left of the cursor position. The number of cycles can be changed 

by selecting Cycle at the bottom of the pop up menu. Distance is shown as Miles however, you can use the 

Options Tab to change the measurement displayed to KM. 

1. In the Metering Area, right-click to display the pop-up menu.  

2. Click Distance.  

14.28.10 Viewing Metering Area Statistics 

For each data value that you display in the Metering Area, you can also view the following details: 

▪ Peak 

▪ Max 

▪ Min 

▪ Max-Min 

▪ Average 

This feature can be valuable when analyzing a continuous record.  

➢  To View Metering Area Statistics 

1. In the Metering Area, right-click to display the pop-up menu.  

2. Point to Statistics and then click the option you want. 

The Metering Area refreshes. A single value is displayed for each oscillogram.  

14.28.11 Changing the Period between Cursors 

You can change the period (in number of cycles) between the first and second cursors. This is the period 

used for calculating the meter values such as RMS, frequency and DC components. 
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➢ To Change the Period between Cursors 

1. In the Channel Description Area, select option button for the channel for which you want to 

change the period.  

2. In the Metering Area, in the box under the X (in the upper right corner), type the number of cycles.  

3. Click the X button. The Graphic Area is immediately updated. 

14.29 Digital Area Menu 

You can perform digital and analog trigger viewing at the bottom left of the Graphic and Analysis window. 

Right clicking in the Digital Area displays the pop-up menu shown in the following figure. 

Figure 176: Digital Area Pop-Up Menu 

You can use these menu choices to move digital and analog trigger traces to the top, delete digital channels 

from the display, or rebuild the display (reverting back to original display before any moving or deleting 

was done.) 

14.30 Tool Bar 

The Tool Bar is located just below the menu items at the top of the Graphic and Data Analysis window.  

 

Figure 177: Tool Bar Controls 

 

The following sections describe the controls in the Tool Bar. 

Note: The appearance of the Tool Bar changes, based on the selections that you make in the 
Graphics and Data Analysis window. If a control is not appropriate based on your 
selections, it does not appear in the Tool Bar. 
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14.30.1 Channel Viewing List 

  

Figure 178: Channel Viewing List 

The options in the Channel Viewing list are: 

▪ Sequential Channels: This selection displays the analog channels in channel number order. 

▪ User Preference: This selection allows you to select the channels you prefer to view and save 

your preferred set with a unique name. When you select User Preference, a User Analog Channel 

Lists window appears, as shown in the following figure. Select the check box for the channels you 

want to include and then click the Save button to save your view with a unique name. Later, you 

can access this window and click the Open button to re-open the same preferred set. 

Figure 179: User Analog Channel Lists Window 

▪ Line Group: This selection displays the analog channels in the user-defined line group 

configuration. Since the graph contains both voltages and currents, power and impedance 

calculations can be made. When Line Group is selected, additional choices appear in the Tool 

Bar. From the Tool Bar, you can select which line group to view, power or impedance calculation, 

and the channel grouping order. 

Note: In the Graphic and Data Analysis window, you can create a line group by clicking 
the File menu, and then clicking Edit Line Group. For complete details on Line 
Groups, see 8.3 Adding a Line Group Record. 

▪ Three Phase: This selection allows you to choose three voltage channels and three current 

channels. Since the Graph Area contains both voltages and currents, power and impedance 

calculations can be made. When Three Phase is selected, additional choices appear in the Tool 

Bar. 
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▪ Single Phase: This selection allows you to choose one voltage channel and one current channel.  

Since the graph contains both a voltage and current, power and impedance calculations can be 

made. When Single Phase is selected, additional choices appear in the Tool Bar. 

▪ Generator (Vab, Ia)(Vbc, Ic), Generator (Vab, Ib)(Vca, Ic), Generator (Vbc, Ib)(Vca, Ia), or 

Generator (Vab, Vbc, Vcam Ia, Ib, Ic) These selections provide you four possible ways of 

calculating generator power given a phase-to-phase connection to the APP Recorder. 

14.30.2 Digital Check Box  

You can select whether to view digital or event data at the bottom of the Graphic and Data Analysis 

window. 

 

Figure 180: Digital Check Box 

➢ To Select Digital (Event) Data 

Do one of the following: 

To view digital data, select the Digital box. 

To exclude digital (event) data, de-select the Digital box. 

14.30.3 RMS List 

 

Figure 181: RMS List 

Selecting RMS causes the software to immediately calculate and display RMS plots for each analog 

channel. The number of cycles used for the calculation is selected in the X box, which is located in the 

Meter Area. The default value is 1 cycle. 

The HFilter selection means harmonic filter. This selection filters all harmonics from the displayed signals 

leaving just the 60Hz (or 50Hz) component.  
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14.30.4 Power and Impedance List 

 

Figure 182: Power and Impedance List 

When you select Line Group, Three Phase, or Single Phase from the Channel Viewing list. You have 

the following options to view: 

▪ Power - displays Apparent Power, Active Power, Reactive Power, and Power Factor 

▪ Impedance - Displays Phase A, B, and C impedance 

▪ Resistance - Displays Phase A, B, and C resistance 

▪ Reactance - Displays Phase A, B, and C reactance 

▪ PwrVoltFreq – Displays Active Power, Reactive Power, +Seq Voltage expressed in RMS, and 

Frequency. Frequency is based on Phase A by default when in Line Group or Three Phase channel 

view. 

Select Power or Impedance to display plots at the bottom of the Graphic and Data Analysis window. 

14.30.5 Update Button 

Clicking the Update button causes the Graphic and Data Analysis window to return to its original state. 

Any display modifications that you have made, such as moving channels around or math calculations, are 

immediately reversed.  

Note: Any function carried out in the Graphic and Data Analysis window will not modify the 
actual COMTRADE record. 

14.30.6 DFT Button 

If you click the DFT button, a DFT window appears showing total harmonic distortion and maximum 

harmonic distortion for the presently selected channel. 

Figure 183: DFT Window 

The display will show up to the number of Harmonics based on the Transient Sampling set in the PAR as 

follows:  
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Table 17 DFT Display Harmonic Limit 

Transient Sampling Up to Harmonic 

2400 Hz 19th 

4800 Hz 39th 

9600 Hz and above 50th 

The main menu in the DFT window offers choices of Print, Beautify, and Exit. If you select Print, a 

window appears that allows you to specify the file format, print destination, and other object modifications. 

If you select Beautify, the display becomes more colorful; select it again to remove the coloration. Click 

Exit to close the DFT window. 

14.30.7 FFT Button 

If you click the FFT button, the Fast Fourier Transform (FFT) window appears, as shown in the 

following figure. Information for the presently tagged channel is shown in the display. 

 

Figure 184: FFT Window 

The main menu in the FFT window offers choices of Print, Beautify, and Exit. If you select Print, a 

window appears that allows you to specify the file format, print destination, and other object modifications. 

If you select Beautify, the display becomes more colorful; select Plain to remove the coloration. Click Exit 

to close the FFT window. 

Click anywhere in the FFT window to display the pop-up menu that contains the following choices: 

▪ Undo Zoom - This selection reverses the zooming actions and returns the screen back to its 

original state. 

▪ Zoom - This selection allows you to zoom in any of the following dimensions: 

Horizontal - You can zoom only from left to right. 

Vertical - You can zoom only from top to bottom. 

Horizontal + Vertical - You can simultaneously zoom from left to right and from top to 

bottom. 

▪ Type - This selection allows you to choose from these types of FFT amplitude:  
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Linear - The FFT amplitude is displayed in terms of percentage. 

dB - The FFT amplitude is displayed in decibels.  

▪ Mark Data Points - This selection marks the actual sampling points. 

▪ #Harmonic Lines - This selection controls the number of dashed vertical lines in the FFT display. 

14.30.8 Vector Button 

If you click the Vector button, the Phasor Diagram window appears. The Phasor Diagram window 

displays only the voltage and current analog channels that are displayed in the Graph Area of the Graphic 

and Data Analysis window. It does not display any other channels such as power or impedance.  

If you have selected the Fix One Phase option on the Options menu in the Graphic and Data Analysis 

window, then as you move the cursor side-to-side, all the vectors except the tagged channel rotate. 

Otherwise, all the vectors will rotate referencing to a cosine function. Tag the channel independent of the 

oscillography by clicking/selecting it in the Description column. 

Disabling Vector, Double clicking the Description will disable the vector from the diagram. 

Enable All will enable all the channels after having been disabled from the diagram. 

Figure 185: Phasor Diagram Window 

In the Phasor Diagram window, the File menu shown allows you to print voltage or current phasor 

screens. 

Figure 186: Phasor Diagram Window - File Menu 
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The Options menu, shown in Figure 187, allows you to display voltage and current Phasors in the same 

graph or in separate graphs. It also allows you to display or not display sequence vectors.  

If voltage and current are displayed in the same graph, the voltage vectors are thicker than the current 

vectors.  

For sequence vectors, voltage and current in the same sequence (positive, negative or zero) are always 

displayed in the same graph, with phase A being red, phase B blue, and phase C green.  

For zero sequences, there is only one vector for voltage and one vector for current. 

Note: Displaying sequence vectors requires all three phases of voltage/current to be available 
and to be identified, ClearView assumes the first three voltages/currents shown in the 
Graphics and Data Analysis window to be phase A, B, and C, in that order. If there are 
more than three, only the first three are used for sequence vectors. Voltages and currents 
can be interleaved. 

Figure 187: Phasor Diagram Window - Options Menu 

14.30.9 Go to Box and Button 

An oscillogram is comprised of a number of data points. The first data point is to the left and the last data 

point is to the right. In the Go to box, you can enter a specific data point and the cursor will jump to that 

data point when you click the Go to button. 

14.30.10 Secondary Check Box 

Check this box to view Secondary values for the channels (i.e. Primary values are factored by the value 

specified in the Point Assignment Record for CT/PT Ratios for a channel). You can dynamically toggle 

between viewing Primary values and Secondary values by checking and un-checking the Secondary box. 


